Intel Stratix 10 Configuration User Guide

Updated for Intel® Quartus® Prime Design Suite: 19.4
1. Intel® Stratix® 10 Configuration User Guide................................................................. 6
   1.1. Intel® Stratix® 10 Configuration Overview.............................................................. 6
   1.1.1. Configuration and Related Signals................................................................. 10
   1.1.2. Intel Download Cables Supporting Configuration in Intel Stratix 10 Devices............. 11
   1.2. Intel Stratix 10 Configuration Architecture.......................................................... 12
       1.2.1. Secure Device Manager.............................................................................. 13
2. Intel Stratix 10 Configuration Details............................................................................ 18
   2.1. Intel Stratix 10 Configuration Timing Diagram.................................................... 18
   2.2. Configuration Flow Diagram............................................................................... 22
   2.3. Additional Clock Requirements for HPS, PCIe, eSRAM, and HBM2...................... 25
   2.4. Intel Stratix 10 Configuration Pins....................................................................... 25
       2.4.1. SDM Pin Mapping...................................................................................... 26
       2.4.2. MSEL Settings.......................................................................................... 27
       2.4.3. Device Configuration Pins for Optional Configuration Signals....................... 28
   2.5. Configuration Clocks........................................................................................... 37
       2.5.1. Setting Configuration Clock Source.......................................................... 37
       2.5.2. OSC_CLK_1 Clock Input............................................................................. 38
3. Intel Stratix 10 Configuration Schemes........................................................................ 40
   3.1. Avalon-ST Configuration....................................................................................... 40
       3.1.1. Avalon-ST Configuration Scheme Hardware Components and File Types.......... 42
       3.1.2. Enabling Avalon-ST Device Configuration.................................................. 43
       3.1.3. The AVST_READY Signal........................................................................... 44
       3.1.4. RBF Configuration File Format................................................................. 46
       3.1.5. Avalon-ST Single-Device Configuration....................................................... 46
       3.1.6. Debugging Guidelines for the Avalon-ST Configuration Scheme......................... 50
       3.1.7. QSF Assignments for Avalon-ST x8............................................................ 51
       3.1.8. QSF Assignments for Avalon-ST x16............................................................ 53
       3.1.9. QSF Assignments for Avalon-ST x32............................................................ 55
       3.1.10. IP for Use with the Avalon-ST Configuration Scheme: Intel FPGA Parallel Flash Loader II IP Core................................. 57
   3.2. AS Configuration.................................................................................................. 84
3.2.1. AS Configuration Scheme Hardware Components and File Types ................................................................. 86
3.2.2. AS Single-Device Configuration ..................................................................................................................... 88
3.2.3. AS Using Multiple Serial Flash Devices ........................................................................................................ 90
3.2.4. AS Configuration Timing Parameters ........................................................................................................... 92
3.2.5. Maximum Allowable External AS_DATA Pin Skew Delay Guidelines .............................................................. 93
3.2.6. Programming Serial Flash Devices .................................................................................................................. 94
3.2.7. Serial Flash Memory Layout .......................................................................................................................... 98
3.2.8. AS_CLK ............................................................................................................................................................ 99
3.2.9. Active Serial Configuration Software Settings ................................................................................................ 100
3.2.10. Intel Quartus Prime Programming Steps ....................................................................................................... 101
3.2.11. Debugging Guidelines for the AS Configuration Scheme .................................................................................. 106
3.2.12. QSF Assignments for AS .................................................................................................................................. 107
3.3. SD/MMC Configuration ........................................................................................................................................ 110
3.3.1. SD/MMC Single-Device Configuration ............................................................................................................. 111
3.4. JTAG Configuration .............................................................................................................................................. 112
3.4.1. JTAG Configuration Scheme Hardware Components and File Types ..................................................................... 114
3.4.2. JTAG Device Configuration ................................................................................................................................ 115
3.4.3. JTAG Multi-Device Configuration ..................................................................................................................... 118
3.4.4. Debugging Guidelines for the JTAG Configuration Scheme .................................................................................. 119
4. Including the Reset Release Intel FPGA IP in Your Design .......................................................................................... 122
4.1. Understanding the Reset Release IP Requirement ................................................................................................. 123
4.2. Assigning INIT_DONE To an SDM_IO Pin ............................................................................................................... 124
4.3. Instantiating the Reset Release IP In Your Design .................................................................................................. 126
4.4. Gating the PLL Reset Signal .................................................................................................................................. 126
4.5. Guidance When Using Partial Reconfiguration (PR) ............................................................................................. 127
4.6. Detailed Description of Device Configuration ....................................................................................................... 127
4.6.1. Device Initialization ............................................................................................................................................. 129
4.6.2. Preventing Register Initialization During Power-On ............................................................................................ 129
4.6.3. Embedded Memory Block Initial Conditions ..................................................................................................... 131
4.6.4. Protecting State Machine Logic ........................................................................................................................ 131
5. Remote System Update (RSU) ................................................................................................................................. 133
5.1. Remote System Update Functional Description .................................................................................................... 135
5.1.1. RSU Glossary ....................................................................................................................................................... 135
5.1.2. Remote System Update Using AS Configuration ................................................................................................. 136
5.1.3. Remote System Update Configuration Images ..................................................................................................137
5.1.4. Remote System Update Configuration Sequence .................................................................................................138
5.1.5. RSU Recovery from Corrupted Images ..................................................................................................................139
5.1.6. Updates with the Factory Update Image ..................................................................................................................142
5.2. Guidelines for Performing Remote System Update Functions for Non-HPS ................................................................143
5.3. Commands and Responses .........................................................................................................................................144
  5.3.1. Operation Commands ...........................................................................................................................................146
  5.3.2. Error Code Responses ...........................................................................................................................................154
5.4. Quad SPI Flash Layout ................................................................................................................................................155
  5.4.1. High Level Flash Layout .........................................................................................................................................155
  5.4.2. Detailed Quad SPI Flash Layout ...............................................................................................................................159
5.5. Generating Remote System Update Image Files Using the Programming File Generator ..............................................164
  5.5.1. Generating the Initial RSU Image ............................................................................................................................164
  5.5.2. Generating an Application Image ............................................................................................................................167
  5.5.3. Generating a Factory Update Image ..........................................................................................................................169
  5.5.4. Command Sequence To Perform Quad SPI Operations ...........................................................................................173
5.6. Remote System Update from FPGA Core Example ......................................................................................................173
  5.6.1. Prerequisites ............................................................................................................................................................174
  5.6.2. Creating Initial Flash Image Containing Bitstreams for Factory Image and One Application Image .......................175
  5.6.3. Programming Flash Memory with the Initial Remote System Update Image ............................................................179
  5.6.4. Reconfiguring the Device with an Application or Factory Image ............................................................................181
  5.6.5. Adding an Application Image ..................................................................................................................................182
  5.6.6. Removing an Application Image ..............................................................................................................................186

6. Intel Stratix 10 Configuration Features ..............................................................................................................................188
  6.1. Device Security ............................................................................................................................................................188
  6.2. Configuration via Protocol ...........................................................................................................................................188
  6.3. Partial Reconfiguration ...............................................................................................................................................190

7. Intel Stratix 10 Debugging Guide .......................................................................................................................................191
  7.1. Configuration Debugging Checklist ..............................................................................................................................191
  7.2. Intel Stratix 10 Configuration Architecture Overview ................................................................................................192
  7.3. SDM Debug Toolkit Overview ........................................................................................................................................192
    7.3.1. Using the SDM Debug Toolkit ................................................................................................................................197
  7.4. Configuration Pin Differences from Previous Device Families ......................................................................................199
  7.5. Configuration File Format Differences ..........................................................................................................................201
## Contents

7.6. Understanding SEUs................................................................................................................................. 202  
7.7. Reading the Unique 64-Bit CHIP ID.............................................................................................................. 202  
7.8. E-Tile Transceivers May Fail To Configure.................................................................................................. 202  
7.9. Understanding and Troubleshooting Configuration Pin Behavior................................................................. 203  
  7.9.1. nCONFIG............................................................................................................................................ 204  
  7.9.2. nSTATUS........................................................................................................................................... 205  
  7.9.3. CONF_DONE and INIT_DONE.............................................................................................................. 206  
  7.9.4. SDM_IO Pins........................................................................................................................................ 206  
8. Intel Stratix 10 Configuration User Guide Archives.......................................................................................... 209  
1. Intel® Stratix® 10 Configuration User Guide

1.1. Intel® Stratix® 10 Configuration Overview

All Intel® Stratix® 10 devices include a Secure Device Manager (SDM) to manage FPGA configuration and security. The SDM provides a failsafe, strongly authenticated, programmable security mode for device configuration. Previous FPGA families include a fixed state machine to manage device configuration.

The Intel Quartus® Prime software also provides flexible and robust security features to protect sensitive data, intellectual property, and the device itself under both remote and physical attacks. Configuration bitstream authentication ensures that the firmware and configuration bitstream are from a trusted source. Encryption prevents theft of intellectual property. The Intel Quartus Prime software also compresses FPGA bitstreams, reducing memory utilization.

Intel describes configuration schemes from the point-of-view of the FPGA. Intel Stratix 10 devices support active and passive configuration schemes. In active configuration schemes the FPGA acts as the master and the external memory acts as a slave device. In passive configuration schemes an external host acts as the master and controls configuration. The FPGA acts as the slave device. All Intel Stratix 10 configuration schemes support design security, and partial reconfiguration. All Intel Stratix 10 active configuration schemes support remote system update (RSU) with quad SPI flash memory. To implement RSU in passive configuration schemes, an external controller must store and drive the configuration bitstream.

Intel Stratix 10 devices support the following configuration schemes:
- Avalon® Streaming (Avalon-ST)
- JTAG
- Configuration via Protocol (CvP)
- Active Serial (AS) normal and fast modes
- Secure Digital and Multi Media Card (SD/MMC)
### Table 1. Intel Stratix 10 Configuration Data Width, Clock Rates, and Data Rates

<table>
<thead>
<tr>
<th>Configuration Scheme</th>
<th>Data Width (bits)</th>
<th>MSEL[2:0]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avalon-ST</td>
<td>32</td>
<td>000</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>101</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>110</td>
</tr>
<tr>
<td>JTAG</td>
<td>1</td>
<td>111</td>
</tr>
<tr>
<td>Configuration via Protocol (CvP)</td>
<td>x1, x2, x4, x8, x16 lanes</td>
<td>001&lt;sup&gt;(1)&lt;/sup&gt;</td>
</tr>
<tr>
<td>Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SD/MMC</td>
<td>4/8</td>
<td>100</td>
</tr>
<tr>
<td>AS - fast mode</td>
<td>4</td>
<td>001</td>
</tr>
<tr>
<td>AS - normal mode</td>
<td>4</td>
<td>011</td>
</tr>
</tbody>
</table>

**Avalon-ST**

The Avalon-ST configuration scheme is a passive configuration scheme. Avalon-ST is the fastest configuration scheme for Intel Stratix 10 devices. Avalon-ST configuration supports x8, x16, and x32 modes. The x16 and x32 bit modes use general-purpose I/Os (GPIOs) for configuration. The x8 bit mode uses dedicated SDM I/O pins.

**Note:**

The AVST_data[15:0], AVST_data[31:0], AVST_clk, and AVST_valid use dual-purpose GPIOs. You can use these pins as regular I/Os after the device enters user mode.

Avalon-ST supports backpressure using the AVST_READY and AVST_VALID pins. Because the time to decompress the incoming bitstream varies, backpressure support is necessary to transfer data to the Intel Stratix 10 device. For more information about the Avalon-ST refer to the Avalon Interface Specifications.

**JTAG**

You can configure the Intel Stratix 10 device using the dedicated JTAG pins. The JTAG port provides seamless access to many useful tools and functions. In addition to configuring the Intel Stratix 10, you use the JTAG port for debugging with Signal Tap or the System Console tools.

<sup>(1)</sup> Before you can use CvP you must configure either the periphery image or full image configuration via the AS scheme. Then you can configure the core image using CvP.
The JTAG port has the highest priority and overrides the MSEL pin settings. Consequently, you can configure the Intel Stratix 10 device over JTAG even if the MSEL pins specify a different configuration scheme unless you disabled JTAG for security reasons.

CvP

CvP uses an external PCIe* host device as a Root Port to configure the Intel Stratix 10 device over the PCIe link. You can specify up to a x16 PCIe link. Typically, the bitstream compression ratio and the SDM input buffer data rate, not the PCIe link width, limit the configuration data rate. Intel Stratix 10 devices support two CvP modes, CvP init and CvP update.

CvP initialization process includes the following two steps:

1. CvP configures the FPGA periphery image which includes I/O and hard IP blocks, including the PCIe IP. CvP uses quad SPI memory in AS x4 mode to configure the FPGA fabric. Because the PCIe IP is in the periphery image, PCIe link training establishes the PCIe link of the CvP PCIe IP before the core fabric configures.

2. The host device uses the CvP PCIe link to configure your design in the core fabric.

CvP update mode updates the FPGA core image using the PCIe link already established from a previous full chip configuration or CvP init configuration. After the Intel Stratix 10 enters user mode, you can use the CvP update mode to reconfigure the FPGA fabric. This mode has the following advantages:

- Allows reprogramming of the core to run different algorithms.
- Provides a mechanism for standard updates as a part of a release process.
- Customizes core processing for different components that are part of a complex system.

For both CvP Init and CvP Update modes, the maximum data rate depends on the PCIe generation and number of lanes.

For Intel Stratix 10 SoC devices, CvP is only supported in FPGA configuration first mode.

For more information refer to the Intel Stratix 10 Configuration via Protocol (CvP) Implementation User Guide.
AS Normal Mode
Active Serial x4 or AS x4 or Quad SPI is an active configuration scheme that supports flash memories capable of three- and four-byte addressing. Upon power up, the SDM boots from a boot ROM which uses three-byte addressing to load the configuration firmware from the Quad SPI flash. After the configuration firmware loads, the Quad SPI flash operates using four-byte addressing for the rest of the configuration process. This mode supports Intel’s serial flash configuration memory solution for the following third-party flash devices:

- Micron MT25QU128, MT25QU256, MT25QU512, MT25QU01G, MT25QU02G

Refer to the Supported Flash Devices for Intel Stratix 10 Devices for complete list of supported flash devices.

AS Fast Mode
The only difference between AS normal mode and fast mode is speed. Use AS fast mode when configuration timing is a concern. This mode does not delay for 10 ms before beginning configuration. Use this mode to meet the 100 ms of power up requirement for PCIe or for other systems with strict timing requirements.

In AS fast mode, the power-on sequence must ensure that the quad SPI flash memory is out of reset before the SDM because the Intel Stratix 10 device accesses flash memory immediately after exiting reset. The power supply must be able to provide an equally fast ramp up for the Intel Stratix 10 device and the external AS x4 flash devices. Failing to meet this requirement causes the SDM to report that the memory is missing. Consequently, configuration fails.


SD/MMC
SD/MMC is an active configuration scheme. The Intel Stratix 10 SDM can initiate configuration from SD, Secure Digital High Capacity (SDHC*), Secure Digital Extended Capacity (SDXC*), MMC cards, and eMMC devices. The advantages of this mode are cost, capacity, availability, portability, and compatibility. Because the SDM I/O configuration pins in Intel Stratix 10 devices operate at 1.8 volt an intermediate voltage level shifter may be required to interface with the higher voltage I/Os in SD/MMC devices.

Note: The SD/MMC configuration scheme is not supported in the current release.

Related Information
- Avalon Interface Specifications
1.1.1. Configuration and Related Signals

The following figure shows the configuration interfaces and configuration-related device functions. Pins shown in dark blue use dedicated SDM I/Os. Pins shown in black use general purpose I/Os (GPIOs). Pins shown in red are dedicated JTAG I/Os.

You specify SDM I/O pin functions using the **Device ➤ Configuration ➤ Device and Pin Options** dialog box in the Intel Quartus Prime software.

**Figure 1. Intel Stratix 10 Configuration Interfaces**

This user guide discusses most of the interfaces shown in the figure. Refer to the separate *Intel Stratix 10 Configuration via Protocol (CvP) Implementation User Guide* and *Intel Stratix 10 Power Management User Guide* for more information about those features.
Related Information

- SDM Pin Mapping on page 26
- Intel Stratix 10 Configuration via Protocol (CvP) Implementation User Guide
- Intel Stratix 10 Power Management User Guide

### 1.1.2. Intel Download Cables Supporting Configuration in Intel Stratix 10 Devices

Intel provides the following cables to download your design to the Intel Stratix 10 device on the PCB. Download cables support prototyping activity by providing detailed debug messages via Intel Quartus Prime Programmer. You must use Intel download cables for advanced debugging using the Signal Tap logic analyzer or the System Console tools.

#### Table 2. Intel Stratix 10-Supported Download Cable Capabilities

<table>
<thead>
<tr>
<th>Download Cable</th>
<th>Protocol Support Intel Stratix 10 Device</th>
<th>Cable Connection to PCB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel FPGA Download Cable II (formerly the USB-Blaster II)</td>
<td>JTAG, AS</td>
<td>10-pin female plug</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3M Part number: 2510-6002UB</td>
</tr>
<tr>
<td>Intel FPGA Ethernet Cable (formerly the Ethernet Blaster II)</td>
<td>JTAG, AS</td>
<td>10-pin female plug</td>
</tr>
</tbody>
</table>

The Intel FPGAs and Programmable Devices / Download Cables provides more information about the download cables and includes links to the user guides for all cables listed in the table above.
1.2. Intel Stratix 10 Configuration Architecture

The Secure Device Manager (SDM) is a triple-redundant processor-based module that manages configuration and the security features of Intel Stratix 10 devices. The SDM is available on all Intel Stratix 10 FPGAs and SoC devices.

The block diagram below provides an overview of the Intel Stratix 10 configuration architecture which includes the following blocks:

- **SDM**: More information about the SDM is contained in later sections.
- **Configuration network**: The SDM uses this dedicated, parallel configuration network to distribute the configuration bitstream to Local Sector Managers (LSMs). You cannot access this network.
- **LSMs**: The LSM is a microprocessor. Each configuration sector includes an LSM. The LSM parses configuration bitstream and configures the logic elements for its sector. After configuration, the LSM performs the following functions:
  - Monitors for single event upsets at the sector level
  - Processes responses to single event upsets (SEUs)
  - Performs hashing or integrity checks in real time
- **Specific blocks for Intel Stratix 10 variants**:
  - SX devices include the hard processor system (HPS) in addition to FPGA logic.
  - MX devices include a High Bandwidth Memory (HBM2) in addition to FPGA logic.
  - GX devices include FPGA logic and L- and H-Tile transceivers.
  - TX devices include FPGA logic and E- and H-Tile transceivers.
1.2.1. Secure Device Manager

The SDM comprises peripherals, cryptographic IP and sensors, boot ROM, triple-redundant lockstep processors, and other blocks shown in the block diagram below. The SDM performs and manages the following security functions:

- **Configuration bitstream authentication**: After power-on during startup, the SDM triple-redundant lockstep processors run code from the boot ROM. The boot ROM code authenticates the Intel-generated configuration firmware and configuration bitstream, ensuring that configuration bitstream is from a trusted source. All Intel Stratix 10 support authentication.

- **Encryption**: Encryption protects the configuration bitstream or confidential data from unauthorized third-party access.

- **Side channel attack protection**: Side channel attack protection guards AES Key and confidential data under non-intrusive attacks.

- **Integrity checking**: Integrity checking verifies that an accidental event has not corrupted the configuration bitstream. This function is active, even if you do not enable authentication.
These security features are available in Intel Stratix 10 devices that support advanced security. The following table lists the security features that Intel Stratix 10 devices support.

<table>
<thead>
<tr>
<th>Intel Stratix 10</th>
<th>Authentication</th>
<th>Advanced Security</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX</td>
<td>Yes</td>
<td>-AS suffix devices</td>
</tr>
<tr>
<td>SX</td>
<td>Yes</td>
<td>-AS suffix devices</td>
</tr>
<tr>
<td>MX</td>
<td>Yes</td>
<td>-AS suffix devices</td>
</tr>
<tr>
<td>TX</td>
<td>Yes</td>
<td>-AS suffix devices</td>
</tr>
<tr>
<td>DX</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Here is an overview of the additional functions the SDM controls:

- The Power Management block consists of a voltage and temperature sensor which enables the SmartVID feature via an external PMBus voltage regulator when you select -V devices.
- The AES/SHA and other Crypto Accelerator blocks implement secure configuration and boot.
- The Key Vault provides volatile and non-volatile cryptographic key storage. To mitigate potential side-channel attacks, crypto functions that use keys require a special hardware storage mechanism.
• The AS and SD/MMC configuration flash controllers enable active configuration schemes via dedicated SDM pins.

• The x8 Avalon-ST configuration scheme uses SDM I/O pins. The x16 and x32 Avalon-ST configuration schemes use dedicated SDM I/O pins and dual-purpose I/O pins. Refer to the SDM Pin Mapping for more information.

• To reduce configuration file size and support smaller memory sizes, and enable faster configuration, the Intel Quartus Prime software compresses the configuration data. All Intel Stratix 10 devices compress the configuration bitstream. You cannot disable this feature. If specify an encrypted configuration bitstream, the Intel Quartus Prime Pro Edition software compresses the configuration bitstream before encryption.

• A specific PCIe block included in the Intel Stratix 10 device supports CvP.

Related Information
• SDM Pin Mapping on page 26
• Intel Stratix 10 Device Feature Status Description
  For information about security features that are currently supported and security features that are planned to be supported in the future.

1.2.1.1. Updating the SDM Firmware

When you generate a configuration bitstream using the File ▶ Programming File Generator menu item, the bitstream assembler adds all firmware (including the SDM firmware) that matches the Intel Quartus Prime Pro Edition Release to the .sof.

Depending on the configuration scheme you specify the resulting file can be in any of the following formats:

• Raw Binary File, .rbf
• Programmer Object File, .pof
• JTAG Indirect Configuration, .jic
• Raw Programming Data, .rpd
• Jam*Standard Test and Programming Language (STAPL) STAPL, .jam
• Jam Byte Code, .jbc
Newer versions of the Intel Quartus Prime software typically include new or updated SDM features implemented in firmware. When regenerating your configuration bitstream, Intel recommends using the latest version of the Intel Quartus Prime Pro Edition Software which includes the latest firmware. You do not need to recompile your .sof to use the firmware from a newer version of the Intel Quartus Prime Pro Edition Software. You can simply regenerate your configuration bitstream with the new version of the Programming File Generator.

1.2.1.2. Specifying Boot Order for Intel Stratix 10 SoC Devices

For Intel Stratix 10 SoC devices you can specify the configuration order, choosing either the FPGA First or the Hard Processor System (HPS) First options. When you select the FPGA First option, the SDM fully configures the FPGA, then configures the HPS SDRAM pins, loads the HPS first stage boot loader (FSBL) and takes the HPS out of reset. In this mode the fabric begins functioning just before the HPS exits reset. This use guide defines a state when the FPGA is functional. Configuration and initialization are complete.

When you select the HPS First option, the SDM first configures the HPS SDRAM pins, loads the HPS FSBL and takes the HPS out of reset. Then the HPS configures the FPGA I/O and FPGA fabric at a later time. The HPS First option has the following advantages:
• Minimizes the amount of SDM flash memory required.
• Minimizes the amount of time it takes for the HPS software to be up and running.
• Supports FPGA reconfiguration while the HPS is running.

For more information about specifying configuration order refer to the FPGA Configuration First Mode and HPS Boot First Mode chapters in the Intel Stratix 10 SoC FPGA Boot User Guide.

Related Information
• FPGA Configuration First Mode
• HPS Boot First Mode
2. Intel Stratix 10 Configuration Details

2.1. Intel Stratix 10 Configuration Timing Diagram

Figure 4. Configuration, Reconfiguration, and Error Timing Diagram

- nCONFIG
- nSTATUS (weak internal pullup)
- CONF_DONE
- INIT_DONE
- nINIT_DONE (internal signal)
- MSEL[2:0]
- Data[<n>:=1:0] (Generic)
- AVST_READY (Avalon ST only)
- AVST_VALID (Avalon ST only)
- AS_CS0 (AS only)
- Configuration State
- Power Supply Status[7:0]
- GPIO Status

Sample

Power On Reset

Reconfiguration Triggered

Reconfiguration

Configuration Error

User Mode

Configuration

Initialization

Device Clean

Idle

Configuration

Err

Idle

Power Down

Group 1

Group 2

Group 3

Tri-Stated with Weak Pull-Up

User Defined

Undetermined. Signal value is between Vccio_pio and GND

Intel Corporation. All rights reserved. Agilex, Altera, Arria, Cyclone, Enpirion, Intel, the Intel logo, MAX, Nios, Quartus and Stratix words and logos are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or other countries. Intel warrants performance of its FPGA and semiconductor products to current specifications in accordance with Intel's standard warranty, but reserves the right to make changes to any products and services at any time without notice. Intel assumes no responsibility or liability arising out of the application or use of any information, product, or service described herein except as expressly agreed to in writing by Intel. Intel customers are advised to obtain the latest version of device specifications before relying on any published information and before placing orders for products or services.

*Other names and brands may be claimed as the property of others.
The SDM drives Intel Stratix 10 device configuration.

**Initial Configuration Timing**

The first section of the figure shows the expected timing for initial configuration after a normal power-on reset. Initially, the application logic drives the \texttt{nCONFIG} signal low (POR). Under normal conditions \texttt{nSTATUS} follows \texttt{nCONFIG} because \texttt{nSTATUS} reflects the current configuration state. \texttt{nCONFIG} must only change when it has the same value as \texttt{nSTATUS}.

When an error occurs, \texttt{nSTATUS} pulses low for approximately 1 ms and asserts high when the device is ready to accept reconfiguration.

The numbers in the *Initial Configuration* part of the timing diagram mark the following events:

1. The SDM boots up and samples the \texttt{MSEL} signals to determine the specified FPGA configuration scheme. The SDM does not sample the \texttt{MSEL} pins again until the next power cycle.
2. With the \texttt{nCONFIG} signal low, the SDM enters Idle mode after booting.
3. When the external host drives \texttt{nCONFIG} signal high, the SDM initiates configuration. The SDM drives the \texttt{nSTATUS} signal high, signaling the beginning of FPGA configuration. The SDM receives the configuration bitstream on the interface that the \texttt{MSEL} bus specified in *Step 1*. The diagram shows \texttt{AVST\_READY} and \texttt{AVST\_VALID} continuously high. It is possible for \texttt{AVST\_READY} to deassert which would require \texttt{AVST\_VALID} to deassert within six cycles.
4. The SDM drives the \texttt{CONF\_DONE} signal high, indicating the SDM received the bitstream successfully.
5. When the Intel Stratix 10 device asserts \texttt{INIT\_DONE} to indicate the FPGA has entered user mode. GPIO pins exit the high impedance state. The time between the assertion of \texttt{CONF\_DONE} and \texttt{INIT\_DONE} is variable. For FPGA First configuration, \texttt{INIT\_DONE} asserts after initialization of the FPGA fabric, including registers and state machines. For HPS first configuration, the HPS application controls the time between \texttt{CONF\_DONE} and \texttt{INIT\_DONE}. \texttt{INIT\_DONE} does not assert until after the software running on the HPS such as U-Boot or the operating system (OS) initiates the configuration, the FPGA configures and enters user mode.

The entire device does not enter user mode simultaneously. Intel requires you to include the Including the Reset Release Intel FPGA IP in Your Design on page 122 in your design. Use the \texttt{nINIT\_DONE} output of the Reset Release Intel FPGA IP to hold your application logic in the reset state until the entire FPGA fabric is in user mode. Failure to include this IP in your design may result in intermittent application logic failures.
Reconfiguration Timing

The second event the timing diagram illustrates the Intel Stratix 10 device reconfiguration. If you change the MSEL setting after power-on, you must power-cycle the Intel Stratix 10. Power cycling forces the SDM to sample the MSEL pins before reconfiguring the device.

The numbers in the Reconfiguration part of the timing diagram mark the following events:
1. The external host drives \( n\text{CONFIG} \) signal low.
2. The SDM initiates device cleaning.
3. The SDM drives the \( n\text{STATUS} \) signal low when device cleaning is complete.
4. The external host drives the \( n\text{CONFIG} \) signal high to initiate reconfiguration.
5. The SDM drives the \( n\text{STATUS} \) signal high signaling the device is ready for reconfiguration and starts to reconfigure.

Configuration Error

The numbers in the Configuration Error part of the timing diagram mark the following events:
1. The SDM drives \( n\text{STATUS} \) signal low for \( 1 \text{ ms} - 0.5 \text{ ms} / +9.5 \text{ ms} \) to indicate a configuration error. The Intel Stratix 10 device does not assert \( \text{CONF\_DONE} \) indicating that configuration did not complete successfully.
2. The SDM enters the error state. During the error state, \( n\text{CONFIG} \) should be in the high state. The application must drive \( n\text{CONFIG} \) from high to low and then from low to high to restart configuration.
3. The SDM enters the idle state. The external host deasserts \( n\text{CONFIG} \). The device is ready for reconfiguration by driving a low to high transition on \( n\text{CONFIG} \). You can also power cycle the device by following the device power down sequence.

\textit{Note:} The \( n\text{CONFIG} \) signal can only change levels when it has the same value as \( n\text{STATUS} \). This restriction means that when \( n\text{STATUS} = 1 \), \( n\text{CONFIG} \) can transition from 1 to 0. When \( n\text{STATUS} = 0 \), \( n\text{CONFIG} \) can transition from 0 to 1. Apart from error reporting, \( n\text{STATUS} \) only changes to follow \( n\text{CONFIG} \).

Power Supply Status

The power-on reset (POR) holds the Intel Stratix 10 device in the reset state until the power supply outputs are within the recommended operating range. \( t_{\text{RAMP}} \) defines the maximum power supply ramp time. If POR does not meet the \( t_{\text{RAMP}} \) time, the Intel Stratix 10 device I/O pins and programming registers remain tri-stated.

For more information about POR refer to the \textit{Intel Stratix 10 Power Management User Guide}. For more information about \( t_{\text{RAMP}} \) refer to the \textit{Intel Stratix 10 datasheet}. 
Related Information

- **Quad SPI Flash Layout** on page 155
  For information about storing firmware, configuration, and application data in flash devices.

- **Intel Intel Stratix 10 Device Datasheet**
  For the following timing diagrams that define set-up, hold, and propagation delay timing parameters: *AS Configuration Serial Output Timing Diagram, AS Configuration Serial Input Timing Diagram,* and *Avalon ST Configuration Timing Diagram.*

- **Intel Intel Stratix 10 Power Management User Guide**

- **Should clocks and resets in user logic be gated until the configuration process is completed in Intel Stratix 10?**
2.2. Configuration Flow Diagram

This topic describes the configuration flow for Intel Stratix 10 devices.

Figure 5. Intel Stratix 10 FPGA Configuration Flow

- Configuration Pass Flow
- Configuration Fail Flow
- Reconfiguration Flow

*FPGA first mode, fabric configuration begins immediately.
HPS first mode, HPS configures the fabric.

**minimum = 0.5 ms, maximum = 10.0 ms
Power Up

- The Intel Stratix 10 power supplies power following the guidelines in the *Power-Up Sequence Requirements for Intel Stratix 10 Devices* section of the *Intel Stratix 10 Power Management User Guide*.
- A device-wide power-on reset (POR) asserts after the power supplies reach the correct operating voltages. The external power supply ramp must not be slower than the minimum ramping rate until the supplies reach the operating voltage.
- During configuration, internal circuitry pulls the SDM_IO0, SDM_IO8, and SDM_IO16 low internally. Internal circuitry pulls the remaining SDM_IO pins to a weak high.
- After POR, internal circuitry also pulls all GPIO pins to a weak high until the device enters user mode.

SDM Startup

- The SDM samples the MSEL pins during power-on.
- If MSEL is set to JTAG, the SDM remains in the Startup state.
- The SDM runs firmware stored in the on-chip boot ROM and enters the Idle state until the host drives nCONFIG high. The host should not drive nCONFIG high before all clocks are stable.

Idle

- The SDM remains in IDLE state until the external host initiates configuration by driving the nCONFIG pin from low to high. Alternatively, the SDM enters the idle state after it exits the error state.

Configuration Start

- After the SDM receives a configuration initiation request (nCONFIG = HIGH), the SDM signals the beginning of configuration by driving the nSTATUS pin high.
- Upon receiving configuration data, the SDM performs authentication, decryption and decompression.
- The nCONFIG pin remains high during configuration and in user mode. The host monitors the nSTATUS pin continuously for configuration errors.

Configuration Pass

- The SDM drives the CONF_DONE pin high after successfully receiving full bitstream.
- The CONF_DONE pin signals an external host that bitstream transfer is successful.
Configuration Error

- A low pulse on the nSTATUS pin indicates a configuration error.
- Errors require reconfiguration.
- After a low pulse indicating an error, configuration stops. The nSTATUS pin remains high.
- Following an error, the SDM drives nSTATUS low after the external host drives nCONFIG low.
- The device enters Idle state after the nSTATUS pin recovers to initial pre-configuration low state.

User Mode

- The SDM drives the INIT_DONE pin high after initializing internal registers and releases GPIO pins from the high impedance state. The device enters user mode. The entire device does not enter user mode simultaneously. Intel requires you to include the Reset Release in your design. Use the nINIT_DONE output of the Reset Release Intel FPGA IP to hold your application logic in the reset state until the entire FPGA fabric is in user mode. Failure to include this IP in your design may result in intermittent application logic failures.
- The nCONFIG pin should remain high in user mode.
- You may re-configure the device by driving nCONFIG pin from low to high.

Device Clean

- In the Device Clean state the design stops functioning.
- Device cleaning zeros out all configuration data.
- The Intel Stratix 10 device drives CONF_DONE and INIT_DONE low.
- The SDM drives the nSTATUS pin low when device cleaning completes.

JTAG Configuration

*Note:* You can perform JTAG configuration anytime from any state except the power-on and SDM startup state. The Intel Stratix 10 device cancels the previous configuration and accepts the reconfiguration data from the JTAG interface. The nCONFIG signal must be held in a stable state during JTAG configuration. A falling edge on the nCONFIG signal cancels the JTAG configuration.

*Note:* The SDM only samples the MSEL pins at power-on. The SDM drives nCONFIG high to initiate bitstream configuration using the configuration scheme you specified at power-on.
2.3. Additional Clock Requirements for HPS, PCIe, eSRAM, and HBM2

The Intel Stratix 10 device has additional clock requirements for PCIe, HPS EMIF, eSRAM, and the High Bandwidth Memory (HBM2) IP.

To avoid configuration failures, the Intel Stratix 10 device requires additional clocks for the PCIe, HPS EMIF, eSRAM, the HBM2 IP, and all E-tile variants. You must provide a free-running, stable reference clock to these blocks before configuration begins. This reference clock is in addition to the configuration clock requirements for an internal or external oscillator described in OSC_CLK_1 Requirements on page 38. These blocks and their specific clock names are as listed below.

- HBM2: pll_ref_clk and ext_core_clk
- eSRAM: CLK_ESRAM_\([0,1]p\) and CLK_ESRAM_\([0,1]n\)
- HPS EMIF: pll_ref_clk
- L- and H-tile PCIe channels: REFCLK_GXB
- E-tile: REFCLK_GXE

Note: The transceiver power supplies must be a nominal levels for successful configuration. You can use the V\(_{CC}\) and V\(_{CCP}\) power supplies for limited transceiver channel testing. Designs that include many transceivers require an auxiliary power supply to operate reliably.

2.4. Intel Stratix 10 Configuration Pins

The Intel Stratix 10 device uses SDM_I/O pins for device configuration. Control of SDM I/O pins passes from internal FPGA circuitry, to the Boot ROM, and finally to the value your application logic specifies.
1. After power-on, SDM I/O pins 0, 8, and 16 have weak pull-downs. All other SDM I/O pins have weak pull-ups. (These initial voltage levels ensure correct operation during initialization. For example, for Avalon-ST configuration SDM_IO8 is the Avalon-ST ready signal which should not be asserted until the device reaches the FPGA Configuration state.)

2. The Boot ROM samples MSEL to determine the configuration scheme you specified and drives pins required for that configuration scheme. SDM I/O pins not required for your configuration scheme remain weakly pulled up.

3. In approximately 10 ms the SDM I/O pins take on the state that your design specifies.

4. After device cleaning, the SDM reads pin information from firmware and restores the pin states that your design specifies. If you reconfigure the device, the SDM uses the updated pin information when initializing the device.

2.4.1. SDM Pin Mapping

You can use SDM I/O pins for configuration and other functions such as power management and SEU detection. You specify SDM I/O pin functions using the Device ➤ Configuration ➤ Device and Pin Options dialog box in the Intel Quartus Prime software. All SDM input signals include Schmitt triggers. All SDM outputs are open collector.

Fixed SDM I/O Pin Assignments for Avalon-ST x8 and AS x4

The Avalon-ST x8 and AS x4 configuration schemes use the dedicated SDM I/O pin assignments listed in the table below. Use the assignments in this table for MSEL and AVSTx8_DATA0 to AVSTx8_DATA8 and AS x4.

<table>
<thead>
<tr>
<th>SDM Pins</th>
<th>MSEL Function</th>
<th>Configuration Source Function</th>
<th>Avalon-ST x8</th>
<th>AS x4</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDM_IO0</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>SDM_IO1</td>
<td>—</td>
<td>AVSTx8_DATA2</td>
<td>AS_DATA1</td>
<td>—</td>
</tr>
<tr>
<td>SDM_IO2</td>
<td>—</td>
<td>AVSTx8_DATA0</td>
<td>AS_CLK</td>
<td>—</td>
</tr>
<tr>
<td>SDM_IO3</td>
<td>—</td>
<td>AVSTx8_DATA3</td>
<td>AS_DATA2</td>
<td>—</td>
</tr>
<tr>
<td>SDM_IO4</td>
<td>—</td>
<td>AVSTx8_DATA1</td>
<td>AS_DATA0</td>
<td>—</td>
</tr>
<tr>
<td>SDM_IO5</td>
<td>MSEL0</td>
<td>—</td>
<td>AS_nCS0</td>
<td>—</td>
</tr>
<tr>
<td>SDM_IO6</td>
<td>—</td>
<td>AVSTx8_DATA4</td>
<td>AS_DATA3</td>
<td>—</td>
</tr>
<tr>
<td>SDM_IO7</td>
<td>MSEL1</td>
<td>—</td>
<td>AS_nCS2</td>
<td>—</td>
</tr>
</tbody>
</table>

continued...
### 2.4.2. MSEL Settings

After power-on MSEL[2:0] pins specify the configuration scheme for Intel Stratix 10 devices. Use 4.7-kΩ resistors to pull the MSEL[2:0] pins up to VCCIO_SDM or down to ground as required by the MSEL[2:0] setting for your configuration scheme.

![MSEL Pull-Up and Pull-Down Circuit Diagram](image)

**Related Information**
- Intel Stratix 10 Device Pinouts
- Intel Stratix 10 Device Family Pin Connection Guidelines
## Table 4. MSEL Settings for Each Configuration Scheme of Intel Stratix 10 Devices

<table>
<thead>
<tr>
<th>Configuration Scheme</th>
<th>MSEL[2:0]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avalon-ST (x32)</td>
<td>000</td>
</tr>
<tr>
<td>Avalon-ST (x16)</td>
<td>101</td>
</tr>
<tr>
<td>Avalon-ST (x8)</td>
<td>110</td>
</tr>
<tr>
<td>AS (Fast mode – for CvP)(2)</td>
<td>001</td>
</tr>
<tr>
<td>AS (Normal mode)</td>
<td>011</td>
</tr>
<tr>
<td>SD/MMC x4/x8</td>
<td>100</td>
</tr>
<tr>
<td>JTAG only(3)</td>
<td>111</td>
</tr>
</tbody>
</table>

You must also specify the configuration scheme on the **Configuration** page of the **Device and Pin Options** dialog box in the Intel Quartus Prime Software.

### Figure 7. Specify Configuration Scheme to Specify MSEL Value

### 2.4.3. Device Configuration Pins for Optional Configuration Signals

All configuration schemes use the same dedicated pins for the standard control signals shown in the *Intel Stratix 10 Configuration Timing Diagram*. Many other optional configuration signals do not have dedicated pin assignments.

#### Device Configuration Pins without Fixed Assignments

(2) If you use AS Fast mode and are not concerned about 100 ms PCIe linkup, you must still ramp the $V_{CCIO_{SDM}}$ supply within 18 ms. This ramp-up requirement ensures that the AS x4 device is within its operating voltage range when the Intel Stratix 10 device begins to access it.

(3) JTAG configuration works with any valid MSEL settings, unless disabled for security.
**Note:** Although the CONF_DONE and INIT_DONE configuration signals are not required, Intel recommends that you use these signals as an indicator to ensure that configuration is successful. The SDM drives the CONF_DONE signal high after successfully receiving full bitstream. The SDM drives the INIT_DONE signal high to indicate the device is fully in user mode. These signals are important when debugging configuration.

Table 5. Available SDM I/O Pin Assignments for Configuration Signals that Do Not Use Dedicated SDM I/O Pins

<table>
<thead>
<tr>
<th>Signal Names</th>
<th>Avalon-ST Configuration Scheme</th>
<th>AS x4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x8</td>
<td>x16</td>
</tr>
<tr>
<td>PWRMGT_SCL</td>
<td>SDM_IO0</td>
<td>SDM_IO0</td>
</tr>
<tr>
<td></td>
<td>SDM_IO14</td>
<td>SDM_IO14</td>
</tr>
<tr>
<td>PWRMGT_SDA</td>
<td>SDM_IO12</td>
<td>SDM_IO11</td>
</tr>
<tr>
<td></td>
<td>SDM_IO16</td>
<td>SDM_IO12</td>
</tr>
<tr>
<td></td>
<td>SDM_IO16</td>
<td>SDM_IO16</td>
</tr>
<tr>
<td>PWRMGT_ALERT</td>
<td>SDM_IO0</td>
<td>SDM_IO0</td>
</tr>
<tr>
<td></td>
<td>SDM_IO9</td>
<td>SDM_IO9</td>
</tr>
<tr>
<td></td>
<td>SDM_IO12</td>
<td>SDM_IO12</td>
</tr>
<tr>
<td>CONF_DONE</td>
<td>SDM_IO0</td>
<td>SDM_IO0</td>
</tr>
<tr>
<td></td>
<td>SDM_IO1</td>
<td>SDM_IO1</td>
</tr>
<tr>
<td></td>
<td>SDM_IO2</td>
<td>SDM_IO2</td>
</tr>
<tr>
<td></td>
<td>SDM_IO3</td>
<td>SDM_IO3</td>
</tr>
<tr>
<td></td>
<td>SDM_IO4</td>
<td>SDM_IO4</td>
</tr>
<tr>
<td></td>
<td>SDM_IO5</td>
<td>SDM_IO5</td>
</tr>
<tr>
<td></td>
<td>SDM_IO6</td>
<td>SDM_IO6</td>
</tr>
<tr>
<td></td>
<td>SDM_IO7</td>
<td>SDM_IO7</td>
</tr>
<tr>
<td></td>
<td>SDM_IO10</td>
<td>SDM_IO9</td>
</tr>
<tr>
<td></td>
<td>SDM_IO11</td>
<td>SDM_IO10</td>
</tr>
<tr>
<td></td>
<td>SDM_IO12</td>
<td>SDM_IO11</td>
</tr>
<tr>
<td></td>
<td>SDM_IO13</td>
<td>SDM_IO12</td>
</tr>
<tr>
<td></td>
<td>SDM_IO14</td>
<td>SDM_IO13</td>
</tr>
<tr>
<td></td>
<td>SDM_IO15</td>
<td>SDM_IO14</td>
</tr>
<tr>
<td></td>
<td>SDM_IO16</td>
<td>SDM_IO15</td>
</tr>
</tbody>
</table>

*continued...*
<table>
<thead>
<tr>
<th>Signal Names</th>
<th>Configuration Scheme</th>
<th>Avalon-ST</th>
<th>AS x4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>x8</td>
<td>x16</td>
</tr>
<tr>
<td>INIT_DONE</td>
<td></td>
<td>SDM_I00</td>
<td>SDM_I00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I05</td>
<td>SDM_I01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I012</td>
<td>SDM_I02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I016</td>
<td>SDM_I03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I04</td>
<td>SDM_I04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I05</td>
<td>SDM_I05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I06</td>
<td>SDM_I06</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I07</td>
<td>SDM_I07</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I09</td>
<td>SDM_I09</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I10</td>
<td>SDM_I10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I11</td>
<td>SDM_I11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I12</td>
<td>SDM_I12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I13</td>
<td>SDM_I13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I14</td>
<td>SDM_I14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I15</td>
<td>SDM_I15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I16</td>
<td>SDM_I16</td>
</tr>
<tr>
<td>CVPCONF_DONE</td>
<td>Not supported</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I010</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I011</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I012</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I013</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I014</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I015</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I016</td>
<td></td>
</tr>
<tr>
<td>SEU_ERROR</td>
<td></td>
<td>SDM_I00</td>
<td>SDM_I00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I05</td>
<td>SDM_I01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I07</td>
<td>SDM_I02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I09</td>
<td>SDM_I03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I012</td>
<td>SDM_I04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I016</td>
<td>SDM_I05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM_I06</td>
<td>SDM_I06</td>
</tr>
<tr>
<td>Signal Names</td>
<td>Configuration Scheme</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td></td>
<td>Avalon-ST</td>
<td>x8</td>
<td>x16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO7</td>
<td>SDM.IO7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO9</td>
<td>SDM.IO9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO10</td>
<td>SDM.IO10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO11</td>
<td>SDM.IO11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO12</td>
<td>SDM.IO12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO13</td>
<td>SDM.IO13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO14</td>
<td>SDM.IO14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO15</td>
<td>SDM.IO15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO16</td>
<td>SDM.IO16</td>
</tr>
<tr>
<td>HPS_COLD_nRESET</td>
<td>SDM.IO0</td>
<td>SDM.IO0</td>
<td>SDM.IO0</td>
</tr>
<tr>
<td></td>
<td>SDM.IO5</td>
<td>SDM.IO1</td>
<td>SDM.IO1</td>
</tr>
<tr>
<td></td>
<td>SDM.IO7</td>
<td>SDM.IO2</td>
<td>SDM.IO2</td>
</tr>
<tr>
<td></td>
<td>SDM.IO9</td>
<td>SDM.IO3</td>
<td>SDM.IO3</td>
</tr>
<tr>
<td></td>
<td>SDM.IO12</td>
<td>SDM.IO4</td>
<td>SDM.IO4</td>
</tr>
<tr>
<td></td>
<td>SDM.IO16</td>
<td>SDM.IO5</td>
<td>SDM.IO5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO6</td>
<td>SDM.IO6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO7</td>
<td>SDM.IO7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO9</td>
<td>SDM.IO9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO10</td>
<td>SDM.IO10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO11</td>
<td>SDM.IO11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO12</td>
<td>SDM.IO12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO13</td>
<td>SDM.IO13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO14</td>
<td>SDM.IO14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO15</td>
<td>SDM.IO15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDM.IO16</td>
<td>SDM.IO16</td>
</tr>
<tr>
<td>Direct to Factory Image</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

*continued...*
## 2. Intel Stratix 10 Configuration Details

### 2.4.3.1. Specifying Optional Configuration Pins

You enable and assign the SDM I/O pins using the Intel Quartus Prime software.

Complete the following steps to assign these additional configuration pins:

1. On the **Assignments** menu, click **Device**.
2. In the **Device and Pin Options** dialog box, select the **Configuration** category and click **Configuration Pins Options**.
3. In the **Configuration Pin** window, enable and assign the configuration pin that you want to include in your design.

**Note:** Intel recommends that you assign the CONF_DONE and INIT_DONE pins to SDM I/O pins 0 or 16. These pins have weak internal pull-downs resistors. If you cannot use these pins, Intel recommends that you include external 4.7-kΩ pull-down resistors to avoid false signaling.
4. Click **OK** to confirm and close the **Configuration Pin** dialog box.
2.4.3.2. Enabling Dual-Purpose Pins

AVST_CLK, AVST_DATA[15:0], AVST_DATA[31:16], and AVST_VALID are dual-purpose pins. Once the device enters user mode these pins can function either as GPIOs or as tri-state inputs.

If you use these pins as GPIOs, make the following assignments:

- Set \( V_{CCIO} \) of the I/O bank at 1.8 V
- Assign the 1.8 V I/O standard to these pins

Complete the following steps to assign these settings to the dual-purpose pins:

1. On the Assignments menu, click Device.
2. In the Device and Pin Options dialog box, select the Dual-Purpose Pins category.
3. In the Dual-purpose pins table, set the pin functionality in the Value column.

4. Click OK to confirm and close the Device and Pin Options

Attention: When you use the Avalon ST configuration scheme the dual-purpose Avalon ST pins have the following restrictions:

- You cannot use the Avalon-ST interface for partial reconfiguration (PR).
- You cannot use the Avalon-ST pins in user mode in designs that include the HPS. This restriction means that you cannot use the Avalon-ST as dual-purpose I/Os in designs that include the HPS.
2.4.3.3. Configuration Pins I/O Standard, Drive Strength, and IBIS Model

Table 6. Intel Stratix 10 Configuration Pins I/O Standard, Drive Strength, and IBIS Model

<table>
<thead>
<tr>
<th>Configuration Pin Function</th>
<th>Direction</th>
<th>I/O Standard</th>
<th>Drive Strength (mA)</th>
<th>IBIS Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>TDO</td>
<td>Output</td>
<td>1.8V LVCMOS</td>
<td>8</td>
<td>18_io_d8s1_sdm_lvl</td>
</tr>
<tr>
<td>TMS</td>
<td>Input</td>
<td>Schmitt Trigger Input</td>
<td>—</td>
<td>18_in_sdm_lv</td>
</tr>
<tr>
<td>TCK</td>
<td>Input</td>
<td>Schmitt Trigger Input</td>
<td>—</td>
<td>18_in_sdm_lv</td>
</tr>
<tr>
<td>TDI</td>
<td>Input</td>
<td>Schmitt Trigger Input</td>
<td>—</td>
<td>18_in_sdm_lv</td>
</tr>
<tr>
<td>nSTATUS</td>
<td>Output</td>
<td>1.8V LVCMOS</td>
<td>8</td>
<td>18_in_sdm_lv</td>
</tr>
<tr>
<td>OSC_CLK_1</td>
<td>Input</td>
<td>Schmitt Trigger Input</td>
<td>—</td>
<td>18_in_sdm_lv</td>
</tr>
<tr>
<td>nCONFIG</td>
<td>Input</td>
<td>Schmitt Trigger Input</td>
<td>—</td>
<td>18_in_sdm_lv</td>
</tr>
<tr>
<td>SDM_IO[16:0]</td>
<td>I/O</td>
<td>Schmitt Trigger Input or 1.8V LVCMOS</td>
<td>8</td>
<td>Input: 18_in_sdm_lv, Output: 18_in_sdm_lv</td>
</tr>
<tr>
<td>AVST_DATA[31:0], AVST_CLK, AVST_VALID</td>
<td>I/O</td>
<td>Schmitt Trigger Input or 1.8V LVCMOS</td>
<td>8</td>
<td>Input: 18_in_sdm_lv, Output: 18_in_sdm_lv</td>
</tr>
</tbody>
</table>

You can download the IBIS models from the IBIS Models for Intel Devices web page. The Intel Quartus Prime software does not support IBIS model generation for configuration pins in the current release.

Unused SDM Pins

You can specify other functions on unused SDM pins in the Intel Quartus Prime software.

Related Information

IBIS Models for Intel Devices

2.4.3.4. SDM I/O Pins for Power Management and SmartVID

SDM pins are also available for the SmartVID power management feature for -V devices.
Intel recommends that you use the Analog Devices LTM4677 Dual 18A or Single 36A μModule Regulator with Digital Power System Management to regulate the PMBus. The LTM4677 device is the default setting for the Device ➤ Device and Pin Options ➤ Power Management & VID ➤ Slave device type parameter. If you are using a different PMBus regular change the default setting from LTM4677 to Other.

**Figure 8. Specifying the Slave Device Type for Power Management and VID**

Refer to the *Intel Stratix 10 Power Management User Guide* for more information about the pin assignments and PMBus setting.

**Related Information**

Intel Stratix 10 Power Management User Guide
2.4.3.5. Specifying Pins for Partial Reconfiguration (PR)

The partial reconfiguration signals use GPIO pins.

The following signals control partial reconfiguration in Intel Stratix 10 devices:
- PR_REQUEST
- PR_READY
- PR_ERROR
- PR_DONE

Connect these partial reconfiguration signals to the Partial Reconfiguration External Configuration Controller Intel FPGA IP.

Related Information
Creating a Partial Reconfiguration Design

2.5. Configuration Clocks

2.5.1. Setting Configuration Clock Source

You must specify the configuration clock source by selecting either the internal oscillator or OSC_CLK_1 with the supported frequency. By default, the SDM uses the internal oscillator for device configuration. Specify an OSC_CLK_1 clock source for the fastest configuration time.

Complete the following steps to select the configuration clock source:
1. To specify OSC_CLK_1 as the clock source, on the Assignments menu, click Device.
2. In the Device and Pin Options dialog box, select the General category.
3. Specify the configuration clock source from the Configuration clock source drop down menu.
4. Click **OK** to confirm and close the **Device and Pin Options**.

**Related Information**

OSC_CLK_1 Clock Input on page 38

### 2.5.2. OSC_CLK_1 Clock Input

**OSC_CLK_1 Requirements**

When you drive the **OSC_CLK_1** input clock with an external clock source and enable **OSC_CLK_1** in the Intel Quartus Prime software, the device loads the majority of the configuration bitstream at 250 MHz. Intel Stratix 10 devices include an internal oscillator in addition to **OSC_CLK_1** which runs the configuration process at a frequency between 170-230 MHz. Intel Stratix 10 devices always use this internal oscillator to load the first section of the bitstream, approximately 200 kilobyte (KB). The SDM can use either clock source for the remainder of device configuration. If you use the internal oscillator, you can leave the **OSC_CLK_1** unconnected.
Note: Device configuration may fail under the following conditions when you select the OSC_CLK_1 as the clock source for configuration:

• You fail to drive the OSC_CLK_1 pin.
• You drive the OSC_CLK_1 pin at an incorrect frequency. Select one of the following input reference clock frequencies to drive the OSC_CLK_1 pin:
  — 25 MHz
  — 100 MHz
  — 125 MHz

The Intel Stratix 10 device multiplies the OSC_CLK_1 source clock frequency to generate a 250 MHz clock for configuration. Using an OSC_CLK_1 source enables the fastest possible configuration. Refer to Setting Configuration Clock Source for instructions setting this frequency using the Intel Quartus Prime Software.

You can also specify this frequency by editing your .qsf file. Here are the possible assignments:

```sh
# EXTERNAL OSCILLATOR CLOCK VIA OSC_CLK_1 PIN
set_global_assignment -name DEVICE_INITIALIZATION_CLOCK OSC_CLK_1_25MHZ
set_global_assignment -name DEVICE_INITIALIZATION_CLOCK OSC_CLK_1_100MHZ
set_global_assignment -name DEVICE_INITIALIZATION_CLOCK OSC_CLK_1_125MHZ
```

Configuration Clock Requirements for Reconfiguration Without Power Cycling the Device

When you specify OSC_CLK_1 for configuration and reconfigure without powering down the Intel Stratix 10 device, the device can only reconfigure with OSC_CLK_1. In this scenario, OSC_CLK_1 must be a free-running clock.

Configuration Clock Requirements for Configuration After Powering Cycling the Device

After a power-down, when you specify OSC_CLK_1 for configuration, the Intel Stratix 10 device uses the internal oscillator to load the first section of the bitstream and OSC_CLK_1 for the remainder.

Related Information

• Intel Stratix 10 L- and H-Tile Transceiver PHY User Guide
• Intel Stratix 10 E-Tile Transceiver PHY User Guide
• Intel Stratix 10 External Memory Interfaces IP User Guide
• Setting Configuration Clock Source on page 37
3. Intel Stratix 10 Configuration Schemes

3.1. Avalon-ST Configuration

The Avalon-ST configuration scheme replaces the FPP mode available in earlier device families. Avalon-ST is the fastest configuration scheme for Intel Stratix 10 devices. This scheme uses an external host, such as a microprocessor, MAX® II, MAX V, or Intel MAX 10 device to drive configuration. The external host controls the transfer of configuration data from external storage such as flash memory to the FPGA. The logic that controls the configuration process resides in the external host. You can use the PFL II IP with a MAX II, MAX V, or Intel MAX 10 device as the host to read configuration data from the flash memory device and configure the Intel Stratix 10 device. The Avalon-ST configuration scheme is called passive because the external host, not the Intel Stratix 10 device, controls configuration.

Table 7. Avalon-ST Configuration Data Width, Clock Rates, and Data Rates
Mb is an abbreviation for Megabits per second.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Data Width (bits)</th>
<th>Max Clock Rate</th>
<th>Max Data Rate</th>
<th>MSEL[2:0]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avalon-ST</td>
<td>32</td>
<td>125 MHz</td>
<td>4000 Mb</td>
<td>000</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>125 MHz</td>
<td>2000 Mb</td>
<td>101</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>125 MHz</td>
<td>1000 Mb</td>
<td>110</td>
</tr>
</tbody>
</table>

Table 8. Required Configuration Signals for the Avalon-ST Configuration Scheme
You can use an 8-, 16-, or 32-bit Avalon-ST configuration data bus. You specify SDM I/O pin functions using the Device ➤ Configuration ➤ Device and Pin Options dialog box in the Intel Quartus Prime software. For the Avalon-ST x16 and x32 configuration, you can reassign the GPIO, dual-purpose configuration pins for other functions in user mode using the Device ➤ Configuration ➤ Device and Pin Options ➤ Dual-Purpose Pins dialog box.

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Pin Type</th>
<th>Direction</th>
<th>Powered by</th>
</tr>
</thead>
<tbody>
<tr>
<td>nSTATUS</td>
<td>SDM I/O</td>
<td>Output</td>
<td>V_{CCIO,SDM}</td>
</tr>
<tr>
<td>nCONFIG</td>
<td>SDM I/O</td>
<td>Input</td>
<td>V_{CCIO,SDM}</td>
</tr>
</tbody>
</table>
### 3. Intel Stratix 10 Configuration Schemes

**Signal Name** | **Pin Type** | **Direction** | **Powered by**
--- | --- | --- | ---
MSEL[2:0] | SDM I/O, Dual-Purpose | Input | $V_{CCIO_{_SDM}}$
CONF_DONE(4) | SDM I/O | Output | $V_{CCIO_{_SDM}}$
AVST READY | SDM I/O | Output | $V_{CCIO_{_SDM}}$
AVSTx8_DATA[7:0] | SDM I/O | Input | $V_{CCIO_{_SDM}}$
AVSTx8_VALID | SDM I/O | Input | $V_{CCIO_{_SDM}}$
AVSTx8_CLK | SDM I/O | Input | $V_{CCIO_{_SDM}}$
AVST DATA[31:0] | GPIO, Dual-Purpose | Input | $V_{CCIO}$
AVST VALID | GPIO, Dual-Purpose | Input | $V_{CCIO}$
AVST CLK | GPIO, Dual-Purpose | Input | $V_{CCIO}$

Refer to the *Intel Stratix 10 Data Sheet* for configuration timing estimates.

**Note:** Although the INIT DONE configuration signal is not required for configuration, Intel recommends that you use this signal. The SDM drives the INIT DONE signal high to indicate the device is fully in user mode. This signal is important when debugging configuration.

**Note:** If you create custom logic instead of using the PFL II IP to drive configuration, refer to the *Avalon Streaming Interfaces* in the *Avalon Interface Specifications* for protocol details.

**Related Information**
- Device Configuration Pins for Optional Configuration Signals on page 28
- SDM Pin Mapping on page 26
- Avalon Interface Specifications
- Intel Stratix 10 Device Data Sheet
- Intel Stratix 10 Device Features
  - For a list of device features that are planned for future releases.

(4) CONF_DONE is required if you are using the Intel FPGA Parallel Flash Loader II IP as the configuration host.
3.1.1. Avalon-ST Configuration Scheme Hardware Components and File Types

You can use the following components to implement the Avalon-ST configuration scheme:

- A CPLD with PFL II IP and common flash interface (CFI) flash or Quad SPI flash memory
- A custom host, typically a microprocessor, with any external memory
- The Intel FPGA Download Cable II to connect the Intel Quartus Prime Programmer to the PCB.

The following block diagram illustrates the components and design flow using the Avalon-ST configuration scheme.

**Figure 9. Components and Design Flow for .pof Programming**
Table 9. Output File Types

<table>
<thead>
<tr>
<th>Programming File Type</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programmer Object File</td>
<td>.pof</td>
<td>The .pof is a proprietary Intel FPGA file type. Use the PFL II IP core via a JTAG header to write the .pof to an external CFI flash or serial flash device.</td>
</tr>
<tr>
<td>Raw Binary File</td>
<td>.rbf</td>
<td>You can also use the .rbf with the Avalon-ST configuration scheme and an external host such as a CPU or microcontroller. You can program the configuration bitstreams or data in the .rbf file directly into flash via a third-party programmer. Then, you can use an external host to configure the device with the Avalon-ST configuration scheme.</td>
</tr>
</tbody>
</table>

If you choose a third-party microprocessor for Avalon-ST configuration, refer to the *Avalon Streaming Interfaces* in the *Avalon Interface Specifications* for protocol details.

### 3.1.2. Enabling Avalon-ST Device Configuration

You enable the Avalon-ST device configuration scheme in the Intel Quartus Prime software.

Complete the following steps to specify an Avalon-ST interface for device configuration.

1. On the **Assignments** menu, click **Device**.
2. In the **Device and Pin Options** dialog box, select the **Configuration** category.
3. In the **Configuration** window, in the **Configuration scheme** dropdown list, select the appropriate Avalon-ST bus width.
4. Click **OK** to confirm and close the **Device and Pin Options** dialog box.
3.1.3. The AVST_READY Signal

Before beginning configuration, trigger device cleaning by toggling the nCONFIG pin from high to low to high. This nCONFIG transition also returns the device to the configuration state.

Figure 10. Monitoring the AVST_READY Signal and Responding to Backpressure

The configuration files for Intel Stratix 10 devices can be highly compressed. During configuration, the decompression of the bit stream inside the device requires the host to pause before sending more data. The Intel Stratix 10 device asserts the AVST_READY signal when the device is ready to accept data. The AVST_READY signal is only valid when the nSTATUS pin is high. In addition, the host must handle backpressure by monitoring the AVST_READY signal and may assert AVST_VALID signal any time after the assertion of AVST_READY signal. The host must monitor the AVST_READY signal throughout the configuration.

The AVST_READY signal sent by the Intel Stratix 10 device to the host is not synchronized with the AVSTx8_CLK or AVST_CLK. To configure the Intel Stratix 10 device successfully, the host must adhere to the following constraints:

- The host must drive no more than six data words after the deassertion of the AVST_READY signal including the delay incurred by the 2-stage register synchronizer.
- The host must synchronize the AVST_READY signal to the AVST_CLK signal using a 2-stage register synchronizer. Here is Register transfer level (RTL) example code for 2-stage register synchronizer:

```verilog
always @(posedge avst_clk or negedge reset_n)
begin
  if (~reset_n)
    begin
      fpga_avst_ready_reg1 <= 0;
    end
```
fpga_avst_ready_reg2 <= 0;
else
  fpga_avst_ready_reg1 <= fpga_avst_ready;
fpga_avst_ready_reg2 <= fpga_avst_ready_reg1;
end

Where:

- The AVST_CLK signal comes from either PFL II IP or your Avalon-ST controller logic.
- fpga_avst_ready is the AVST_READY signal from the Intel Stratix 10 device.
- fpga_avst_ready_reg2 signal is the AVST_READY signal that is synchronous to AVST_CLK.

You must properly constrain the AVST_CLK and AVST_DATA signals at the host. Perform timing analysis on both signals between the host and Intel Stratix 10 device to ensure the Avalon-ST configuration timing specifications are met. Refer to the Avalon-ST Configuration Timing section of the Intel Stratix 10 Device Data Sheet for information about the timing specifications.

Note: The AVST_CLK signal must run continuously during configuration. The AVST_READY signal cannot assert unless the clock is running.

Optionally, you can monitor the CONF_DONE signal to indicate the flash has sent all the data to FPGA or to indicate the configuration process is complete.

If you use the PFL II IP core as the configuration host, you can use the Intel Quartus Prime software to store the binary configuration data to the flash memory through the PFL II IP core.

If you use the Avalon-ST Adapter IP core as part of the configuration host, set the Source Ready Latency value between 1-6.

Avalon-ST x8 configuration scheme uses the SDM pins only. Avalon-ST x16 and x32 configuration scheme only use dual-purpose I/O pins that you can use as general-purpose I/O pins after configuration.

Related Information
- Avalon-ST Configuration Timing in Intel Stratix 10 Device Datasheet
- Avalon Interface Specifications
3.1.4. RBF Configuration File Format

If you do not use the Parallel Flash Loader II Intel FPGA IP core to program the flash, you must generate the .rbf file.

The data in .rbf file are in little-endian format

Table 10. Writing 32-bit Data
For a x32 data bus, the first byte in the file is the least significant byte of the configuration double word, and the fourth byte is the most significant byte.

<table>
<thead>
<tr>
<th>Double Word = 01EE1B02</th>
</tr>
</thead>
<tbody>
<tr>
<td>LSB: BYTE0 = 02</td>
</tr>
<tr>
<td>BYTE1 = 1B</td>
</tr>
<tr>
<td>BYTE2 = EE</td>
</tr>
<tr>
<td>MSB: BYTE3 = 01</td>
</tr>
<tr>
<td>D[7:0]</td>
</tr>
<tr>
<td>D[15:8]</td>
</tr>
<tr>
<td>D[23:16]</td>
</tr>
<tr>
<td>D[31:24]</td>
</tr>
<tr>
<td>0000 0010</td>
</tr>
<tr>
<td>0001 1011</td>
</tr>
<tr>
<td>1110 1110</td>
</tr>
<tr>
<td>0000 0001</td>
</tr>
</tbody>
</table>

Table 11. Writing 16-bit Data
For a x16 data bus, the first byte in the file is the least significant byte of the configuration word, and the second byte is the most significant byte of the configuration word.

<table>
<thead>
<tr>
<th>WORD0 = 1B02</th>
</tr>
</thead>
<tbody>
<tr>
<td>LSB: BYTE0 = 02</td>
</tr>
<tr>
<td>MSB: BYTE1 = 1B</td>
</tr>
<tr>
<td>LSB: BYTE2 = EE</td>
</tr>
<tr>
<td>MSB: BYTE3 = 01</td>
</tr>
<tr>
<td>D[7:0]</td>
</tr>
<tr>
<td>D[15:8]</td>
</tr>
<tr>
<td>D[7:0]</td>
</tr>
<tr>
<td>D[15:8]</td>
</tr>
<tr>
<td>0000 0010</td>
</tr>
<tr>
<td>0001 1011</td>
</tr>
<tr>
<td>1110 1110</td>
</tr>
<tr>
<td>0000 0001</td>
</tr>
</tbody>
</table>

3.1.5. Avalon-ST Single-Device Configuration

Refer to the Intel Stratix 10 Device Family Pin Connection Guidelines for additional information about individual pin usage and requirements.
Figure 11. Connections for Avalon-ST x8 Single-Device Configuration
Figure 12. Connections for Avalon-ST x16 Single-Device Configuration
Figure 13. Connections for Avalon-ST x32 Single-Device Configuration
Notes for Figure:

1. Refer to MSEL Settings for the correct resistor pull-up and pull-down values for all configuration schemes.
2. The MSEL pins are dual-purpose. After power-on, you can reassign these pins to other functions. For more information, refer to Enabling Dual Purpose Pins.
3. The synchronizers shown in all three figures can be internal if the host is an FPGA or CPLD. If the host is a microprocessor, you must use discrete synchronizers.

Related Information

- MSEL Settings on page 27
- Enabling Dual-Purpose Pins on page 34
- Intel Stratix 10 Device Family Pin Connection Guidelines

3.1.6. Debugging Guidelines for the Avalon-ST Configuration Scheme

The Avalon-ST configuration scheme replaces the previously available in fast passive parallel (FPP) modes. This configuration scheme retains similar functionality and performance. Here are the important differences:

- The Avalon-ST configuration scheme requires you to monitor the flow control signal, AVST_READY. The AVST_READY signal indicates if the device can receive configuration data.
- The AVST_CLK and AVSTx8_CLK clock signals cannot pause when configuration data is not being transferred. Data is not transferred when AVST_READY and AVST_VALID are low. The AVST_CLK and AVSTx8_CLK clock signals must run continuously until CONF_DONE asserts.

Debugging Suggestions

Review the general Configuration Debugging Checklist in the Debugging Guide chapter before considering these debugging tips that pertain to the Avalon-ST configuration scheme.

- Only assert AVST_VALID after the SDM asserts AVST_READY.
- Only assert AVST_VALID when the AVST_DATA is valid.
- Ensure that the AVST_CLK clock signal is continuous and free running until configuration completes. The AVST_CLK can stop after CONF_DONE asserts. The initialization state does not require the AVST_CLK signal.
- If using x8 mode, ensure that you use the dedicated SDM_IO pins for this interface (clock, data, valid and ready).
- If using x16 or x32 mode, power the I/O bank containing the x16 or x32 pins (I/O Bank 3A) at 1.8 V.
• Ensure you select the appropriate Avalon-ST configuration scheme in your Intel Quartus Prime Pro Edition project.
• Ensure the MSEL pins reflect this mode on the PCB.
• Verify that host device does not drive configuration pins before the Intel Stratix 10 device powers up.

Related Information
Intel Stratix 10 Debugging Guide on page 191

3.1.7. QSF Assignments for Avalon-ST x8

You can specify many Intel Quartus Prime project settings using Intel Quartus Prime Software GUI or by editing the Intel Quartus Prime Settings File (.qsf). The following assignments in the .qsf show typical settings for a Intel Stratix 10 device using Avalon-ST x8 configuration.

These settings are for a Intel Stratix 10 SmartVID device operating in PMBus slave mode which requires most of the SDM_IO pins. Refer to the Intel Stratix 10 Power Management User Guide for the PMBus constraints in master mode.

```bash
# Fitter Assignments
# ==================
set_global_assignment -name CONFIGURATION_VCCIO_LEVEL 1.8V

# SDM IO Assignments
# ==================
set_global_assignment -name USE_PWRMGT_SCL SDM_IO0
set_global_assignment -name USE_PWRMGT_SDA SDM_IO12
set_global_assignment -name USE_PWRMGT_ALERT SDM_IO9
set_global_assignment -name USE_CONF_DONE SDM_IO16
set_global_assignment -name USE_SEU_ERROR SDM_IO5

# Configuration settings
# ======================
# The following setting also supports Intel Stratix 10 devices
set_global_assignment -name STRATIXV_CONFIGURATION_SCHEME "AVST X8"
set_global_assignment -name USE_CONFIGURATION_DEVICE OFF
set_global_assignment -name ERROR_CHECK_FREQUENCY_DIVISOR 256
set_global_assignment -name GENERATE_PR_RBF_FILE ON
set_global_assignment -name ENABLE_ED_CRC_CHECK ON
set_global_assignment -name MINIMUM_SEU_INTERVAL 479

# SmartVID feature PMBus settings [Slave mode settings only]
```
You can also set the SDM_IO configuration pins using the **Assignments ➤ Device ➤ Device and Pin Options ➤ Configuration ➤ Configuration Pin Options**.

**Figure 14.** Set SDM_IO Configuration Pins Using the Intel Quartus Prime Software
3.1.8. QSF Assignments for Avalon-ST x16

You can specify many Intel Quartus Prime project settings using Intel Quartus Prime Software GUI or by editing the Intel Quartus Prime Settings File (.qsf). The following assignments in the .qsf show typical settings for a Intel Stratix 10 device using Avalon-ST x16 configuration.

These settings are for a Intel Stratix 10 SmartVID device operating in PMBus slave mode which requires most of the SDM_IO pins. Refer to the Intel Stratix 10 Power Management User Guide for the PMBus constraints in master mode.

```plaintext
# Fitter Assignments
# ==================
set_global_assignment -name CONFIGURATION_VCCIO_LEVEL 1.8V

# SDM IO Assignments
# ==================
set_global_assignment -name USE_PWRMGT_SCL SDM_IO0
set_global_assignment -name USE_PWRMGT_SDA SDM_IO12
set_global_assignment -name USE_PWRMGT_ALERT SDM_IO9
set_global_assignment -name USE_CONF_DONE SDM_IO16
set_global_assignment -name USE_SEU_ERROR SDM_IO5

# Configuration settings
# ======================
# The following setting also supports Intel Stratix 10 devices
set_global_assignment -name STRATIXV_CONFIGURATION_SCHEME "AVST X16"
set_global_assignment -name USE_CONFIGURATION_DEVICE OFF
set_global_assignment -name ERROR_CHECK_FREQUENCY_DIVISOR 256
set_global_assignment -name GENERATE_PR_RBF_FILE ON
set_global_assignment -name ENABLE_ED_CRC_CHECK ON
set_global_assignment -name MINIMUM_SEU_INTERVAL 479

# SmartVID feature PMBus settings [Slave mode settings only]
# ----------------------------------------------------------
set_global_assignment -name VID_OPERATION_MODE "PMBUS_SLAVE"
set_global_assignment -name PWRMGT_DEVICE_ADDRESS_IN_PMBUS_SLAVE_MODE 3F
```
You can also set the SDM_IO configuration pins using the Assignments ➤ Device ➤ Device and Pin Options ➤ Configuration ➤ Configuration Pin Options.

Figure 15. Set SDM_IO Configuration Pins Using the Intel Quartus Prime Software

Related Information

- PMBus Master Mode
  In the Intel Stratix 10 Power Management User Guide
3.1.9. QSF Assignments for Avalon-ST x32

You can specify many Intel Quartus Prime project settings using Intel Quartus Prime Software GUI or by editing the Intel Quartus Prime Settings File (*.qsf). The following assignments in the *.qsf show typical settings for an Intel Stratix 10 device using Avalon-ST x32 configuration.

These settings are for an Intel Stratix 10 SmartVID device operating in PMBus slave mode which requires most of the SDM_IO pins. Refer to the Intel Stratix 10 Power Management User Guide for the PMBus constraints in master mode.

```plaintext
# Fitter Assignments
# ===============
set_global_assignment -name CONFIGURATION_VCCIO_LEVEL 1.8V

# SDM IO Assignments
# ================
set_global_assignment -name USE_PWRMGT_SCL SDM_IO14
set_global_assignment -name USE_PWRMGT_SDA SDM_IO16
set_global_assignment -name USE_PWRMGT_ALERT SDM_IO12
set_global_assignment -name USE_CONF_DONE SDM_IO5
set_global_assignment -name USE_INIT_DONE SDM_IO0
set_global_assignment -name USE_SEU_ERROR SDM_IO1

# Configuration settings
# ======================

# The following setting also supports Intel Stratix 10 devices
set_global_assignment -name STRATIXV_CONFIGURATION_SCHEME "AVST X32"
set_global_assignment -name USE_CONFIGURATION_DEVICE OFF
set_global_assignment -name ERROR_CHECK_FREQUENCY_DIVISOR 256
set_global_assignment -name ENABLE_ED_CRC_CHECK ON
set_global_assignment -name MINIMUM_SEU_INTERVAL 479

# SmartVID feature PMBus settings [Slave mode settings only]
# ==========================================================
set_global_assignment -name VID_OPERATION_MODE "PMBUS SLAVE"
set_global_assignment -name PWRMGT_DEVICE_ADDRESS_IN_PMBUS_SLAVE_MODE 3F
```

You can also set the SDM_IO configuration pins using the Assignments ➤ Device ➤ Device and Pin Options ➤ Configuration ➤ Configuration Pin Options.
Figure 16. Set SDM_IO Configuration Pins Using the Intel Quartus Prime Software

Related Information

- PMBus Master Mode
  In the Intel Stratix 10 Power Management User Guide
3.1.10. IP for Use with the Avalon-ST Configuration Scheme: Intel FPGA Parallel Flash Loader II IP Core

3.1.10.1. Functional Description

You can use the Parallel Flash Loader II Intel FPGA IP (PFL II) with an external host, such as the MAX II, MAX V, or Intel MAX 10 devices to complete the following tasks:

- Program configuration data into a flash memory device using JTAG interface.
- Configure the Intel Stratix 10 device with the Avalon-ST configuration scheme from the flash memory device.

*Note:* Use the Parallel Flash Loader II IP Intel FPGA IP and not the earlier Parallel Flash Loader IP with the Avalon-ST configuration scheme in Intel Stratix 10 devices.

3.1.10.1.1. Generating and Programming a .pof into CFI Flash

The Intel Quartus Prime software generates the .sof when you compile your design. You use the .sof to generate the .pof. This process includes the following steps:

2. Using the Intel Quartus Prime Programmer to write the Intel Stratix 10 device .pof to the flash device.

**Figure 17.** Programming the CFI Flash Memory with the JTAG Interface
The PFL II IP core supports dual flash memory devices in burst read mode to achieve faster configuration times. You can connect two MT29EW CFI flash memory devices to the host in parallel using the same data bus, clock, and control signals. During FPGA configuration, the AVST_CLK frequency is four times faster than the flash_clk frequency.

**Figure 18. PFL II IP core with Dual CFI Flash Memory Devices**
The flash memory devices must have the same memory density from the same device family and manufacturer.

---

**Related Information**
Intel Stratix 10 GX FPGA Development Kit

**3.1.10.1.2. Controlling Avalon-ST Configuration with PFL II IP Core**
The PFL II IP core in the host determines when to start the configuration process, read the data from the flash memory device, and configure the Intel Stratix 10 device using the Avalon-ST configuration scheme.
You can use the PFL II IP core to either program the flash memory devices, configure your FPGA, or both. To perform both functions, create separate PFL II functions if any of the following conditions apply to your design:

- You modify the flash data infrequently.
- You have JTAG or In-System Programming (ISP) access to the configuration host.
- You want to program the flash memory device with non-Intel FPGA data, for example initialization storage for an ASSP.

You can use the PFL II IP core to program the flash memory device for the following purposes:
- To write the initialization data
- To store your design source code to implement the read and initialization control with the host logic

### 3.1.10.1.3. Mapping PFL II IP Core and Flash Address

The address connections between the PFL II IP core and the flash memory device vary depending on the flash memory device vendor and data bus width.
Figure 20. **Flash Memory in 8-Bit Mode**
The address connection between the PFL II IP core and the flash memory device are the same.

<table>
<thead>
<tr>
<th>PFL II</th>
<th>Flash Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Figure 21. **Flash Memories in 16-Bit Mode**
The flash memory addresses in 16-bit flash memory shift one bit down in comparison with the flash addresses in PFL II IP core. The flash address in the flash memory starts from bit 1 instead of bit 0.

<table>
<thead>
<tr>
<th>PFL II</th>
<th>Flash Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>23</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>
Figure 22. Cypress and Micron M28, M29 Flash Memory in 8-Bit Mode
The flash memory addresses in Cypress 8-bit flash shifts one bit up. Address bit 0 of the PFL II IP core connects to data pin \( D_{15} \) of the flash memory.

![Diagram showing the address mapping between PFL II and flash memory in 8-bit mode.]

Figure 23. Cypress and Micron M28, M29 Flash Memory in 16-Bit Mode
The address bit numbers in the PFL II IP core and the flash memory device are the same.

![Diagram showing the address mapping between PFL II and flash memory in 16-bit mode.]

3. Intel Stratix 10 Configuration Schemes
UG-S10CONFIG | 2019.12.16
### 3.1.10.1.4. Implementing Multiple Pages in the Flash .pof

The PFL II IP core stores configuration data in a maximum of eight pages in a flash memory block.

The total number of pages and the size of each page depends on the flash density. Here are some guidelines for storing your designs to pages:

- Always store designs for different FPGA chains on different pages.
- You may choose to store different designs for a FPGA chain on a single page or on multiple pages.
- When you choose to store the designs for a FPGA chain on a single page, the design order must match the JTAG chain device order.

Use the generated .sof to create a flash memory device .pof. The following address modes are available for the .sof to .pof conversion:

- **Block mode**—allows you to specify the start and end addresses for the page.
- **Start mode**—allows you to specify only the start address. The start address for each page must be on an 8 KB boundary. If the first valid start address is $0x000000$, the next valid start address is an increment of $0x2000$.
- **Auto mode**—allows the Intel Quartus Prime software to automatically determine the start address of the page. The Intel Quartus Prime software aligns the pages on a 128 KB boundary. If the first valid start address is $0x000000$, the next valid start address is a multiple of $0x20000$.

### 3.1.10.1.5. Storing Option Bits

In addition to design data, the flash memory stores the option bits. You must specify the address for the options bits in two places: the PFL II IP and in the option bits address of the flash memory device.

The option bits contain the following information:

- The start address for each page.
- The .pof version for flash programming. This value is the same for all pages.
- The Page-Valid bits for each page. The Page-Valid bit is bit 0 of the start address. The PLF II IP core writes this bit after successfully programming the page.

You use the **Programming File Generator** dialog box to specify the **Start address** of the option bits. Specify your flash device using **Add Device** on the **Configuration Tab** of the **Programming File Generator** dialog box. Then click **OPTIONS** and **EDIT** to specify the **Start address** for the option bits. This **Start address** must match the address you specify for **What is the byte address of the option bits, in hex?** when specifying the PFL II IP parameters.
You set the option bits in the PFL II IP Intel FPGA IP using the parameter editor. By default the PFL II IP displays Flash Programming for the What operating mode will be used? parameter. In this default state, the FPGA Configuration tab is not visible. Select either FPGA Configuration or Flash Programming and FPGA Configuration for the What operating mode will be used parameter on the General tab. The following figure shows the FPGA Configuration option.

**Figure 24. General Tab of the PFL II IP**

Specify the options bits hex address for the What is the base address of the option bits, in hex? parameter on the FPGA Configuration tab.
You use the Programming File Generator dialog box to specify the Start address of the option bits. Specify your flash device using Add Device on the Configuration Tab of the Programming File Generator dialog box. Then click OPTIONS and EDIT to specify the Start address for the option bits. This Start address must match the address you specify for What is the byte address of the option bits, in hex? when specifying the PFL II IP parameters.

The Intel Quartus Prime Programming File Generator generates the information for the .pof version when you convert the .sofs to .pofs. The value for the .pof version for Intel Stratix 10 is 0x05. The following table shows an example of page layout for a .pof using all eight pages. This example stores the .pof version at 0x80.
Table 12. Option Bits Sector Format

<table>
<thead>
<tr>
<th>Sector Offset</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00–0x03</td>
<td>Page 0 start address</td>
</tr>
<tr>
<td>0x04–0x07</td>
<td>Page 0 end address</td>
</tr>
<tr>
<td>0x08–0x0B</td>
<td>Page 1 start address</td>
</tr>
<tr>
<td>0x0C–0x0F</td>
<td>Page 1 end address</td>
</tr>
<tr>
<td>0x10–0x13</td>
<td>Page 2 start address</td>
</tr>
<tr>
<td>0x14–0x17</td>
<td>Page 2 end address</td>
</tr>
<tr>
<td>0x18–0x1B</td>
<td>Page 3 start address</td>
</tr>
<tr>
<td>0x1C–0x1F</td>
<td>Page 3 end address</td>
</tr>
<tr>
<td>0x20–0x23</td>
<td>Page 4 start address</td>
</tr>
<tr>
<td>0x24–0x27</td>
<td>Page 4 end address</td>
</tr>
<tr>
<td>0x28–0x2B</td>
<td>Page 5 start address</td>
</tr>
<tr>
<td>0x2C–0x2F</td>
<td>Page 5 end address</td>
</tr>
<tr>
<td>0x30–0x33</td>
<td>Page 6 start address</td>
</tr>
<tr>
<td>0x34–0x37</td>
<td>Page 6 end address</td>
</tr>
<tr>
<td>0x38–0x3B</td>
<td>Page 7 start address</td>
</tr>
<tr>
<td>0x3C–0x3F</td>
<td>Page 7 end address</td>
</tr>
<tr>
<td>0x40–0x47</td>
<td>Reserved</td>
</tr>
<tr>
<td>0x80(5)</td>
<td>.pof version</td>
</tr>
<tr>
<td>0x81–0xFF</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

**Caution:** To prevent the PFL II IP core from malfunctioning, do not overwrite any information in the option bits sector. Always store the option bits in unused addresses in the flash memory device.

(5) The .pof version occupies only one byte in the option bits sector.
3.1.10.1.6. Verifying the Option Bit Start and End Addresses

You can decode the start and end address that you specified for each of the SOF page when converting a `.sof` to `.pof` file from the 32-bit value of the sector offset address. If you encounter a configuration error you can verify that the generated bitstream addresses match the addresses you specified in the Intel Quartus Prime Software.

The following table shows the bit fields of the start address.

**Table 13. Start Address Bit Content**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:11</td>
<td>21</td>
<td>Addressable start address</td>
</tr>
<tr>
<td>10:1</td>
<td>10</td>
<td>Reserved bits</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>Page valid bit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0=Valid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1=Error</td>
</tr>
</tbody>
</table>

**Table 14. End Address Bit Content**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:0</td>
<td>32</td>
<td>Addressable end address</td>
</tr>
</tbody>
</table>

To restore the addresses:
- Start address—append `13'b0000000000000` to the addressable start address
- End address—append `2'b11` to the addressable end address

For a `.pof` that has two page addresses with the values shown in the following table.

<table>
<thead>
<tr>
<th>Sector Offset</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00 – 0x03</td>
<td>0x00004000</td>
</tr>
<tr>
<td>0x04 – 0x07</td>
<td>0x00196E30</td>
</tr>
<tr>
<td>0x08 – 0x0B</td>
<td>0x001C0000</td>
</tr>
</tbody>
</table>
3. Intel Stratix 10 Configuration Schemes

### Sector Offset

<table>
<thead>
<tr>
<th>Sector Offset</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0C - 0x0F</td>
<td>0x00352E30</td>
</tr>
</tbody>
</table>

For Page 0 if you append the start address bits[31:11] with 13'b0000000000000, the result is 32'b00000000000000000000000000000000 = 0x10000.

If you append the end address 0x00196E0 with 2'b11, the result is 26'b00011001011011100011000011 = 0x65B8C3.

For Page 1 if you append the start address with 13'b0000000000000, the result is 32'b00000000000111000000000000000000 = 0x70000.

If you append end address 0x00352E30 with 2’b11, the result is 32'b00000000110101001011100011000011 = 0xD4B8C3.

The start and end address must be correlated with the start and end address for each page printed in the .map file.

### 3.1.10.1.7 Implementing Page Mode and Option Bits in the CFI Flash Memory Device

The following figure shows an sample layout of a .pof with three pages. The end addresses depend on the density of the flash memory device. For different density devices refer to the Byte Address Range for CFI Flash Memory Devices with Different Densities table below. The option bits follow the configuration data in memory.
The following figure shows the layout of the option bits for a single page. Because the start address must be on an 8 KB boundary, bits 0-12 of the page start address are set to zero and are not stored in the option bits.
The Page-Valid bits indicate whether each page is successfully programmed. The PFL II IP core sets the Page-Valid bits after successfully programming the pages.

Table 15. Byte Address Range for CFI Flash Memory Devices with Different Densities

<table>
<thead>
<tr>
<th>CFI Device (Megabit)</th>
<th>Address Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>0x00000000–0x00FFFFF</td>
</tr>
<tr>
<td>16</td>
<td>0x00000000–0x01FFFFF</td>
</tr>
<tr>
<td>32</td>
<td>0x00000000–0x03FFFFF</td>
</tr>
<tr>
<td>64</td>
<td>0x00000000–0x07FFFFF</td>
</tr>
</tbody>
</table>
### Using the PFL II IP Core

#### Converting .sof to .pof File

You can use the Programming File Generator to convert the .sof file to a .pof. The Programming File Generator options change dynamically according to your device and configuration mode selection.

1. Click **File ➤ Programming File Generator**.
2. For **Device family** select **Intel Stratix 10**.
3. For **Configuration mode** select Avalon-ST configuration scheme that you plan to use.
4. For **Output directory**, click **Browse** to select your output file directory.
5. For **Name** specify a name for your output file.
6. On the **Output Files** tab, enable the checkbox for generation of the file or files you want to generate.
7. Specify the **Output directory** and **Name** for the file or files you generate.
Figure 28. Programming File Generator Output Files Tab

8. To specify a .sof that contains the configuration bitstream, on the Input Files tab, click Add Bitstream.
9. To include raw data, click **Add Raw Data** and specify a Hexadecimal (Intel-Format) Output File (.hex) or binary (.bin) file. This step is optional.

10. On the **Configuration Device** tab, click **Add device**. The **Add Device** dialog box appears. Select your flash device from the drop-down list of available parallel flash devices.

11. Click **OPTIONS** and then **Edit**. In the **Edit Partition** dialog box specify the **Start address** of the **Options** in flash memory. This address must match the address you specify for **What is the byte address of the option bits, in hex?** when specifying the PFL II IP parameters. Ensure that the option bits sector does not overlap with the configuration data pages and that the start address is on an 8 KB boundary.
12. With the flash device selected, click **Add Partition** to specify a partition in flash memory.
Figure 31.  Add Flash Device and Partition

a. For Name select a Partition name.
b. For Input File specify the .sof.
c. From the Page dropdown list, select the page to write this .sof.
d. For Address mode select the addressing mode to use.

The following modes are available:
• **Auto**—For the tool to automatically allocate a block in the flash device to store the data.
• **Block**—To specify the start and end address of the flash partition.
• **Start**—To specify the start address of the partition. The tool assigns the end address of the partition based on the input data size.

  e. For **Block** and **Start** options, specify the address information.

### 3.1.10.2.2. Creating Separate PFL II Functions

Follow these steps to create separate PFL II IP instantiations for programming and configuration control:

1. In the IP Catalog locate the Parallel Flash Loader II Intel FPGA IP.
2. On the **General** tab for **What operating mode will be used**, select **Flash Programming Only**.
3. Intel recommends that you turn on the **Set flash bus pins to tri-state when not in use**.
4. Specify the parameters on the **Flash Interface Settings** and **Flash Programming** tabs to match your design.
5. Compile and generate a **.pof** for the flash memory device. Ensure that you tri-state all unused I/O pins.
6. To create a second PFL II instantiation for FPGA configuration, on the **General** tab, for **What operating mode will be used**, select **FPGA Configuration**.
7. Use this **Flash Programming Only** instance of the PFL II IP to write data to the flash device.
8. Whenever you must program the flash memory device, program the CPLD with the flash memory device **.pof** and update the flash memory device contents.
9. Reprogram the host with the production design **.pof** that includes the configuration controller.

**Note:** By default, all unused pins are set to ground. When programming the configuration flash memory device through the host JTAG pins, you must tri-state the FPGA configuration pins common to the host and the configuration flash memory device. You can use the **pfl_flash_access_request** and **pfl_flash_access_granted** signals of the PFL II block to tri-state the correct FPGA configuration pins.
3.1.10.2.3. Programming CPLDs and Flash Memory Devices Sequentially

This procedure provides a single set of instructions for the Intel Quartus Prime Programmer to configure the CPLD and write the flash memory device.

1. Open the **Programmer** and click **Add File** to add the `.pof` for the CPLD.
2. Right-click the **CPLD .pof** and click **Attach Flash Device**.
3. In the **Flash Device** menu, select the appropriate density for the flash memory device.
4. Right-click the flash memory device density and click **Change File**.
5. Select the `.pof` generated for the flash memory device. The Programmer appends the `.pof` for the flash memory device to the `.pof` for the CPLD.
6. Repeat this process if your chain has additional devices.
7. Check all the boxes in the **Program/Configure** column for the new `.pof` and click **Start** to program the CPLD and flash memory device.

3.1.10.2.4. Programming CPLDs and Flash Memory Devices Separately

Follow these instructions to program the CPLD and the flash memory devices separately:

1. Open the **Programmer** and click **Add File**.
2. In the **Select Programming File**, add the targeted `.pof`, and click **OK**.
3. Check the boxes under the **Program/Configure** column of the `.pof`.
4. Click **Start** to program the CPLD.
5. After the programming progress bar reaches 100%, click **Auto Detect**.
   For example, if you are using dual Micron or Macronix flash devices, the programmer window shows a dual chain in your setup. Alternatively, you can add the flash memory device to the programmer manually. Right-click the CPLD `.pof` and click **Attach Flash Device**. In the **Select Flash Device** dialog box, select the device of your choice.
6. Right-click the flash memory device density and click **Change File**.
Note: For designs with more than one flash device, you must select the density that is equivalent to the sum of the densities of all devices. For example, if the design includes two 512-Mb CFI flash memory devices, select CFI 1 Gbit.

7. Select the .pof generated for the flash memory device. The Programmer attaches the .pof for the flash memory device to the .pof of the CPLD.

8. Check the boxes under the Program/Configure column for the added .pof and click Start to program the flash memory devices.

Note: If your design includes the PFL II IP the Programmer allows you to program, verify, erase, blank-check, or examine the configuration data page, the user data page, and the option bits sector separately. The programmer erases the flash memory device if you select the .pof of the flash memory device before programming. To prevent the Programmer from erasing other sectors in the flash memory device, select only the pages, .hex data, and option bits.

3.1.10.2.5. Defining New CFI Flash Memory Device

The PFL II IP core supports Intel- and AMD-compatible flash memory devices. In addition to the supported flash memory devices, you can define the new Intel- or AMD-compatible CFI flash memory device in the PFL II-supported flash database using the Define New CFI Flash Device function.

To add a new CFI flash memory device to the database or update a CFI flash memory in the database, follow these steps:

1. In the Programmer window, on the Edit menu, select Define New CFI Flash Device. The following table lists the three functions available in the Define CFI Flash Device window.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Add a new Intel- or AMD-compatible CFI flash memory device into the PFL II-supported flash database.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit the parameters of the newly added Intel- or AMD-compatible CFI flash memory device in the PFL II-supported flash database.</td>
</tr>
<tr>
<td>Remove</td>
<td>Remove the newly added Intel- or AMD-compatible CFI flash memory device from the PFL II-supported flash database.</td>
</tr>
</tbody>
</table>

2. To add a new CFI flash memory device or edit the parameters of the newly added CFI flash memory device, select New or Edit. The New CFI Flash Device dialog box appears.

3. In the New CFI Flash Device dialog box, specify or update the parameters of the new flash memory device. You can obtain the values for these parameters from the data sheet of the flash memory device manufacturer.
**Figure 32. Using the Programmer Edit Menu to Define a New Flash Device**

![Define CFI Flash Device](image)

**Table 17. Parameter Settings for New CFI Flash Device**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFI flash device name</td>
<td>Define the CFI flash name</td>
</tr>
<tr>
<td>CFI flash device ID</td>
<td>Specify the CFI flash identifier code</td>
</tr>
<tr>
<td>CFI flash manufacturer ID</td>
<td>Specify the CFI flash manufacturer identification number</td>
</tr>
<tr>
<td>CFI flash extended device ID</td>
<td>Specify the CFI flash extended device identifier, only applicable for AMD-compatible CFI flash memory device</td>
</tr>
<tr>
<td>Flash device is Intel compatible</td>
<td>Turn on the option if the CFI flash is Intel compatible</td>
</tr>
<tr>
<td>Typical word programming time</td>
<td>Typical word programming time value in µs unit</td>
</tr>
<tr>
<td>Maximum word programming time</td>
<td>Maximum word programming time value in µs unit</td>
</tr>
<tr>
<td>Typical buffer programming time</td>
<td>Typical buffer programming time value in µs unit</td>
</tr>
<tr>
<td>Maximum buffer programming time</td>
<td>Maximum buffer programming time value in µs unit</td>
</tr>
</tbody>
</table>
Note: You must specify either the word programming time parameters, buffer programming time parameters, or both. Do not leave both programming time parameters with the default value of zero.

4. Click OK to save the parameter settings.
5. After you add, update, or remove the new CFI flash memory device, click OK.

The Windows registry stores user flash information. Consequently, you must have system administrator privileges to store the parameters in the Define New CFI Flash Device window in the Intel Quartus Prime Pro Edition Programmer.

3.1.10.3. PFL II Parameters

Table 18. PFL II General Parameters

<table>
<thead>
<tr>
<th>Options</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What operating mode will be used?</td>
<td>• Flash Programming</td>
<td>Specifies the operating mode of flash programming and FPGA configuration control in one IP core or separate these functions into individual blocks and functionality.</td>
</tr>
<tr>
<td></td>
<td>• FPGA Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Flash Programming and FPGA Configuration</td>
<td></td>
</tr>
<tr>
<td>What is the targeted flash?</td>
<td>• CFI Parallel Flash</td>
<td>Specifies the flash memory device connected to the PFL II IP core.</td>
</tr>
<tr>
<td></td>
<td>• Quad SPI Flash</td>
<td></td>
</tr>
<tr>
<td>Set flash bus pins to tri-state when not in use</td>
<td>• On</td>
<td>Allows the PFL II IP core to tri-state all pins interfacing with the flash memory device when the PFL II IP core does not require access to the flash memory.</td>
</tr>
<tr>
<td></td>
<td>• Off</td>
<td></td>
</tr>
</tbody>
</table>

Table 19. PFL II Flash Interface Setting Parameters

<table>
<thead>
<tr>
<th>Options</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>How many flash devices will be used?</td>
<td>• 1–16</td>
<td>Specifies the number of flash memory devices connected to the PFL II IP core.</td>
</tr>
<tr>
<td>What’s the largest flash device that will be used?</td>
<td>• 8 Mbit–4 Gbit</td>
<td>Specifies the density of the flash memory device to be programmed or used for FPGA configuration. If you have more than one flash memory device connected to the PFL II IP core, specify the largest flash memory device density. For dual CFI flash, select the density that is equivalent to the sum of the density of two flash memories. For example, if you use two 512-Mb CFI flashes, you must select CFI 1 Gbit.</td>
</tr>
<tr>
<td>What is the flash interface data width</td>
<td>• 8</td>
<td>Specifies the flash data width in bits. The flash data width depends on the flash memory device you use. For multiple flash memory device support, the data width must be the same for all connected flash memory devices.</td>
</tr>
<tr>
<td></td>
<td>• 16</td>
<td></td>
</tr>
</tbody>
</table>
|                                            | • 32                             |                                                                             | continued...
Options | Value | Description
--- | --- | ---
Flash programming IP optimization target | • Area • Speed | Specifies the flash programming IP optimization. If you optimize the PFL II IP core for Speed, the flash programming time is shorter, but the IP core uses more LEs. If you optimize the PFL II IP core for Area, the IP core uses fewer LEs, but the flash programming time is longer.
Flash programming IP FIFO size | • 16 • 32 | Specifies the FIFO size if you select Speed for flash programming IP optimization. The PFL II IP core uses additional LEs to implement FIFO as temporary storage for programming data during flash programming. With a larger FIFO size, programming time is shorter.
Add Block-CRC verification acceleration support | • On • Off | Adds a block to accelerate verification.

Table 21. PFL II FPGA Configuration Parameters

Options | Value | Description
--- | --- | ---
What is the external clock frequency? | Provide the frequency of your external clock. | Specifies the user-supplied clock frequency for the IP core to configure the FPGA. The clock frequency must not exceed two times the maximum clock (AVST_CLK) frequency the FPGA can use for configuration. The PFL II IP core can divide the frequency of the input clock maximum by two.

continued...
<table>
<thead>
<tr>
<th>Options</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the byte address of the option bits, in hex?</td>
<td>Provide the byte address of the option bits.</td>
<td>Specifies the option bits start address in flash memory. The start address must reside on an 8 KB boundary. This address must be the same as the bit sector address you specified when converting the .sof to a .pof. For more information refer to Storing Option Bits.</td>
</tr>
</tbody>
</table>
| Which FPGA configuration scheme will be used?     | • Avalon-ST x8  
• Avalon-ST x16  
• Avalon-ST x32 | Specifies the width of the Avalon-ST interface.                                                                                                                                                           |
| What should occur on configuration failure?       | • Halt  
• Retry same page  
• Retry from fixed address | Configuration behavior after configuration failure.  
• If you select **Halt**, the FPGA configuration stops completely after failure.  
• If you select **Retry same page**, after failure, the PFL II IP core reconfigures the FPGA with data from the page that failed.  
• If you select **Retry from fixed address**, the PFL II IP core reconfigures the FPGA a fixed address. |
| What is the byte address to retry from failure    | —                                          | If you select **Retry from fixed address** for configuration failure option, this option specifies the flash address the PFL II IP core to reads from.                                                   |
| Include input to force reconfiguration           | • On  
• Off                                     | Includes the optional `pfl_nreconfigure` reconfiguration input pin to enable reconfiguration of the FPGA.                                                                                              |
| Enable watchdog timer on Remote System Update support | • On  
• Off                                     | Enables a watchdog timer for remote system update support. Turning on this option enables the `pfl_reset_watchdog` input pin and `pfl_watchdog_error` output pin. This option also specifies the period before the watchdog timer times out. The watchdog timer runs at the `pfl_clk frequency`. |
### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time period before the watchdog timer times out</td>
<td>—</td>
<td>Specifies the time out period for the watchdog timer. The default time out period is 100 ms.</td>
</tr>
<tr>
<td>Use advance read mode?</td>
<td></td>
<td>This option improves the overall flash access time for the read process during the FPGA configuration.</td>
</tr>
<tr>
<td>• Normal mode</td>
<td></td>
<td>• Normal mode—applicable for all flash memory</td>
</tr>
<tr>
<td>• Intel Burst mode</td>
<td></td>
<td>• Intel Burst mode—Applicable for devices that support bursting. Reduces sequential read access time</td>
</tr>
<tr>
<td>• 16 byte page mode (GL only)</td>
<td></td>
<td>• 16 byte page mode (GL only)—applicable for Cypress GL flash memory only</td>
</tr>
<tr>
<td>• 32 byte page mode (MT23EW)</td>
<td></td>
<td>• 32 byte page mode (MT23EW)—applicable for MT23EW only</td>
</tr>
<tr>
<td>• Micron Burst Mode (M58BW)</td>
<td></td>
<td>• Micron Burst Mode (M58BW)—applicable for Micron M58BW flash memory only</td>
</tr>
<tr>
<td>Latency count</td>
<td></td>
<td>Specifies the latency count for <strong>Intel Burst mode</strong>.</td>
</tr>
<tr>
<td>• 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### 3.1.10.4. PFL II Signals

**Table 22. PFL II Signals**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Type</th>
<th>Weak Pull-Up</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>pfl_nreset</td>
<td>Input</td>
<td>—</td>
<td>Asynchronous reset for the PFL II IP core. Pull high to enable FPGA configuration. To prevent FPGA configuration, pull low when you do not use the PFL II IP core. This pin does not affect the PFL II IP flash programming functionality.</td>
</tr>
<tr>
<td>pfl_flash_access_granted</td>
<td>Input</td>
<td>—</td>
<td>For system-level synchronization. A processor or any arbiter that controls access to the flash drives this input pin. To use the PFL II IP core function as the flash master pull this pin high. Driving the pfl_flash_access_granted pin low prevents the JTAG interface from accessing the flash and FPGA configuration.</td>
</tr>
<tr>
<td>pfl_clk</td>
<td>Input</td>
<td>—</td>
<td>User input clock for the device. This is the frequency you specify for the <strong>What is the external clock frequency?</strong> parameter on the Configuration tab of the PFL II IP. This frequency must not be higher than the maximum DCLK frequency you specify for FPGA during configuration. This pin is not available if you are only using the PFL II IP for flash programming.</td>
</tr>
</tbody>
</table>

Continued...
<table>
<thead>
<tr>
<th>Pin</th>
<th>Type</th>
<th>Weak Pull-Up</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>fpga_pgm[]</td>
<td>Input</td>
<td>—</td>
<td>Determines the page for the configuration. This pin is not available if you are only using the PFL II IP for flash programming.</td>
</tr>
<tr>
<td>fpga_conf_done</td>
<td>Input</td>
<td>10 kΩ Pull-Up Resistor</td>
<td>Connects to the CONF_DONE pin of the FPGA. The FPGA releases the pin high if the configuration is successful. During FPGA configuration, this pin remains low. This pin is not available if you are only using the PFL II IP for flash programming.</td>
</tr>
<tr>
<td>fpga_nstatus</td>
<td>Input</td>
<td>10 kΩ Pull-Up Resistor</td>
<td>Connects to the nSTATUS pin of the FPGA. This pin is high before the FPGA configuration begins and must stay high during FPGA configuration. If a configuration error occurs, the FPGA pulls this pin low and the PFL II IP core stops reading the data from the flash memory device. This pin is not available if you are only using the PFL II IP for flash programming.</td>
</tr>
<tr>
<td>pfl_nreconfigure</td>
<td>Input</td>
<td>—</td>
<td>When low initiates FPGA reconfiguration. To implement manual control of reconfiguration connect this pin to a switch. You can use this input to write your own logic in a CPLD to trigger reconfiguration via the PFL II IP. You can use pfl_nreconfigure to drive the fpga_nconfig output signal initiating reconfiguration. The pfl_clk pin registers this signal. This pin is not available if you are only using the PFL II IP for flash programming.</td>
</tr>
<tr>
<td>pfl_flash_access_request</td>
<td>Output</td>
<td>—</td>
<td>For system-level synchronization. When necessary, this pin connects to a processor or an arbiter. The PFL II IP core drives this pin high when the JTAG interface accesses the flash or the PFL II IP configures the FPGA. This output pin works in conjunction with the flash_noe and flash_nwe pins.</td>
</tr>
<tr>
<td>flash_addr[]</td>
<td>Output</td>
<td>—</td>
<td>The flash memory address. The width of the address bus depends on the density of the flash memory device and the width of the flash_data bus. Intel recommends that you turn On the Set flash bus pins to tri-state when not in use option in the PFL II.</td>
</tr>
<tr>
<td>flash_data[]</td>
<td>Input or Output (bidirectional pin)</td>
<td>—</td>
<td>Bidirectional data bus to transmit or receive 8-, 16-, or 32-bit data. Intel recommends that you turn On the Set flash bus pins to tri-state when not in use option in the PFL II. (6)</td>
</tr>
<tr>
<td>flash_nce[]</td>
<td>Output</td>
<td>—</td>
<td>Connects to the nCE pin of the flash memory device. A low signal enables the flash memory device. Use this bus for multiple flash memory device support. The flash_nce pin connects to each nCE pin of all the connected flash memory devices. The width of this port depends on the number of flash memory devices in the chain.</td>
</tr>
</tbody>
</table>

---

(6) Intel recommends that you do not insert logic between the PFL II pins and the host I/O pins, especially on the flash_data and fpga_nconfig pins.
<table>
<thead>
<tr>
<th>Pin</th>
<th>Type</th>
<th>Weak Pull-Up</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>flash_nwe</td>
<td>Output</td>
<td></td>
<td>Connects to the nWE pin of the flash memory device. When low enables write operations to the flash memory device.</td>
</tr>
<tr>
<td>flash_noe</td>
<td>Output</td>
<td></td>
<td>Connects to the nOE pin of the flash memory device. When low enables the outputs of the flash memory device during a read operation.</td>
</tr>
<tr>
<td>flash_clk</td>
<td>Output</td>
<td></td>
<td>For burst mode. Connects to the CLK input pin of the flash memory device. The active edges of CLK increment the flash memory device internal address counter. The flash_clk frequency is half of the pfl_clk frequency in burst mode for a single CFI flash. In dual CFI flash solution, the flash_clk frequency runs at a quarter of the pfl_clk frequency. Use this pin for burst mode only. Do not connect these pins from the flash memory device to the host if you are not using burst mode.</td>
</tr>
<tr>
<td>flash_nadv</td>
<td>Output</td>
<td></td>
<td>For burst mode. Connects to the address valid input pin of the flash memory device. Use this signal to latch the start address. Use this pin for burst mode only. Do not connect these pins from the flash memory device to the host if you are not using burst mode.</td>
</tr>
<tr>
<td>flash_nreset</td>
<td>Output</td>
<td></td>
<td>Connects to the reset pin of the flash memory device. A low signal resets the flash memory device.</td>
</tr>
<tr>
<td>fpga_nconfig</td>
<td>Open Drain Output</td>
<td>10-kW Pull-Up Resistor</td>
<td>Connects to the nCONFIG pin of the FPGA. A low pulse resets the FPGA and initiates configuration. These pins are not available for the flash programming option in the PFL II IP core. (6)</td>
</tr>
<tr>
<td>pfl_reset_watchdog</td>
<td>Input</td>
<td></td>
<td>A switch signal to reset the watchdog timer before the watchdog timer times out. To reset the watchdog timer hold the signal high or low for at least two pfl_clk clock cycles.</td>
</tr>
<tr>
<td>pfl_watchdog_error</td>
<td>Output</td>
<td></td>
<td>When high indicates an error condition to the watchdog timer.</td>
</tr>
</tbody>
</table>

**Related Information**

Avalon Interface Specifications

**3.2. AS Configuration**

In AS configuration schemes, the SDM block in the Intel Stratix 10 device controls the configuration process and interfaces. The serial flash configuration device stores the configuration data. During AS Configuration, the SDM first powers on with the boot ROM. Then, the SDM loads the initial configuration firmware from AS x4 flash. After the configuration firmware loads, this firmware controls the remainder of the configuration process, including I/O configuration and FPGA core configuration. Designs including an HPS, can use the HPS to access serial flash memory after the initial configuration.
Note: The serial flash configuration device must be fully powered up at the same time or before ramping up $V_{CCIO_SDM}$ of the Intel Stratix 10 device.

The AS configuration scheme supports AS x4 (4-bit data width) mode only.

Table 23. Intel Stratix 10 Configuration Data Width, Clock Rates, and Data Rates

<table>
<thead>
<tr>
<th>Mode</th>
<th>Data Width (bits)</th>
<th>Max Clock Rate</th>
<th>Max Data Rate</th>
<th>MSEL[2:0]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active Serial (AS)</td>
<td>4</td>
<td>133 MHz</td>
<td>532 Mb</td>
</tr>
</tbody>
</table>

Table 24. Required Configuration Signals for the AS Configuration Scheme

You specify SDM I/O pin functions using the Device ➤ Configuration ➤ Device and Pin Options dialog box in the Intel Quartus Prime software. You can reassign the GPIO, dual-purpose configuration pins for other functions in user mode.

<table>
<thead>
<tr>
<th>Configuration Function</th>
<th>Pin Type</th>
<th>Direction</th>
<th>Powered by</th>
</tr>
</thead>
<tbody>
<tr>
<td>nSTATUS</td>
<td>SDM I/O</td>
<td>Output</td>
<td>$V_{CCIO_SDM}$</td>
</tr>
<tr>
<td>nCONFIG</td>
<td>SDM I/O</td>
<td>Input</td>
<td>$V_{CCIO_SDM}$</td>
</tr>
<tr>
<td>MSEL[2:0]</td>
<td>SDM I/O, Dual-Purpose</td>
<td>Input</td>
<td>$V_{CCIO_SDM}$</td>
</tr>
<tr>
<td>CONF_DONE</td>
<td>SDM I/O</td>
<td>Output</td>
<td>$V_{CCIO_SDM}$</td>
</tr>
<tr>
<td>AS_nCSO[3:0]</td>
<td>SDM I/O</td>
<td>Output</td>
<td>$V_{CCIO_SDM}$</td>
</tr>
<tr>
<td>AS_DATA[3:0]</td>
<td>SDM I/O</td>
<td>Bidirectional</td>
<td>$V_{CCIO_SDM}$</td>
</tr>
<tr>
<td>AS_CLK</td>
<td>SDM I/O</td>
<td>Output</td>
<td>$V_{CCIO_SDM}$</td>
</tr>
</tbody>
</table>

Note: Although the CONF_DONE and INIT_DONE configuration signals are not required, Intel recommends that you use these signals. The SDM drives the CONF_DONE signal high after successfully receiving full bitstream. The SDM drives the INIT_DONE signal high to indicate the device is fully in user mode. These signals are important when debugging configuration. You can reassign the GPIO, dual-purpose configuration pins for other functions in user mode.

MSEL Pin Function for the AS x4 Configuration Scheme

The SDM samples the MSEL pins immediately after power-on in the SDM Start state. After the SDM samples the MSEL pins, the MSEL pins become active-low chips selects. For AS x4 designs using one flash device, AS_nCSO asserts low. The remaining chip select pins, AS_nCS1 - AS_nCS3 deassert high.
3. Intel Stratix 10 Configuration Schemes

Related Information
- Can I use 3rd party QSPI flash devices for Active Serial configuration of Intel Stratix 10 devices?
- Device Configuration Pins for Optional Configuration Signals on page 28
- SDM Pin Mapping on page 26
- AS Configuration Timing in Intel Stratix 10 Devices
  For timing parameter minimum, typical, and maximum values.

3.2.1. AS Configuration Scheme Hardware Components and File Types

You use the following components to implement the AS configuration scheme:
- Quad SPI flash memory
- The Intel FPGA Download Cable II to connect the Intel Quartus Prime Programmer to the PCB.

The following block diagram illustrates the components and design flow using the AS configuration scheme.
In addition to AS programming using a \texttt{.jic}, the Programmer supports direct programming of the quad SPI flash using a \texttt{.pof} as shown in \textit{AS Programming Using Intel Quartus Prime or Third-Party Programmer}.

### Table 25. Output File Types

<table>
<thead>
<tr>
<th>Programming File Type</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JTAG Indirect Configuration File</td>
<td>\texttt{.jic}</td>
<td>The \texttt{.jic} enables serial flash programming via Intel FPGA JTAG pins. This file type is available only for ASx4 configuration. A newly populated board using the ASx4 configuration scheme requires initial SDM firmware programming. The helper SOF image provides the required SDM firmware. You initially use the JTAG cable to load a SDM Helper SOF into the Intel Stratix 10 device. The SDM can then load the flash device with the Intel Stratix 10 design.</td>
</tr>
</tbody>
</table>
3.2.2. AS Single-Device Configuration

Refer to the Intel Stratix 10 Device Family Pin Connection Guidelines for additional information about individual pin usage and requirements.
Figure 34. Connections for AS x4 Single-Device Configuration

Related Information
- MSEL Settings on page 27
- Intel Stratix 10 Device Family Pin Connection Guidelines
3.2.3. AS Using Multiple Serial Flash Devices

Intel Stratix 10 devices support one AS x4 flash memory device for AS configuration and up to three AS x4 flash memories for use with HPS data storage. The MSEL pins are dual-purpose and operate as MSEL only during POR state. After the FPGA device enters user mode, you can repurpose the MSEL pins as chip select pins. You must to ensure appropriate chip select pin connections to the configuration AS x4 flash memory and the HPS AS x4 flash memory. Each flash device has a dedicated AS_nCSO pin but shares other pins.

Refer to the Intel Stratix 10 Device Family Pin Connection Guidelines for additional information about individual pin usage and requirements.
Figure 35. Connections for AS Configuration with Multiple Serial Flash Devices

The following table shows the maximum supported AS_CLK frequency for a range of capacitance loading values when using multiple flash devices. The maximum AS_CLK frequency also depends on whether you use the OSC_CLK_1 or internal oscillator as the clock source.
Table 26. Maximum AS_CLK Frequency as a Function of Board Capacitance Loading and Clock Source

<table>
<thead>
<tr>
<th>Capacitance Loading (pF)</th>
<th>OSC_CLK_1 (MHz)</th>
<th>Internal Oscillator (MHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>133/125</td>
<td>115</td>
</tr>
<tr>
<td>19</td>
<td>108</td>
<td>115</td>
</tr>
<tr>
<td>30</td>
<td>100</td>
<td>77</td>
</tr>
<tr>
<td>37</td>
<td>80</td>
<td>77</td>
</tr>
<tr>
<td>80</td>
<td>50</td>
<td>58</td>
</tr>
<tr>
<td>140</td>
<td>25</td>
<td>25</td>
</tr>
</tbody>
</table>

Related Information
- MSEL Settings on page 27
- Intel Stratix 10 Device Datasheet (Core and HPS)
- Intel Stratix 10 Device Family Pin Connection Guidelines

3.2.4. AS Configuration Timing Parameters

Figure 36. AS Configuration Serial Output Timing Diagram

![AS Configuration Serial Output Timing Diagram](image)
3.2.5. Maximum Allowable External AS_DATA Pin Skew Delay Guidelines

You must minimize the skew on the AS data pins.

Skew delay includes the following elements:
- The delay due to the differences in board traces lengths on the PCB
- The capacitance loading of the flash device

The table below lists the maximum allowable skew delay depending on the AS_CLK frequency. Intel recommends that you to perform IBIS simulations to ensure that the skew delay does not exceed the maximum delay specified in this table.

Table 27. Maximum Skew for AS Data Pins in Nanoseconds (ns)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Frequency</th>
<th>Min</th>
<th>Typical</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>$T_{ext_skew}$</td>
<td>Skew delay for AS_DATA for the AS_CLK frequency specified</td>
<td>133 MHz</td>
<td>−</td>
<td>−</td>
<td>3.60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>125 MHz</td>
<td>−</td>
<td>−</td>
<td>4.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>115 MHz</td>
<td>−</td>
<td>−</td>
<td>4.20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>108 MHz</td>
<td>−</td>
<td>−</td>
<td>4.60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>100 MHz</td>
<td>−</td>
<td>−</td>
<td>5.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;100 MHz</td>
<td>−</td>
<td>−</td>
<td>5.0</td>
</tr>
</tbody>
</table>

Note: For more information about the timing parameters, refer to the Intel Stratix 10 Device Datasheet.
3.2.6. Programming Serial Flash Devices

You can program serial flash devices in-system using the Intel FPGA Download Cable II or Intel FPGA Ethernet Cable.

You have the following two in-system programming options:

- Active Serial
- JTAG

3.2.6.1. Programming Serial Flash Devices using the AS Interface

When you select AS programming the Intel Quartus Prime software or any supported third-party software programs the configuration data directly into the serial flash device.

You must set MSEL to JTAG. When MSEL is set to JTAG, the SDM tristates the following AS pins: AS_CLK, AS_DATA0-AS_DATA3, and AS_nCS0-AS_nCS3. The Intel Quartus Prime Programmer programs the flash memory devices via the AS header. If you are using the Generic Serial Flash Interface Intel FPGA IP to write the flash memory the flash device must be connected to GPIO to access the flash device.
Figure 38. AS Programming Using Intel Quartus Prime or Third-Party Programmer

External clock source to is optional.

JTAG mode: Pull MSEL [2] high


AS normal mode: Pull MSEL [1] high
3.2.6.2. Programming Serial Flash Devices using the JTAG Interface

The Intel Quartus Prime Programmer interfaces to the SDM device through JTAG interface and programs the serial flash device. The SDM emulates AS programming.

Figure 39. Programming Your Serial Configuration Device Using JTAG and SDM Emulation of AS
Figure 40. Connections for Programming the Serial Flash Devices using the JTAG Interface

Resistor values can vary between 1 kΩ to 10 kΩ. Perform signal integrity analysis to select the resistor value for your setup.

Intel recommends using the JTAG interface to prepare the Quad SPI flash device for later use in AS mode.
This configuration scheme includes the following steps:

1. In the Intel Quartus Prime Programmer, select the JTAG programming mode and initiate programming by clicking Start.
2. The Programmer drives .jic configuration data to the board using the JTAG header connection.
3. The programmer first configures the SDM with configuration firmware. Then, the SDM drives configuration data from the programmer to the AS x4 flash device using SDM_IOs.
4. To use the Intel Stratix 10 device in AS mode after successful programming of the flash device, set the MSEL pins to either AS fast or AS normal mode and power cycle the device.

The Intel Quartus Prime Programmer interfaces to the SDM device through JTAG interface and programs the serial flash device.

### 3.2.7. Serial Flash Memory Layout

Serial flash devices store the configuration data in sections.

The following diagram illustrates sections of a non-HPS Intel Stratix 10 configuration data mapping in a serial flash device. Refer to Intel Stratix 10 SoC FPGA Bitstream Sections of the HPS Technical Reference Manual for more information about flash memory layout for HPS devices.

**Figure 41. Serial Flash Memory Layout Diagram**

Start Address 32'd0

- 32'd256k
- 32'd512k
- 32'd768k
- 32'd1024k

End Address (Design dependent)

- Dynamic Section (I/O Configuration)
- Dynamic Section (FPGA Core Configuration)

Firmware section is static and Quartus Prime version dependent.

Firmware Section
If you use a third-party programmer to program an .rpd, ensure that the configuration data is stored starting from address 0 of the serial flash device. If you use .jic or .pof files, the Intel Stratix 10 Programmer automatically programs the configuration data starting from address 0 of the serial flash device.

Intel currently support the following listed Supported Flash Devices for Intel Stratix 10

**Related Information**
Intel Stratix 10 SoC FPGA Bitstream Sections

### 3.2.7.1. Understanding Quad SPI Flash Byte-Addressing

At power-on the SDM operates from boot ROM. The SDM loads configuration firmware from Quad SPI flash using 3-byte addressing. Once loaded, if the flash size is 256 Mb or larger, the SDM configures the Quad SPI flash to operate in 4-byte addressing mode and continues to load the rest of the bitstream until configuration completes.

Intel Stratix 10 devices support the following third-party flash devices operating at 1.8 V:
- Macronix MX66U 512 Mb, 1 and 2 gigabits (Gb)
- Macronix MX25U 128 Mb, 256 Mb, and 512 Mb
- Micron MT25QU 128 Mb, 256 Mb, 512 Mb, 1 Gb, and 2 Gb

Micron and Macronix both offer Quad SPI memories a density range of 128Mb—2Gb.

### 3.2.8. AS_CLK

The Intel Stratix 10 device drives AS_CLK to the serial flash device. An internal oscillator or the external clock that drives the OSC_CLK_1 pin generates AS_CLK. Using an external clock source allows the AS_CLK to run at a higher frequency. If you provide a 25 MHz, 100 MHz, or 125 MHz clock to the OSC_CLK_1 pin, the AS_CLK can run up to 133 MHz.

Set the maximum required frequency for the AS_CLK pin in the Intel Quartus Prime software as described in Active Serial Configuration Software Settings on page 100. The AS_CLK pin runs at or below your selected frequency.

<table>
<thead>
<tr>
<th>Configuration Clock Source</th>
<th>AS_CLK Frequency (MHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal oscillator</td>
<td>25</td>
</tr>
</tbody>
</table>

**Table 28.** Supported configuration clock source and AS_CLK Frequencies in Intel Stratix 10 Devices

---

---
3.2.9. Active Serial Configuration Software Settings

You must set the parameters in the Device and Pin Options of the Intel Quartus Prime software when using the AS configuration scheme.

To set the parameters for AS configuration scheme, complete the following steps:
1. On the Assignments menu, click Device.
2. In the Device and Pin Options select the Configuration category.
   a. Select Active Serial x4 from the Configuration scheme drop down menu.
3. Intel Stratix 10 Configuration Schemes

3.2.10. Intel Quartus Prime Programming Steps

3.2.10.1. Generating Programming Files using the Programming File Generator

By default, the Intel Quartus Prime Compiler's Assembler module generates the primary files required for device programming at the end of full compilation. Primary programming files include the .sof, .pof, and .rpd. You can use the Programming File Generator to generate programming files for alternative device programming methods, such as the .jic for flash programming, .zbf for partial reconfiguration, or .rpd for third-party programmer configuration. The Programming File Generator supports Intel Stratix 10 and later devices. The legacy Convert Programming Files dialog box does not support some advanced programming features for Intel Stratix 10 and later devices.

Note: If you are generating an .rpd for remote system update (RSU), you must follow the instructions in Generating an Application Image on page 167 in the Remote System Update chapter. This procedure generates flash programming files for Intel Stratix 10 devices.

b. Select Auto or 1.8 V in the Configuration device I/O voltage drop-down list.

c. Select the AS clock frequency from the Active serial clock source drop-down list.

3. Click OK to confirm and close the Device and Pin Options.

Related Information
Can I use 3rd party QSPI flash devices for Active Serial configuration of Intel Stratix 10 devices?
Complete the following steps to generate the programming file or files you require:

1. Click **File Programming File Generator**.
2. For **Device Family** select Intel Stratix 10.
3. In the **Configuration mode**, select **Active Serial x4**.
4. Specify the **Output directory** and **Name** for the file you generate.
5. Under **Output directory**, select the appropriate file type for your design. The AS scheme supports the **Programmer Object File (.pof)**, **JTAG Indirect Configuration File (.jic)**, and **Raw Programming Data File (.rpd)** file types.

![Programming File Generator Output Files](image)

Figure 42. Programming File Generator Output Files

6. For the **JTAG Indirect Configuration File (.jic)** and **Programmer Object File (.pof)** you can turn on the **Memory Map File (.map)**. This option describes flash memory address locations.

   The **Input Files** tab is now available.

7. On the **Input Files** tab, click **Add Bitstream** and browse to your configuration bitstream.
8. On the Configuration Device tab, click Add Device. You can select your flash device from the Configuration Device list, or define a custom device using the available menu options. For more information about defining a custom configuration device, refer to the Configuration Device Tab Settings (Programming File Generator) in the Intel Quartus Prime Pro Edition User Guide: Programmer.
### Programming File Generator Input Files

![Figure 44](image)

- **Configuration Device**
  - **Name filter:**
  - **Name**
    - 1: `<new device>`
    - 2: MT25QU01G
    - 3: EPCQL1024
    - 4: EPCQL256
    - 5: EPCQL512
    - 6: MT25QU01G
    - 7: MT25QU02G
    - 8: MT25QU128
    - 9: MT25QU256
    - 10: MT25QU512
    - 11: MX25U128
    - 12: MX25U256
    - 13: MX25U512
    - 14: MX66U1G
    - 15: MX66U2G
    - 16: MX66U512

- **Initialization**
  - **Device name:**
  - **Device ID:**
  - **Device I/O voltage:** 1.8V
  - **Device density:** 1Mb
  - **Total device die:**
  - **Single I/O mode dummy clock:**
  - **Quad I/O mode dummy clock:**

- **Program**
  - **Programming flow template:** Micron

- **Erase**

- **Verify/Blank-Check**
  - **Save as template**

---

Intel Stratix 10 Configuration User Guide

104
Note: You do not need to specify the flash device for .rpd files because the .rpd format is independent of the flash device. In contrast, the .pof and .jic files include both programming data and additional data specific to the configuration device. The Intel Quartus Prime Programmer uses this additional data to establish communication with the configuration device and then write the programming data.

9. Click Generate to generate the programming file or files.

Related Information
For comprehensive information about programming file generation and conversion.

3.2.10.2. Programming .pof files into Serial Flash Device
To program the .pof into the serial flash device through the AS header, perform the following steps:
1. In the Programmer window, click Hardware Setup and select the desired download cable.
2. In the Mode list, select Active Serial Programming.
3. Click Auto Detect button on the left pane.
4. Select the device to be programmed and click Add File.
5. Select the .pof to be programmed to the selected device.
6. Click Start to start programming.

3.2.10.3. Programming .jic files into Serial Flash Device
To program the .jic into the serial flash device through the JTAG interface, perform the following steps:
1. In the Programmer window, click Hardware Setup and select the desired download cable.
2. In the Mode list, select JTAG.
3. Select the device to be programmed and click Add File.
4. Select the .jic to be programmed to the selected device.
5. Click Start to start programming.
3.2.11. Debugging Guidelines for the AS Configuration Scheme

The AS configuration scheme operation is like earlier device families. However, there is one significant difference. Intel Stratix 10 devices using AS mode, try to load a firmware section from addresses 0, 256k, 512k and 768k in the serial flash device connected to the CS0 pin.

If the configuration bitstream does not include a valid image, the SDM asserts an error by driving \text{nSTATUS} low. You can recover from the error by reconfiguring the FPGA over JTAG, or by driving \text{nCONFIG} low.

SDM tristates AS pins, \text{AS_CLK, AS_DATA0-AS_DATA3, and AS_nCS0-AS_nCS3}, only when the device powers on if you set \text{MSEL} to JTAG. If \text{MSEL} is either AS fast or normal, the SDM drives the AS pins until you power cycle the Intel Stratix 10 device. Unlike earlier device families, the AS pins are not tristated when the device enters user mode.

The AS configuration scheme has power-on requirements. If you use AS Fast mode and are not concerned about 100 ms PCIe link training requirement, you must still ramp the \text{V_{CCIO_SDM}} supply within 18 ms. This ramp-up requirement ensures that the AS x4 device is within its operating voltage range when the Intel Stratix 10 device begins assessing the AS x4 device.

When using AS fast mode, all power supplies to the Intel Stratix 10 device must be fully ramped-up to the recommended operating conditions before the SDM releases from reset. To meet the PCIe 100 ms power-up-to-active time requirement for CvP, the \text{V_{CCIO_SDM}} power to the Intel Stratix 10 device must be at the recommended operating range within 10 ms.

**Debugging Suggestions**

Here are some debugging tips for the AS configuration scheme:

- Ensure that the boot address for your configuration image is correctly defined when generating the programming file for the flash. The boot address defaults to 0 for AS configuration.

- Ensure that the design meets the power-supply ramp requirements for fast AS mode. If using fast mode, \text{V_{CCIO_SDM}} must ramp up within 18 ms.

- Ensure that the flash is powered up and ready to be accessed when the Intel Stratix 10 device exits power-on reset.

- If you are using an external clock source for configuration, ensure the \text{OSC_CLK_1} pin is fed correctly, and the frequency matches the frequency you set for the \text{OSC_CLK_1} in your Intel Quartus Prime Pro Edition project.

- Ensure the \text{MSEL} pins reflect the correct AS configuration scheme.
• If the AS configuration is failing due to a corrupt image inside the serial flash device and reprogramming does not resolve the problem, you have two possible solutions depending on the components you are using for configuration:
  — If you are using a third-party programmer to configure the flash directly from an AS or JTAG header as shown in Figure 38 on page 95 change the MSEL setting to JTAG. Setting MSEL to JTAG prevents the corrupt image from loading automatically at power-on. Then, update the image in quad serial flash through the AS or JTAG header.
  — If you are programming the flash device using the JTAG header as shown in Figure 39 on page 96, force the nCONFIG signal to low. When nCONFIG is low, the image cannot load from the quad SPI flash device. Then, update the image in quad serial flash through the JTAG header.

• If you are using AS x4 flash memories, ensure that you use AS Fast mode, if you are not concerned about 100 ms PCIe link up, you must still ramp the VCCIO_SDM supply within 18 ms. This ramp-up requirement ensures that the AS x4 device is within its operating voltage range when the Intel Stratix 10 device begins to access it.

• Check endianness of the .rpd if using a third-party programmer to program Quad SPI device. You should generate the .rpd as big endian.

**Related Information**
Intel Stratix 10 Debugging Guide on page 191

### 3.2.12. QSF Assignments for AS

You can specify many Intel Quartus Prime project settings using Intel Quartus Prime Software GUI or by editing the Intel Quartus Prime Settings File (.qsf). The following assignments in the .qsf show typical settings for a Intel Stratix 10 device using AS configuration.

These settings are for a Intel Stratix 10 SmartVID device operating in PMBus slave mode which requires most of the SDM_IO pins. Refer to the Intel Stratix 10 Power Management User Guide for the PMBus constraints in master mode.

```plaintext
# Fitter Assignments
# ==================
set_global_assignment -name DEVICE 1SG280LU3F50E3VG
set_global_assignment -name CONFIGURATION_VCCIO_LEVEL 1.8V

# SDM IO Assignments
# ==================
set_global_assignment -name USE_PWRMGT_SCL SDM_IO14
set_global_assignment -name USE_PWRMGT_SDA SDM_IO11
set_global_assignment -name USE_PWRMGT_ALERT SDM_IO12
set_global_assignment -name USE_CONF_DONE SDM_IO16
```
You can also set the SDM_IO configuration pins using the Assignments ➤ Device ➤ Device and Pin Options ➤ Configuration ➤ Configuration Pin Options.
Figure 45. Set SDM_IO Configuration Pins Using the Intel Quartus Prime Software

Related Information

- PMBus Master Mode
  In the Power Management User Guide
3.3. SD/MMC Configuration

Note: Contact your Intel sales representative for information about SD/MMC support.

In the configuration scheme using SD memory cards or MMC, the memory cards store configuration data. The SDM uses the on-chip SD or MMC controller to interface to the memory cards. The SDM block reads the configuration data from the memory cards for the configuration process. The configuration from SD and MMC supports x4 SD memory cards and x8 MMC.

Table 29. Intel Stratix 10 Configuration Data Width, Clock Rates, and Data Rates

<table>
<thead>
<tr>
<th>Mode</th>
<th>Data Width (bits)</th>
<th>Max Clock Rate</th>
<th>Max Data Rate</th>
<th>MSEL[2:0]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active SD/MMC</td>
<td>4 or 8</td>
<td>50 MHz</td>
<td>400 Mb</td>
<td>3'b100</td>
</tr>
</tbody>
</table>

Table 30. Required Configuration Signals for the SD/MMC Configuration Scheme

You specify SDM I/O pin functions using the Device ➤ Configuration ➤ Device and Pin Options dialog box in the Intel Quartus Prime software.

<table>
<thead>
<tr>
<th>Configuration Function</th>
<th>Direction</th>
<th>Powered by</th>
</tr>
</thead>
<tbody>
<tr>
<td>nSTATUS</td>
<td>SDM I/O</td>
<td>Output</td>
</tr>
<tr>
<td>nCONFIG</td>
<td>SDM I/O</td>
<td>Input</td>
</tr>
<tr>
<td>MSEL[2:0]</td>
<td>SDM I/O, Dual-Purpose</td>
<td>Input</td>
</tr>
<tr>
<td>SDMMC_CFG_CMD</td>
<td>GPIO</td>
<td>Output</td>
</tr>
<tr>
<td>SDMMC_CFG_DATA[7:0]</td>
<td>GPIO</td>
<td>Bidirectional</td>
</tr>
<tr>
<td>SDMMC_CFG_CCLK</td>
<td>GPIO</td>
<td>Output</td>
</tr>
</tbody>
</table>

Note: Although the CONF_DONE and INIT_DONE configuration signals are not required, Intel recommends that you use these signals. The SDM drives the CONF_DONE signal high after successfully receiving full bitstream. The SDM drives the INIT_DONE signal high to indicate the device is fully in user mode. You can reassign the GPIO, dual-purpose configuration pins for other functions in user mode.

Related Information
- MSEL Settings on page 27
- Device Configuration Pins for Optional Configuration Signals on page 28
- SDM Pin Mapping on page 26
3. Intel Stratix 10 Configuration Schemes

3.3.1. SD/MMC Single-Device Configuration

Figure 46. Connections for SD/MMC Single-Device Configuration

Note: The External Level Shifter is not mandatory for embedded multimedia cards (eMMC).
3.4. JTAG Configuration

JTAG-chain device programming is ideal during development. JTAG-chain device configuration uses the JTAG pins to configure the Intel Stratix 10 FPGA directly with the .sof file. Configuration using the JTAG device chain allows faster development because it does not require you to program an external flash memory. You can also use JTAG to reprogram if the image stored in quad SPI memory. You can also use the JTAG configuration scheme to reprogram the quad SPI memory if the quad SPI content is corrupted or invalid.

The Intel Quartus Prime software generates a .sof containing the FPGA design information. You can use the .sof with a JTAG programmer to configure the Intel Stratix 10 device. The Intel FPGA Download Cable II and the Intel FPGA Ethernet Cable both can support the $V_{CCIO\_SDM}$ supply at 1.8 V. Alternatively, you can use the JamSTAPL Format File (.jam) or Jam Byte Code File (.jbc) for JTAG configuration.

Intel Stratix 10 devices automatically compress the configuration bitstream. You cannot disable compression in Intel Stratix 10 devices.

Table 31. Intel Stratix 10 Configuration Data Width, Clock Rates, and Data Rates

<table>
<thead>
<tr>
<th>Mode</th>
<th>Data Width (bits)</th>
<th>Max Clock Rate</th>
<th>Max Data Rate</th>
<th>MSEL[2:0]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passive</td>
<td>JTAG</td>
<td>1</td>
<td>30 MHz</td>
<td>3'b111</td>
</tr>
</tbody>
</table>

Note: The JTAG port has the highest priority and overrides the MSEL pin settings. Consequently, you can configure the Intel Stratix 10 device over JTAG even if the MSEL pin specify a different configuration scheme unless you disabled JTAG for security reasons.
### Table 32. Power Rails for the Intel Stratix 10 Device Configuration Pins

You can view the pin assignments for fixed pins in the Pin-Out File for your device. You specify SDM I/O pin functions using the Device ➤ Configuration ➤ Device and Pin Options dialog box in the Intel Quartus Prime software.

<table>
<thead>
<tr>
<th>Configuration Function</th>
<th>Pin Type</th>
<th>Direction</th>
<th>Powered by</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCK</td>
<td>Fixed</td>
<td>Input</td>
<td>( V_{CCIO_SDM} )</td>
</tr>
<tr>
<td>TDI(^{(7)})</td>
<td>Fixed</td>
<td>Input</td>
<td>( V_{CCIO_SDM} )</td>
</tr>
<tr>
<td>TMS(^{(7)})</td>
<td>Fixed</td>
<td>Input</td>
<td>( V_{CCIO_SDM} )</td>
</tr>
<tr>
<td>TDO(^{(7)})</td>
<td>Fixed</td>
<td>Output</td>
<td>( V_{CCIO_SDM} )</td>
</tr>
<tr>
<td>nSTATUS</td>
<td>SDM I/O</td>
<td>Output</td>
<td>( V_{CCIO_SDM} )</td>
</tr>
<tr>
<td>nCONFIG</td>
<td>SDM I/O</td>
<td>Input</td>
<td>( V_{CCIO_SDM} )</td>
</tr>
<tr>
<td>MSEL[2:0]</td>
<td>SDM I/O, Dual-Purpose</td>
<td>Input</td>
<td>( V_{CCIO_SDM} )</td>
</tr>
</tbody>
</table>

**Note:** Although the CONF_DONE and INIT_DONE configuration signals are not required, Intel recommends that you use these signals. The SDM drives the CONF_DONE signal high after successfully receiving full bitstream. The SDM drives the INIT_DONE signal high to indicate the device is fully in user mode.

**Note:** Pin-Out files are not yet available for Intel Agilex™ devices.

**Related Information**

- Programming Support for Jam STAPL Language
- Device Configuration Pins for Optional Configuration Signals on page 28
- SDM Pin Mapping on page 26
- JTAG Configuration Timing in Intel Stratix 10 Devices
- Documentation: Pin-Out Files for Intel FPGA Devices

\(^{(7)}\) The JTAG pins can access the HPS JTAG chain in Intel Stratix 10 SoC devices.
3.4.1. JTAG Configuration Scheme Hardware Components and File Types

The following figure illustrates JTAG programming. This is the simplest device configuration scheme. You do not have to use the **File ➤ Programming File Generator** to convert the `.sof` file to a `.pof`.

**Figure 47. JTAG Configuration Scheme**
3.4.2. JTAG Device Configuration

To configure a single device in a JTAG chain, the programming software sets the other devices to bypass mode. A device in bypass mode transfers the programming data from the TDI pin to the TDO pin through a single bypass register. The configuration data is available on the TDO pin one clock cycle later.

You can configure the Intel Stratix 10 device through JTAG using a download cable or a microprocessor.

3.4.2.1. JTAG Single-Device Configuration using Download Cable Connections

Refer to the Intel Stratix 10 Device Family Pin Connection Guidelines for additional information about individual pin usage and requirements.
Figure 49.  Connection Setup for JTAG Single-Device Configuration using Download Cable

Related Information
- Intel FPGA Download Cable II User Guide
- Intel Stratix 10 Device Family Pin Connection Guidelines
3.4.2.2. JTAG Single-Device Configuration using a Microprocessor

Refer to the *Intel Stratix 10 Device Family Pin Connection Guidelines* for additional information about individual pin usage and requirements.

**Figure 50.** Connection Setup for JTAG Single-Device Configuration using a Microprocessor
3.4.3. JTAG Multi-Device Configuration

You can configure multiple devices in a JTAG chain. Observe the following pin connections and guidelines for this configuration setup:

- One JTAG-compatible header connects to several devices in a JTAG chain. The drive capability of the download cable is the only limit on the number of devices in the JTAG chain.
- If you have four or more devices in a JTAG chain, buffer the TCK, TDI, and TMS pins with an on-board buffer. You can also connect other Intel FPGA devices with JTAG support to the chain.
3.4.3.1. JTAG Multi-Device Configuration using Download Cable

Figure 51. Connection Setup for JTAG Multi Device Configuration using Download Cable

Resistor values can vary between 1 kΩ to 10 kΩ. Perform signal integrity to select the resistor value for your setup.

For JTAG configuration only:
Connect MSEL [2:0] of Intel FPGA devices to VCCIO_SDM through 4.7 kΩ external pull-up resistor.

For JTAG in conjunction with another configuration scheme:
Connect MSEL [2:0] of Intel FPGA devices based on the non-JTAG configuration scheme.

3.4.4. Debugging Guidelines for the JTAG Configuration Scheme

The JTAG configuration scheme overrides all other configuration schemes. The SDM is always ready to accept configuration over JTAG unless a security feature disables the JTAG interface. JTAG is particularly useful in recovering a device that may be in an unrecoverable state reached when trying to configure using a corrupted image.
An nCONFIG falling edge terminates any JTAG access and the device reverts to the MSEL-specified boot source. nCONFIG must be stable during JTAG configuration. nSTATUS follows nCONFIG during JTAG configuration. Consequently, nCONFIG also must be stable.

Unlike other configuration schemes, nSTATUS does not assert if an error occurs during JTAG configuration. You must monitor the error messages that the Intel Quartus Prime Pro Edition Programmer generates for error reporting.

Note:
For Intel Stratix 10 SX devices when you choose to configure the FPGA fabric first, the JTAG chain has no mechanism to redeliver the HPS boot information following a cold reset. Consequently, you must reconfig the device with the .sof file or avoid cold resets to continue operation.

Debugging Suggestions
Here are some debugging tips for JTAG:

- Verify that the JTAG pin connections are correct.
- If JTAG configuration is failing, check that the FPGA has successfully powered up and exited POR. One strategy is to check the hand shaking behavior between nCONFIG and nSTATUS by driving nCONFIG low and ensuring that nSTATUS also goes low.
- Verify that the nCONFIG pin remains high during JTAG configuration.
- Another way to determine whether the device has exited the POR state is to use the Intel Quartus Prime Programmer to detect the device. If the programmer can detect the Intel Stratix 10 device, it has exited the POR state.
- If you are using an Intel FPGA Download Cable II, reduce the cable clock speed to 6 MHz.
- If you have multiple devices in the JTAG chain, try to disconnect other devices from the JTAG chain to isolate the Intel Stratix 10 device.
- If you specify the OSC_CLK_1 as the clock source for configuration, ensure that OSC_CLK_1 is running at the frequency you specify in the Intel Quartus Prime software.
- For designs including the High Bandwidth Memory (HBM2) IP or any IP using transceivers, you must provide a free running and stable reference clock to the device before device configuration begins. All transceiver power supplies must be at the required voltage before configuration begins.
- When the MSEL setting on the PCB is not JTAG, if you use the JTAG interface for reconfiguration after an initial reconfiguration using AS or the Avalon-ST interface, the .sof must be in the file format you specified in the Intel Quartus Prime project. For example, if you initially configure the MSEL pins for AS configuration and configure using the AS scheme, a subsequent JTAG reconfiguration using a .sof generated for Avalon-ST fails.
Related Information
Intel Stratix 10 Debugging Guide on page 191
4. Including the Reset Release Intel FPGA IP in Your Design

Intel requires that you either use the Reset Release Intel FPGA IP or the INIT_DONE signal routed back in through a pin to hold your design in reset until configuration is complete.

The Reset Release Intel FPGA IP is available in the Intel Quartus Prime Software. This IP consists of a single output signal, nINIT_DONE. The nINIT_DONE signal is the core version of the INIT_DONE pin and has the same function in both FPGA First and HPS First configuration modes. Intel recommends that you hold your design in reset while the nINIT_DONE signal is high or while the INIT_DONE pin is low. When you instantiate the Reset Release IP in your design, the SDM drives the nINIT_DONE signal. Consequently, the IP does not consume any FPGA fabric resources, but does require routing resources.

Figure 52. Reset Release Intel FPGA IP nINIT_DONE Internal Connection
If you do not include the Reset Release Intel FPGA IP in your design, you must feed the \texttt{INIT\_DONE} signal back into your design as an input to your reset logic as shown in this figure.

\begin{figure}
\centering
\includegraphics[width=0.5\textwidth]{figure}
\caption{Reset Release Intel FPGA IP INIT\_DONE External Connection}
\end{figure}

\textbf{Related Information}
\begin{itemize}
\item Should clocks and resets in user logic be gated until the configuration process is completed in Intel Stratix 10?
\item An 891: Using the Reset Release FPGA IP
\end{itemize}

\section{4.1. Understanding the Reset Release IP Requirement}

Intel Stratix 10 devices use a parallel, sector-based architecture that distributes the core fabric logic across multiple sectors. Device configuration proceeds in parallel with each Local Sector Manager (LSM) configuring its own sector. Consequently, FPGA registers and core logic do not exit reset at exactly the same time, as has always been the case in previous families.

The continual increases in clock frequency, device size, and design complexity now necessitate a reset strategy that considers the possible effects of slight differences in the release from reset. The Reset Release Intel FPGA IP holds a control circuit in reset until the device has fully entered user mode. The Reset Release FPGA IP generates an inverted version of the internal \texttt{INIT\_DONE} signal, \texttt{nINIT\_DONE} for use in your design.
After \texttt{nINIT\_DONE} asserts (low), all logic is in user mode and operates normally. You can use the \texttt{nINIT\_DONE} signal in one of the following ways:

- To gate an external or internal reset.
- To gate the reset input to the transceiver and I/O PLLs.
- To gate the write enable of design blocks such as embedded memory blocks, state machine, and shift registers.
- To synchronously drive register reset input ports in your design.

\textbf{Attention:} When you instantiate Reset Release Intel FPGA IP in your design, the Intel Quartus Prime Fitter selects one Local Sector Manager (LSM) to output the \texttt{nINIT\_DONE} signal. An Intel Quartus Prime Pro Edition legality check prevents you from instantiating more than one instance of the Reset Release Intel FPGA IP. Multiple instances results in some skew between the \texttt{nINIT\_DONE} signals.

### 4.2. Assigning \texttt{INIT\_DONE} To an SDM\_IO Pin

If you choose to route \texttt{INIT\_DONE} to an external pin, you must assign \texttt{INIT\_DONE} to an SDM\_IO pin.

Complete the following steps to make this assignment.

1. On the Intel Quartus Prime Assignments menu, select \textbf{Device ➤ Device and Pin Options ➤ Configuration Pin}, turn on the \textbf{Use INIT\_DONE} output.
2. In the drop-down list, select any SDM\_IO pin that is available.
Figure 54. Assigning INIT_DONE to SDM_IO Pin

Note: The Reset Release IP generates the \texttt{nINIT\_DONE} internal signal whether or not you choose to assign INIT\_DONE to an SDM\_IO pin.
4.3. Instantiating the Reset Release IP In Your Design

The Reset Release IP is available in the IP Catalog in the Basic Functions ➤ Configuration and Programming category. This IP has no parameters.

Complete the following steps to instantiate the Reset Release IP in your design.

1. In the IP Catalog, type `reset release` in the search window to find the Reset Release Intel FPGA IP.

2. Double click the **Reset Release Intel FPGA IP** to add the Reset Release IP to your design.

3. In the **New IP Variant** dialog box, browse to your IP directory and specify a file name for the Reset Release IP. Then click **Create**. The Reset Release IP is now included in your project.

4.4. Gating the PLL Reset Signal

In older FPGA device families, designs frequently used the PLL lock signal to hold the custom FPGA logic in reset until the PLL locked. In newer Intel device families the lock time of PLLs can be less than the initialization time. In some cases the PLL may lock before the device completes initialization. Consequently, if you use the locked output of the PLL to control resets in the Intel Stratix 10 device, you should gate the PLL reset input with `nINIT_DONE` as shown the figure.
Another alternative if you are using PLL_Lock in your reset sequence is to gate the PLL_Lock output with the nINIT_DONE signal, (PLL_Lock && !nINIT_DONE).

4.5. Guidance When Using Partial Reconfiguration (PR)

The PR Region Controller IP provides reset logic that ensures that the static region of the device and the PR personas do not interact during PR.

The Reset Release IP is only necessary to manage reset for full FPGA core configuration and subsequent full FPGA core configurations. The Reset Release IP is not necessary to prevent interaction between the static and PR personas during the PR process. For more information about PR refer to the Intel Quartus Prime Pro Edition User Guide: Partial Reconfiguration.

Related Information
Creating a Partial Reconfiguration Design

4.6. Detailed Description of Device Configuration

Each Local Sector Manager (LSM) configures its own sector. A sector comprises multiple logic array block (LAB) rows. A logical function can span multiple rows and multiple sectors.
During configuration global configuration control signals hold the core fabric in a frozen state to prevent electrical contention. The LSMs work in parallel to asynchronously unfreeze the sectors. Within a sector the LSM unfreezes LAB rows and registers in the LABs sequentially. The LSMs work to unfreeze the fabric in parallel across all sectors without synchronization. Consequently, logic in different sectors or in the same sector but in different rows could begin to operate while other logic is still frozen. The INIT_DONE signal asserts when all the LSMs have entered user mode.

**Figure 57.** Releasing LAB Rows and Registers in the LABs Sequentially and Asynchronously Across Sectors

The following topics provide more detail about device configuration and initialization, and possible consequences if you do not use the Reset Release IP to hold the Intel Stratix 10 device in reset until entire fabric enters user mode.
4.6.1. Device Initialization

The following steps summarize device initialization:

1. An external host drives a configuration request to the Secure Device Manager (SDM) by driving nCONFIG high. The SDM exits the IDLE state and signals the beginning of configuration by driving nSTATUS high and driving configuration data.

2. The SDM asserts CONF_DONE indicating that the Intel FPGA has successfully received all the configuration data.

3. The SDM uses the configuration logic to start non-gated clocks in the fabric. Intel Hyperflex™ registers begin shifting data. Consequently, the initial conditions of Intel Hyperflex registers can be random. Use the Disable Register Power-up Initialization setting in the Intel Quartus Prime Configuration dialog box to disable Intel Hyperflex register initialization during power-on as explained below.

4. The SDM uses the configuration logic to enable and initialize user registers in the LABs, DSP, and embedded memory blocks.

5. The SDM drives INIT_DONE to indicate that the device has fully entered user mode. The Reset Release IP asserts nINIT_DONE. Intel recommends that you use nINIT_DONE to gate your reset logic.

6. The FPGA is now in user mode and ready for operation.

4.6.2. Preventing Register Initialization During Power-On

If not held in reset, both ALM and Intel Hyperflex registers may lose their initial state if they initialize before their respective source.

You can prevent registers from initializing during power-on by enabling an option in the Intel Quartus Prime software. Complete the following steps to turn on this option:

1. On the Assignments menu select Device ➤ Device and Pin Options ➤ Configuration.

2. In the Configuration dialog box, turn on Disable Register Power-up Initialization.
Figure 58. Disabling Register Initialization During Power-On

![Configuration settings for disabling register initialization during power-on.]

- **Configuration scheme**: AVST x8
- **Configuration device**: (dropdown)
- **Configuration device I/O voltage**: Auto
- **Force VCCIO to be compatible with configuration I/O voltage**: (checkbox)
- **VID Operation mode**: (dropdown)
- **Configuration pin**: (dropdown)
- **Generate compressed bitstreams**: (checkbox)
- **Active serial clock source**: (dropdown)
- **Enable input tri-state on active configuration pins in user mode**: (checkbox)
- **HPS/FPGA configuration order**: After INIT_DONE
- **HPS debug access port (DAP)**: Disabled
- **Disable Register Power-up Initialization**: (checkbox)
Note: Coming out of reset, you cannot rely on the value of registers with initial conditions unless you gate your system reset using one of the following options:

- Designs that include the Reset Release IP must route nINIT_DONE to the system reset.
- Designs that do not include the Reset Release IP must route INIT_DONE to an external pin and feed INITDONE back into the FPGA as an input to system reset.

4.6.3. Embedded Memory Block Initial Conditions

Initialized content of embedded memory blocks is stable during configuration. However, designs that contain logic to modify embedded memory can result in spurious writes. Spurious writes can occur if you fail to gate the write enable with an appropriate reset.

4.6.4. Protecting State Machine Logic

To guarantee correct operation of state machines, your reset logic must hold the FPGA fabric in reset until the entire fabric enters user mode.

The following example shows how an inadequate reset strategy might result in an illegal state in a one-hot state machine. In this example, the design does not reset any of the state machine registers. The state machine design depends on registers entering an initial state. Without an adequate reset, this state machine begins operating when part of the device is active. Nearby logic included in the state machine remains frozen, before INIT_DONE asserts.

Figure 59. Partially Initialized Design - INIT_DONE = 0
Register B in the active section is operational and takes on the value of Register A in the next clock cycle. Register A is still in the freeze register state and does not respond to the clock edge. Register A remains in the current state.

**Figure 60.  Advance One Clock Cycle, Device Completely In User Mode - INIT_DONE = 1**

The entire fabric is now in user mode. The state machine enters an illegal or unknown state with two ones in a one-hot state machine. To prevent this illegal state, use the Reset Release IP to hold the circuit in reset until INIT_DONE asserts indicating that the entire fabric has entered user mode.
5. Remote System Update (RSU)

RSU implements device reconfiguration using dedicated RSU circuitry available in all Intel Stratix 10 devices. RSU has the following advantages:

- Provides a mechanism to deliver feature enhancements and bug fixes without recalling your products
- Reduces time-to-market
- Extends product life

Using RSU and the Mailbox Client Intel FPGA IP you can write configuration bitstreams to the AS x4 flash device. Then you can use the Mailbox Client Intel FPGA IP to instruct the SDM to restart from the updated image. You can store multiple application images and a single factory image in the configuration device. Your design manages remote updates of the application images in the configuration device.

A command to the Mailbox Client Intel FPGA IP initiates reconfiguration. The RSU performs configuration error detection during and after the reconfiguration process. If errors in the application image or images prevent reconfiguration, the configuration circuitry reverts to the factory image and provides error status information.

This chapter explains the remote system update implementation for active configuration schemes. The FPGA drives the RSU. For the Intel Stratix 10 SoC devices, HPS can drive the RSU process. For more information about using the HPS to drive RSU, refer to Intel Stratix 10 SoC Remote System Update (RSU) User Guide.

For passive configuration schemes, an external host implements remote system update rather than the Intel Stratix 10 device. To learn more about remote system update for passive configuration schemes, refer to Remote Update Intel FPGA IP User Guide for remote system update implementations in earlier device families.

The following figure shows functional diagrams for typical remote system update processes.
**Figure 61. Typical Remote System Update Process**

**Related Information**
- Remote Update Intel FPGA IP User Guide
- Serial Flash Mailbox Client Intel FPGA IP User Guide
- Mailbox Client Intel FPGA IP User Guide
- Intel Stratix 10 SoC Remote System Update (RSU) User Guide
# 5.1. Remote System Update Functional Description

## 5.1.1. RSU Glossary

### Table 33. RSU Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware</td>
<td>Firmware that runs on SDM. Implements many functions including the functions listed here:   • FPGA configuration  • Voltage regulator configuration  • Temperature measurement  • HPS software load  • HPS Reset  • RSU  • Read, erase, and program flash memory  • Device security, including authentication and encryption</td>
</tr>
<tr>
<td>Decision firmware data</td>
<td>Decision firmware data structure containing the following information:   • The Direct to Factory Image pin assignment.  • PLL settings for the external clock source. This optional clock source drives OSC_CLK_1. For more information, refer to OSC_CLK_1 Clock Input.  • Quad SPI pins.</td>
</tr>
<tr>
<td>Configuration pointer block (CPB)</td>
<td>A list of application image addresses in order of priority. When you add an image, that image becomes the highest priority.</td>
</tr>
<tr>
<td>Sub-partition table (SPT)</td>
<td>Data structure to facilitate the management of the flash storage.</td>
</tr>
<tr>
<td>Application image</td>
<td>Configuration bitstream that implements your design. This image includes the SDM firmware.</td>
</tr>
<tr>
<td>Factory image</td>
<td>The fallback configuration bitstream that the RSU loads when all attempts to load an application image fail.</td>
</tr>
<tr>
<td>Initial RSU flash image</td>
<td>Contains the factory image, the application images, the decision firmware, and the associated RSU data structures.</td>
</tr>
<tr>
<td>Factory update image</td>
<td>An image that updates the following RSU-related items in flash:   • The factory image  • The decision firmware  • The decision firmware data</td>
</tr>
</tbody>
</table>
5.1.2. Remote System Update Using AS Configuration

Remote system update using AS configuration includes the following components:

- Your remote system update host design. The host can be custom logic, the HPS, or a Nios® II processor in the FPGA.
- One factory image.
- Flash memory for image storage.
- At least one application image.
- Designs that do not use the HPS as the remote system update host require an Mailbox Client Intel FPGA IP as shown in the figure below. The Mailbox Client sends and receives remote system update operation commands and responses, such as QSPI_READ and QSPI_WRITE. Optionally, you may use Serial Flash Mailbox Client Intel FPGA IP to perform flash transactions, such as rewriting the application image to the serial flash.

Figure 62. Intel Stratix 10 Remote System Update Components
Attention: Starting in version 19.2 of the Intel Quartus Prime software, a restriction applies to the following mailbox client IPs that access the SDM mailbox over an Avalon Memory-Mapped (Avalon-MM) interface:

- Temperature Sensor
- Voltage Sensor
- Chip ID
- Serial Flash Mailbox Client
- Mailbox Client IP
- Advanced SEU Detection IP
- Partial Reconfiguration IP

You cannot use a .sof created in version 19.2 of the Intel Quartus Prime or later that includes any of the listed SDM mailbox client IP for bitstream generation or for JTAG configuration in Intel Quartus Prime software version 19.1 or earlier. However, you can use a .sof including the listed SDM mailbox client IPs that you created in version 19.1 of the Intel Quartus Prime or earlier, in later versions of the Intel Quartus Prime software, including Intel Quartus Prime version 19.2.

Related Information
Mailbox Client Intel FPGA IP User Guide

5.1.3. Remote System Update Configuration Images

Intel Stratix 10 devices using remote system update require the following configuration images:

- A Factory image—This image includes logic to implement the following functions:
  - Your design-specific logic to obtain new application images
  - Your design-specific logic to request reconfiguration using a specific application image
  - Image storage in flash memory
- Application image—contains logic to implement the custom application. The application image must also contain logic to obtain new application images and store the images in the flash memory.

Depending on the storage space of your flash memory, Intel Stratix 10 remote system update supports one factory image and up to 507 application images. The Quartus Programming File Generator only supports up to seven remote system update images. However, you can add more images using the Mailbox Client IP or Serial Flash Mailbox Client IP with the device in user mode.
5.1.4. Remote System Update Configuration Sequence

Figure 63. Remote System Update Configuration Sequence

In the following figure the blue text are states shown in the Configuration Flow Diagram on page 22.

Exit Power-On
SDM Startup
Boot ROM Code

1. Boot ROM Loads
   Firmware Sections

nCONFIG Asserted
SDM is in
Idle Mode

2. nCONFIG High
   Idle Mode: Direct
to Factory Image Pin is
   asserted?

   Yes
   Configuration:
   Load Factory Image

   Enter User Mode
with Factory Image

   Remote Update
to Application Image

   Remote Update
to Factory Image

   Error Loading All
   Subsequent Application Images

   Configuration:
   Load Application Image

   Enter User Mode
with Application Image

   Remote Update
to other Application Image

   Remote Update
to other Application Image

3. Remote System Update
   Flash Layout

   Decision Firmware
   Decision Firmware
   Decision Firmware
   Decision Firmware
   Reserved
   Factory Image
   Sub-Partition Table
   Sub-Partition Table
   (Back-up copy)
   Configuration Pointer Block
   Configuration Pointer Block
   (Back-up copy)
   Application Image
   Application Image
   Prioritized List of Application Images

4. Configuration:
   Load Application Image

5. Application Image
Reconfiguration includes the following steps:

1. After the device exits power-on-reset (POR), the boot ROM loads flash memory from the first valid decision firmware from one of the copies at addresses 0, 256 K, 512 K, or 768 K to initialize the SDM. The same configuration firmware is present in each of these locations. This firmware is part of the initial RSU flash image. (Refer to Step 2 of Guidelines for Performing Remote System Update Functions for Non-HPS on page 143 for step-by-step details for programming the initial RSU flash image into the flash.)

2. The optional Direct to Factory pin controls whether the SDM firmware loads the factory or application image. You can assign the Direct to Factory input to any unused SDM pin. The SDM loads the application image if you do not assign this pin.

3. The configuration pointer block in the flash device maintains a list of pointers to the application images.

4. When loading an application image, the SDM traverses the pointer block in reverse order. The SDM loads the highest priority image. When image loading completes, the device enters user mode.

5. If loading the newest (highest priority) image is unsuccessful, the SDM tries the next application image from the list. If none of the application loads successfully, the SDM loads the factory image.

6. If loading the factory image fails, you can recover by reprogramming the quad SPI flash with the initial RSU flash image using the JTAG interface.

5.1.5. RSU Recovery from Corrupted Images

When an RSU fails, the Mailbox Client Intel FPGA IP RSU_STATUS command provides information about the current configuration status, including the currently running image and most recent failing image. The rsu1.tcl script implements the RSU_STATUS commands. You can download the rsu1.tcl script from the following web page. Under Device Configuration Support Center, click Advanced Configuration Features, click the triangle next to Remote System Upgrade to expand this section, then click Example of Tcl Script.
The following example illustrates recovery from a corrupted image:

**Multiple Corrupted Images**

If the flash memory includes multiple corrupted images, the RSU_STATUS only reports status for the highest priority failing image. The following example illustrates this procedure.

- The flash memory includes the following four images, in order of priority:
  1. Application Image3 (highest priority)
  2. Application Image2
  3. Application image1
  4. Application image0 (lowest priority)

- Application Image3, Application Image2, and Application Image1 are corrupted.
- RSU_STATUS includes the following information:
  - Current_Image: Application Image0
  - Highest priority failing image, State, Version, Error location, Error details: records information for Application Image3 which is the highest priority failing image.
Figure 64. Multiple Corrupt Images

- **Factory Image**
  - Address Offset 1MB + 64 KB

- **Current Image**
  - Application Image0
    - Address Offset \(<N>\) * 64 KB

- **Last Failing Image**
  - Application Image1 - Corrupt
    - Address Offset \(<M>\) * 64 KB

- **Highest Priority Failing Image**
  - Application Image2 - Corrupt
    - Address Offset \(<O>\) * 64 KB

- **Application Image3 - Corrupt**
  - Address Offset \(<P>\) * 64 KB

**Related Information**
- [Operation Commands](#) on page 146
- [Supported Flash Devices for Intel Stratix 10 Devices](#)
5.1.6. Updates with the Factory Update Image

In rare instances you may need to update flash memory with a new factory image and the associated decision firmware and decision firmware data.

An update may be required for the following reasons:

- If there are vulnerabilities in the firmware
- If there are errors in the firmware or in the factory image

Intel provides a safe solution for you to update the factory image and the associated decision firmware and decision firmware data remotely. The update process stores multiple copies of critical data so that if power is lost or the update is disrupted, the device is still able to restart and continue the update. The update continues automatically when power is restored. Here are the steps to perform the update:

1. Generate the factory update image using the Programming File Generator. The image contains the new factory Image, decision firmware, and decision firmware data.

2. Program the factory update image, (*.rpd) to an empty partition slot starting from a new sector boundary in the flash device.

3. Trigger reconfiguration to load the update image from the starting address specified in step 2.

4. The updated image performs the following operations:
   a. Erases and replaces the previous decision firmware and decision firmware data in the flash device.
   b. Reprograms the new factory image in the flash device.
   c. After the update completes, the updated image removes itself from the CPB and loads the application image or the factory image if an application image is not available.

5. If the update process used an application slot, you must restore the application image by writing the application image .rpd to the application slot and the CPB.
Here are guidelines to follow when implementing remote system update:

1. The factory or application image must at least contain a remote system update host controller and the Mailbox Client Intel FPGA IP.
   - You can use either custom logic, the Nios II processor, or the JTAG to Avalon Master Bridge IP as a remote system update host controller.
   - The remote system update host controller controls the remote system update function by sending commands to and receiving responses from the SDM via Mailbox Client Intel FPGA IP. The Mailbox Client functions as the messenger between the remote system update host and SDM. It passes the commands to and responses from the SDM.

2. The pre-generated standard remote system update image file should include a factory image and at least one application image. The remote system update image must be programmed into the flash memory. You can use a dummy image to begin developing RSU functionality before the actual application image is complete. In user mode you can program additional application images.
• Refer to *Generating Remote System Update Image Files Using the Programming File Generator* on page 164 for the step by step process to generate the standard and single remote system update image files using the programming file generator.

3. The remote system update requires you to use the AS x4 configuration scheme to configure the FPGA with the pre-generated remote system update image.

4. Once the device enters user mode with either the factory image or an application image, the remote system update host can perform the following remote system update operations:
   a. Reconfiguring the device with an application or factory image:
      i. From factory image to an application image or vice versa
      ii. From an application image to another application image
   b. Erasing the application image
   c. Adding an application image
   d. Updating an application or factory image

**Related Information**

- [Intel Stratix 10 SoC Development Kit User Guide](#)
- [Mailbox Client Intel FPGA IP User Guide](#)

### 5.3. Commands and Responses

The remote system update host communicates with the SDM using command and response packets via the Mailbox Client Intel FPGA IP.

**Block Diagram**

Intel FPGA IP The following figure illustrates the role of the Mailbox Client Intel FPGA IP in an Intel Stratix 10 design. The Mailbox Client IP enables communication with the SDM to access quad SPI flash memory and system status.
Mailbox Client Role

Figure 66. Command and Response Header Format

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>RESERVED</td>
</tr>
<tr>
<td>30</td>
<td>ID</td>
</tr>
<tr>
<td>29</td>
<td>0</td>
</tr>
<tr>
<td>28</td>
<td>LENGTH</td>
</tr>
<tr>
<td>27</td>
<td>0</td>
</tr>
<tr>
<td>26</td>
<td>COMMAND / ERROR CODE</td>
</tr>
</tbody>
</table>

**Note:** The LENGTH field in the command header must match the command length of corresponding command. The following table describes the fields of the header command. Your client must read all the response words, even if your client does not interpret all the response words.

Table 34. Mailbox Client Intel FPGA IP Command and Response Header Description

<table>
<thead>
<tr>
<th>Header</th>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>[27:24]</td>
<td>The command ID. The response header returns the ID specified in the command header. Set different IDs in each command to match responses with commands.</td>
</tr>
</tbody>
</table>

continued...
### 5. Remote System Update (RSU)

**Table 35. Command List and Description**

<table>
<thead>
<tr>
<th>Command</th>
<th>Code (Hex)</th>
<th>Command Length (B)</th>
<th>Response Length (B)</th>
<th>Description</th>
</tr>
</thead>
</table>
| RSU_IMAGE_UPDATE | 5C         | 2                  | 0                  | Triggers reconfiguration from the data source which can be either the factory or an application image. This command takes an optional 64-bit argument that specifies the reconfiguration data address in the flash. If you do not provide this argument its value is assumed to be 0.  
- Bit [63:32]: Reserved (write as 0).  
- Bit [31:0]: The start address of an application image.  
Returns a non-zero response if the device is already processing a configuration command. |
| RSU_GET_SPT      | 5A         | 0                  | 4                  | RSU_GET_SPT retrieves the quad SPI flash location for the two sub-partition tables that the RSU uses: SPT0 and SPT1.  
The 4-word response contains the following information:  
<table>
<thead>
<tr>
<th>Offset</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>SPT0[63:32]</td>
<td>SPT0 address in quad SPI flash.</td>
</tr>
<tr>
<td>1</td>
<td>SPT0[31:0]</td>
<td>SPT0 address in quad SPI flash.</td>
</tr>
<tr>
<td>2</td>
<td>SPT1[63:32]</td>
<td>SPT1 address in quad SPI flash.</td>
</tr>
<tr>
<td>3</td>
<td>SPT1[31:0]</td>
<td>SPT1 address in quad SPI flash.</td>
</tr>
</tbody>
</table>

---

(8) This number does not include the command and response header.
5. Remote System Update (RSU)

<table>
<thead>
<tr>
<th>Command</th>
<th>Code (Hex)</th>
<th>Command Length (8)</th>
<th>Response Length (8)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONFIG_STATUS</td>
<td>4</td>
<td>0</td>
<td>6</td>
<td>Reports the status of the last reconfiguration. You can use this command to check the configuration status during and after configuration. The response contains the following information:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>State</td>
<td>Describes the most recent configuration related error. Returns 0 when there are no configuration errors. The error field nCONFIG_STATUSas 2 fields: • Upper 16 bits: Major error code. • Lower 16 bits: Minor error code. Refer to the Table 36 on page 152 and Table 37 on page 153 for more information.</td>
</tr>
<tr>
<td>1</td>
<td>Version</td>
<td>The version of the RSU data structure.</td>
</tr>
<tr>
<td>2</td>
<td>Pin status</td>
<td>• Bit [31]: Current nSTATUS output value (active low) • Bit [30]: Detected nCONFIG input value (active low) • Bit [29:3]: Reserved • Bit [2:0]: The MSEL value at power up</td>
</tr>
<tr>
<td>3</td>
<td>Soft function status</td>
<td>Contains the value of each of the soft functions, even if you have not assigned the function to an SDM pin. • Bit [31:6]: Reserved • Bit [5]: HPS_WARMRESET • Bit [4]: HPS_COLDRESET • Bit [3]: SEU_ERROR • Bit [2]: CVP_DONE • Bit [1]: INIT_DONE • Bit [0]: CONF_DONE</td>
</tr>
<tr>
<td>4</td>
<td>Error location</td>
<td>Contains the error location. Returns 0 if there are no errors.</td>
</tr>
<tr>
<td>5</td>
<td>Error details</td>
<td>Contains the error details. Returns 0 if there are no errors.</td>
</tr>
</tbody>
</table>

(8) This number does not include the command and response header.
### 5. Remote System Update (RSU)

<table>
<thead>
<tr>
<th>Command</th>
<th>Code (Hex)</th>
<th>Command Length (8)</th>
<th>Response Length (8)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSU_STATUS</td>
<td>5B</td>
<td>0</td>
<td>9</td>
<td>Reports the current remote system upgrade status. You can use this command to check the configuration status during configuration and after it has completed. This command returns the following responses:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-1</td>
<td>Current image</td>
<td>Flash offset of the currently running application image.</td>
</tr>
<tr>
<td>2-3</td>
<td>Failing image</td>
<td>Flash offset of the highest priority failing application image. If multiple images are available in flash memory, stores the value of the first image that failed. A value of all 0s indicates no failing images. If there are no failing images, the remainder of the remaining words of the status information do not store valid information. <strong>Note</strong>: A rising edge on nCONFIG to reconfigure from ASx4, does not clear this field. Information about failing image only updates when the Mailbox Client receives a new RSU_IMAGE_UPDATE command and successfully configures from the update image.</td>
</tr>
</tbody>
</table>
| 4    | State      | Failure code of the failing image. The error field has two parts: 
• Upper 16 bits: Major error code. 
• Lower 16 bits: Minor error code. 
Returns 0 for no failures. Refer to the Table 36 on page 152 and Table 37 on page 153 for more information. |
| 5    | Error Reporting and Version | Starting with version 19.4 of the Intel Quartus Prime Pro Edition software, contains the following fields: |

(8) This number does not include the command and response header.
<table>
<thead>
<tr>
<th>Command</th>
<th>Code (Hex)</th>
<th>Command Length (8)</th>
<th>Response Length (8)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Bits[31:28]: Specifies the currently used decision firmware index.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Bits[27:16]: Source of the error. Available in version 19.3 of the Intel Quartus Prime Pro Edition software or later. The following encodings are valid:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0000: No error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0ACF: Application firmware reported an error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0DCF: Decision firmware reported an error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Bits[15:8]: Application firmware RSU interface version. RSU interface version. The following encodings are valid:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0000: Pre 19.3 release</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0001: 19.3 release</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Bits[7:0]: Decision firmware RSU interface version. The following encodings are valid:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0000: Pre 19.3 release</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0001: 19.3 release</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>— 0x0002: 19.4 release</td>
</tr>
<tr>
<td>6</td>
<td>Error location</td>
<td></td>
<td></td>
<td>Stores the error location of the failing image. Returns 0 for no errors.</td>
</tr>
<tr>
<td>7</td>
<td>Error details</td>
<td></td>
<td></td>
<td>Stores the error details for the failing image. Returns 0 if there are no errors.</td>
</tr>
<tr>
<td>8</td>
<td>Current image retry counter</td>
<td></td>
<td></td>
<td>Count of the number of retries that have been attempted for the current image. The counter is 0 initially. The counter is set to 1 after the first retry, then 2 after a second retry. Specify the maximum number of retries in your Intel Quartus Prime Settings File (.qsf). The command is: set_global_assignment -name RSU_MAX_RETRY_COUNT 3. Valid values for the MAX_RETRY counter are 1-3. The actual number of available retries is MAX_RETRY - 1. This field was added in version 19.3 of the Intel Quartus Prime Pro Edition Software.</td>
</tr>
</tbody>
</table>

(8) This number does not include the command and response header.
### QSPI_OPEN

**Command**: QSPI_OPEN  
**Code (Hex)**: 32  
**Command Length (8)**: 0  
**Response Length (8)**: 1  

Requests exclusive access to the quad SPI. The SDM accepts the request if the quad SPI is not in use and the SDM is not configuring the device. Returns OK if the SDM grants access. Returns the ALT SDM_MBOX_RESP_DEVICE_BUSY when the quad SPI flash is busy.

**Note**: The SDM grants exclusive access to the client using this mailbox. Other clients cannot access the quad SPI until the active client relinquishes access using the QSPI_CLOSE command.

### QSPI_CLOSE

**Command**: QSPI_CLOSE  
**Code (Hex)**: 33  
**Command Length (8)**: 0  
**Response Length (8)**: 1  

Closes the exclusive access to the quad SPI interface.

### QSPI_SET_CS

**Command**: QSPI_SET_CS  
**Code (Hex)**: 34  
**Command Length (8)**: 1  
**Response Length (8)**: 1  

Specifies one of the attached quad SPI devices via the chip select lines. Takes a one-word argument as described below:

- **Bits[31:28]**: Flash device to select. The value 4'b0000 selects the flash that corresponds to nCSO[0]. nCSO[0] is the only signal that the FPGA can use to access the quad SPI flash device. The HPS can use nCSO[3:1] to access HPS data.
- **Bits[27:0]**: Reserved (write as 0). The HPS can use nCSO[3:1] to access 3 additional quad SPI devices.

This command is optional for the AS x4 configuration scheme. Is required for all other configuration schemes.

Access to the QSPI flash memory devices using SDM IO pins is only available for the AS x4 configuration scheme, JTAG configuration, and a design compiled for ASx4 configuration. For the Avalon ST configuration scheme, you must connect QSPI flash memories to GPIO pins.

### QSPI_READ

**Command**: QSPI_READ  
**Code (Hex)**: 3A  
**Command Length (8)**: 2  
**Response Length (8)**: N  

Reads the attached quad SPI device. The maximum read size is 4 kilobytes (KB). Takes two arguments:

- The quad SPI flash address (one word). The address must be word aligned. The device returns the 0x1 error code for non-aligned addresses.
- Number of words to read (one word).

When successful returns OK followed by the read data from the quad SPI device. A failure response returns an error code.

For a partially successful read, QSPI_READ may erroneously return the OK status.

**Note**: You cannot run the QSPI_READ command while device configuration is in progress.

### QSPI_WRITE

**Command**: QSPI_WRITE  
**Code (Hex)**: 39  
**Command Length (8)**: 2+N  
**Response Length (8)**: 0  

Writes data to the quad SPI device. Takes three arguments:

- The flash address offset (one word). The write address must be word aligned. The device returns error code 0x3FF for non-aligned addresses.
- The number of words to write (one word).
- The data to be written (one or more words).

A successful write returns the OK response code.

---

(8) This number does not include the command and response header.
<table>
<thead>
<tr>
<th>Command</th>
<th>Code (Hex)</th>
<th>Command Length (B)</th>
<th>Response Length (B)</th>
<th>Description</th>
</tr>
</thead>
</table>
| QSPI_ERASE          | 38         | 2                  | 0                  | Erases a sector of the quad SPI device. Takes two arguments:  
                                                                                                                                      The flash address offset to start the erase (one word). The address must be the start address  
                                                                                                                                      of a sector within the flash memory; consequently, the address must be 64 KB aligned.  
                                                                                                                                      Returns an error for non-64 KB aligned addresses.  
                                                                                                                                      The number of words to erase specified in multiples of 0x4000 words.  
                                                                                                                                      A successful erase returns the OK response code. |
| QSPI_READ_DEVICE_REG| 35         | 2                  | N                  | Reads registers from the quad SPI device. The maximum read is 8 bytes. Takes two arguments.  
                                                                                                                                      The opcode for the read command.  
                                                                                                                                      The number of bytes to read.  
                                                                                                                                      A successful read returns the OK response code followed by the data read from the device. Pads  
                                                                                                                                      data that is not a multiple of 4 bytes to the next word boundary. |

(8) This number does not include the command and response header.
Command | Code (Hex) | Command Length (8) | Response Length (8) | Description
--- | --- | --- | --- | ---
QSPI_WRITE_DEVICE_REG | 36 | 2+N | 0 | Writes to registers of the quad SPI. The maximum write is 8 bytes. Takes three arguments:
- The opcode for the write command.
- The number of bytes to write.
- The data to write.
To perform a sector erase or sub-sector erase, you must specify the serial flash address in most significant byte (MSB) to least significant byte (LSB) order as the following example illustrates.
To erase a sector of a Micron 2 gigabit (Gb) flash at address 0x04FF0000 using the QSPI_WRITE_DEVICE_REG command, write the flash address in MSB to LSB order as shown here:
Header: 0x00003036
Opcode: 0x000000DC
Number of bytes to write: 0x00000004
Flash address: 0x0000FF04
A successful write returns the OK response code. This command pads data that is not a multiple of 4 bytes to the next word boundary.

QSPI_SEND_DEVICE_OP | 37 | 1 | 0 | Sends a command opcode to the quad SPI. Takes one argument:
- The opcode to send the quad SPI device.
A successful command returns the OK response code.

RSU_NOTIFY | 5D | 1 | 0 | Clears all error information in the RSU_STATUS response and resets the retry counter. The one-word argument has the following fields:
- 0x00050000: Clear current reset retry counter. Resetting the current retry counter sets the counter back to zero, as if the current image was successfully loaded for the first time.
- 0x00060000: Clear error status information.
- All other values are reserved.
This command is not available before version 19.3 of the Intel Quartus Prime Pro Edition Software.

Table 36. CONFIG_STATUS and RSU_STATUS Major Error Code Descriptions

<table>
<thead>
<tr>
<th>Major Error Code</th>
<th>Error Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xF001</td>
<td>BITSTREAM_ERROR</td>
<td>Potential unsigned bitstream used. Ensure the bitstream is signed with the correct key.</td>
</tr>
<tr>
<td>0xF002</td>
<td>HARDWARE_ACCESS_FAILURE</td>
<td>Failure to communicate to PMBus-compliant voltage regulator. Check your power management and smart voltage identification (SmartVID) parameter settings and PMBus interface connections.</td>
</tr>
</tbody>
</table>

(8) This number does not include the command and response header.
## 5. Remote System Update (RSU)

### Major Error Code

<table>
<thead>
<tr>
<th>Major Error Code</th>
<th>Error Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xF003</td>
<td>BITSTREAM_CORRUPTION</td>
<td>Bitstream is corrupt. Ensure the bit stream in configuration device or flash is not corrupt.</td>
</tr>
<tr>
<td>0xF004</td>
<td>INTERNAL_ERROR</td>
<td>This major code may indicate the following error events:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An error in the SDM Crypto IP task.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An RSU operation error. Refer to Table 37 on page 153 for more information.</td>
</tr>
<tr>
<td>0xF005</td>
<td>DEVICE_ERROR</td>
<td>Indicates an SDM internal device error. The following errors are possible:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A device cleaning failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An HPS configuration failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact your local Field Applications Engineer (FAE). Alternatively, submit a Service Request on the My Intel support page to get the support on capturing the error log for further debug.</td>
</tr>
<tr>
<td>0xF006</td>
<td>HPS_WATCHDOG_TIMEOUT</td>
<td>HPS watchdog timeout failure. Ensure that your design resets the watchdog timer correctly.</td>
</tr>
<tr>
<td>0xF007</td>
<td>INTERNAL_UNKNOWN_ERROR</td>
<td>Indicates an internal device error due to an unknown task.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can contact your local Field Applications Engineer (FAE). Alternatively, submit a Service Request on the My Intel support page to get the support on capturing the error log for further debug.</td>
</tr>
</tbody>
</table>

### Table 37. CONFIG_STATUS and RSU_STATUS Minor Error Code Descriptions

<table>
<thead>
<tr>
<th>Minor Error Code</th>
<th>Error Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xD001</td>
<td>RSU_CMF_AUTH_ERR</td>
<td>Authentication failure for the firmware.</td>
</tr>
<tr>
<td>0xD002</td>
<td>RSU_USER_AUTH_ERR</td>
<td>Authentication failure for the design.</td>
</tr>
<tr>
<td>0xD003</td>
<td>RSU_CMF_DESC_SHA_MISMATCH</td>
<td>The SHA does not match for the firmware descriptor.</td>
</tr>
<tr>
<td>0xD004</td>
<td>RSU_POINTERS_NOT_FOUND_ERR</td>
<td>Unable to read data from boot ROM on first boot after the device exits power-on reset (POR).</td>
</tr>
<tr>
<td>0xD005</td>
<td>RSU_QSPI_REQ_CHANGE</td>
<td>Unable to configure the quad SPI flash during RSU initialization.</td>
</tr>
<tr>
<td>0xD006</td>
<td>RSU_FACTORY_IMAGE_FAILED</td>
<td>Failed to load any image, including the factory image.</td>
</tr>
<tr>
<td>0xD007</td>
<td>RSU_CMF_TYPE_ERR</td>
<td>The firmware version does not match the version that was previously loaded.</td>
</tr>
</tbody>
</table>
### 5.3.2. Error Code Responses

#### Table 38. Error Codes

<table>
<thead>
<tr>
<th>Value (Hex)</th>
<th>Error Code Response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OK</td>
<td>Indicates that the command completed successfully. A command may erroneously return the OK status if a command, such as QSPI_READ, is partially successful.</td>
</tr>
<tr>
<td>1</td>
<td>INVALID_COMMAND</td>
<td>Indicates that the command is incorrectly formatted.</td>
</tr>
<tr>
<td>2</td>
<td>UNKNOWN_BR</td>
<td>Indicates that the command code is not understood.</td>
</tr>
<tr>
<td>3</td>
<td>UNKNOWN</td>
<td>Indicates that the currently loaded firmware cannot decode the command code.</td>
</tr>
<tr>
<td>4</td>
<td>COMMAND_INVALID_ON_SOURCE</td>
<td>Command is from a source for which it is not enabled.</td>
</tr>
<tr>
<td>6</td>
<td>CLIENT_ID_NO_MATCH</td>
<td>Indicates that the Client ID requesting quad SPI or SD MMC access does not have exclusive access.</td>
</tr>
<tr>
<td>7</td>
<td>INVALID_ADDRESS</td>
<td>The address is invalid. This error indicates one of the following conditions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An unaligned address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An address range problem</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A read permission problem</td>
</tr>
<tr>
<td>8</td>
<td>TIMEOUT</td>
<td>The command timed out.</td>
</tr>
<tr>
<td>9</td>
<td>HW_NOT_READY</td>
<td>The hardware is not ready. Can indicate either an initialization or configuration problem.</td>
</tr>
<tr>
<td>100</td>
<td>NOT_CONFIGURED</td>
<td>Indicates that the device is not configured.</td>
</tr>
<tr>
<td>1FF</td>
<td>ALT_SDM_MBOX_RESP_DEVICE_BUSY</td>
<td>Indicates that the device is busy.</td>
</tr>
<tr>
<td>2FF</td>
<td>ALT_SDM_MBOX_RESP_NO_VALID_RESP_AVAILABLE</td>
<td>Indicates that there is no valid response available.</td>
</tr>
<tr>
<td>3FF</td>
<td>ALT_SDM_MBOX_RESP_ERROR</td>
<td>General Error.</td>
</tr>
</tbody>
</table>
5.4. Quad SPI Flash Layout

5.4.1. High Level Flash Layout

5.4.1.1. Standard (non-RSU) Flash Layout

In the standard (non-RSU) case, the flash contains four firmware images and the application image. To guard against possible corruption, there are four redundant copies of the firmware. The firmware contains a pointer to the location of the highest priority application image in flash. Typically the application image is immediately after the four firmware copies, but the Intel Quartus Prime Pro Edition tools do not require this location.

![Flash Layout - Non-RSU](image)

5.4.1.2. RSU Flash Layout – SDM Perspective

In the RSU case, decision firmware replaces the standard firmware. The decision firmware copies have pointers to the following structures in flash:

- Decision data
- One factory image
- Two Pointer Blocks (CPBs)
The decision firmware data stores basic settings, including the following:

- The clock and pins that connect to quad SPI flash memory
- The **Direct to Factory Image** pin that forces the SDM to load the factory image. (You can set this pin on the following menu: **Assignments ➤ Device ➤ Device and Pin Options ➤ Configuration ➤ Configuration Pin Options**).

The pointer blocks contain a list of application images to try until one of them is successful. If none are successful, the SDM loads the factory image. To ensure reliability, the pointer block includes a main and a backup copy in case an update operation fails.
Both the factory image and the application images start with firmware. First, the decision firmware loads the firmware. Then, that firmware loads the rest of the image. These implementation details are not shown in the figure above. For more information, refer to the Application Image Layout section.

Related Information
Application Image Layout on page 162

5.4.1.3. RSU Flash Layout – Your Perspective

The sub-partition table (SPT) manages the quad SPI flash. In devices that include the HPS, the HPS can access and read the SPT and report it to the SDM.

The Intel Quartus Prime Programming File Generator creates the SPT when creating the initial manufacturing image. To ensure reliable operation, the Programming File Generator creates two copies, sub-partition table and the configuration pointer block, SPT0 and SPT1 and CPB0 and CPB1.

The initial RSU image stored in flash typically contains the following partitions:

Table 39. Typical Sub-Partitions of the Initial RSU Image

<table>
<thead>
<tr>
<th>Sub-partition Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOT_INFO</td>
<td>Decision firmware and decision firmware data</td>
</tr>
<tr>
<td>FACTORY_IMAGE</td>
<td>Factory Image</td>
</tr>
<tr>
<td>SPT0</td>
<td>Sub-partition table 0</td>
</tr>
<tr>
<td>SPT1</td>
<td>Sub-partition table 1</td>
</tr>
<tr>
<td>CPB0</td>
<td>Pointer block 0</td>
</tr>
<tr>
<td>CPB1</td>
<td>Pointer block 1</td>
</tr>
<tr>
<td>A1 (you enter)</td>
<td>Application image 1</td>
</tr>
<tr>
<td>A2 (you enter)</td>
<td>Application image 2</td>
</tr>
</tbody>
</table>
To summarize, your view of flash memory is different from SDM view in two ways:

- You do not need to know the addresses of the decision firmware, decision firmware data, and factory image.
- You have access to the sub-partition tables. The sub-partition tables provide access to the data structures required for remote system update.
5.4.2. Detailed Quad SPI Flash Layout

5.4.2.1. RSU Sub-Partitions Layout

The Flash Sub-Partitions Layout table shows the layout of RSU flash images.

### Table 40. Flash Sub-Partitions Layout

<table>
<thead>
<tr>
<th>Flash Offset</th>
<th>Size (in bytes)</th>
<th>Contents</th>
<th>Sub-Partition Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 K</td>
<td>256 K</td>
<td>Decision firmware</td>
<td>BOOT_INFO</td>
</tr>
<tr>
<td>256 K</td>
<td>256 K</td>
<td>Decision firmware</td>
<td></td>
</tr>
<tr>
<td>512 K</td>
<td>256 K</td>
<td>Decision firmware</td>
<td></td>
</tr>
<tr>
<td>768 K</td>
<td>256 K</td>
<td>Decision firmware</td>
<td></td>
</tr>
<tr>
<td>1M</td>
<td>8 K + 24 pad</td>
<td>Decision firmware data</td>
<td></td>
</tr>
<tr>
<td>1M+32 K</td>
<td>32 K</td>
<td>Reserved for SDM</td>
<td></td>
</tr>
<tr>
<td>2M+64 K</td>
<td>varies</td>
<td>Factory image</td>
<td>FACTORY_IMAGE</td>
</tr>
<tr>
<td>Next</td>
<td>4 K + 28 K pad</td>
<td>Sub-partition table (copy 0)</td>
<td>SPT0</td>
</tr>
<tr>
<td>Next</td>
<td>4 K + 28 K pad</td>
<td>Sub-partition table (copy 1)</td>
<td>SPT1</td>
</tr>
<tr>
<td>Next</td>
<td>4 K + 28 K pad</td>
<td>Pointer block (copy 0)</td>
<td>CPB0</td>
</tr>
<tr>
<td>Next</td>
<td>4 K + 28 K pad</td>
<td>Pointer block (copy 1)</td>
<td>CPB1</td>
</tr>
<tr>
<td>Next</td>
<td>varies</td>
<td>Application image 1</td>
<td>You assign</td>
</tr>
<tr>
<td>Next</td>
<td>varies</td>
<td>Application image 2</td>
<td>You assign</td>
</tr>
</tbody>
</table>

The Intel Quartus Prime Programming File Generator allows you to create many user partitions. These partitions can contain application images and other items such as the Second Stage Boot Loader (SSBL), Linux* kernel, or Linux root file system.

When you create the initial flash image, you can create up to seven partitions for application images. There are no limitations on creating empty partitions.

5.4.2.2. Sub-Partition Table Layout

The following table shows the structure of the sub-partition table. The Intel Quartus Prime software supports up to 126 partitions. Each sub-partition descriptor is 32 bytes.
### Table 41. Sub-partition Table Layout

<table>
<thead>
<tr>
<th>Offset</th>
<th>Size (in bytes)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x000</td>
<td>4</td>
<td>Magic number 0x57713427</td>
</tr>
<tr>
<td>0x004</td>
<td>4</td>
<td>Version number (0 for this document)</td>
</tr>
<tr>
<td>0x008</td>
<td>4</td>
<td>Number of entries</td>
</tr>
<tr>
<td>0x00C</td>
<td>20</td>
<td>Reserved</td>
</tr>
<tr>
<td>0x020</td>
<td>32</td>
<td>Sub-partition Descriptor 1</td>
</tr>
<tr>
<td>0x040</td>
<td>32</td>
<td>Sub-partition Descriptor 2</td>
</tr>
<tr>
<td>0xFE0</td>
<td>32</td>
<td>Sub-partition Descriptor 126</td>
</tr>
</tbody>
</table>

Each 32-byte sub-partition descriptor contains the following information:

### Table 42. Sub-partition Descriptor Layout

<table>
<thead>
<tr>
<th>Offset</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>16</td>
<td>Sub-partition name, including a null string terminator</td>
</tr>
<tr>
<td>0x10</td>
<td>8</td>
<td>Sub-partition start offset</td>
</tr>
<tr>
<td>0x18</td>
<td>4</td>
<td>Sub-partition length</td>
</tr>
<tr>
<td>0x1C</td>
<td>4</td>
<td>Sub-partition flags</td>
</tr>
</tbody>
</table>

### 5.4.2.3. Configuration Pointer Block Layout

The configuration pointer block contains a list of application images. The SDM tries the images in sequence until one of them is successful or all fail. The structure contains the following information:

### Table 43. Pointer Block Layout

<table>
<thead>
<tr>
<th>Offset</th>
<th>Size (in bytes)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>4</td>
<td>Magic number 0x57789609</td>
</tr>
<tr>
<td>0x04</td>
<td>4</td>
<td>Size of pointer block header (0x18 for this document)</td>
</tr>
</tbody>
</table>
The configuration pointer block can contain up to 508 application image pointers. The actual number is listed as NSLOTS. A typical configuration pointer block update procedure consists of adding a new pointer and potentially clearing an older pointer. Typically, the pointer block update uses one additional entry. Consequently, you can make 508 remote system updates before the pointer block must be erased. The erase procedure is called pointer block compression. This procedure is safe. There are two copies of pointer block. The copies are in different flash erase sectors. While one copy is being updated the other copy is still valid.

5.4.2.4. Modifying the List of Application Images

The SDM uses the configuration pointer block to determine priority of application images.

The pointer block operates taking into account the following characteristics of quad SPI flash memory:

- On a sector erase, all the sector flash bits become 1’s.
- A program operation can only turn 1’s into 0’s.

The pointer block contains an array of values which have the following meaning:

- All 1’s – the entry is unused. The client can write a pointer to this entry. This is the state after a quad SPI erase operation occurs on the pointer block.
- All 0’s – the entry has been previously used and then canceled.
- A combination of 1’s and 0’s – a valid pointer to an application image.
When the configuration pointer block is erased, all entries are marked as unused. To add an application image to the list, the client finds the first unused location and writes the application image address to this location. To remove an application image from the list, the client finds the application image address in the pointer block list and writes this address to 0s.

If the configuration pointer block runs out of space for new application images, the client compresses the pointer block by completing the following actions:

- Erasing the pointer block
- Copying all previously valid entries
- Adding the new image

When using HPS to manage RSU, both the U-Boot and LIBRSU clients implement the block compression. For designs that drive RSU from FPGA logic, you can implement pointer block compression many different ways, including Nios II code, a scripting language, or a state machine.

Pointer block compression does not occur frequently because the pointer block has up to 508 available entries.

There are two configuration pointer blocks: a primary (CPB0) and a backup (CPB1). Two blocks enable the list of application images to be protected if a power failure occurs just after erasing one of them. For more information, refer to the Configuration Pointer Block Layout topic. When compressing, the client compresses (erases and rewrites) the primary CPB completely. Once the primary CPB is valid, it is safe to modify the secondary CPB. When rewriting, the magic number at the start of a CPB is the last word written in the CPB. (After this number is written only image pointer slot values can be changed.)

When the client writes the application image to flash, it ensures that the pointers within the main image pointer of its first signature block are updated to point to the correct locations in flash. When using HPS to manage RSU, both the U-Boot and LIBRSU clients implement the required pointer updates. For more information, refer to the Application Image Layout topic.

Related Information
- Configuration Pointer Block Layout on page 160
- Application Image Layout on page 162

5.4.2.5. Application Image Layout

The application image comprises SDM firmware and the configuration data. The configuration data includes up to four sections. The SDM firmware contains pointers to those sections. The table below shows the location of the number of sections and the section pointers in a application image.
By default the first 16 bytes of the application image, *.rpd, starting at address offset 0x1FC0 are 0. However you can use these 16 bytes to store a Version ID to identify your application image. Providing this Version ID allows you to verify the images stored in flash memory at a later time.

Table 44. Application Image Section Pointers

<table>
<thead>
<tr>
<th>Offset</th>
<th>Size (in bytes)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x1F00</td>
<td>4</td>
<td>Number of sections</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0x1F08</td>
<td>8</td>
<td>Address of 1st section</td>
</tr>
<tr>
<td>0x1F10</td>
<td>8</td>
<td>Address of 2nd section</td>
</tr>
<tr>
<td>0x1F18</td>
<td>8</td>
<td>Address of 3rd section</td>
</tr>
<tr>
<td>0x1F20</td>
<td>8</td>
<td>Address of 4th section</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0x1FFC</td>
<td>4</td>
<td>CRC32 of 0x1000 to 0x1FFB</td>
</tr>
</tbody>
</table>

The section pointers must match the actual location of the FPGA image in flash. Two options are available to meet this requirement:

- You can generate the application image to match the actual location in quad SPI flash memory. Because different systems may have a different sets of updates this option may not be practical.
- You can generate the application image as if it is located at address zero, then update the pointers to match the actual location.

Here is the procedure to update the pointers from an application image created for INITIAL_ADDRESS to NEW_ADDRESS:

1. Create the application image, targeting the INITIAL_ADDRESS.
2. Read the 32-bit value from offset 0xF100 of the application image to determine the number of sections.
3. For \( s = 1 \) to number_of_sections:
a. section_pointer = read the 64-bit section pointer from 0xF100 + (s * 8)
b. Subtract INITIAL_ADDRESS from section_pointer
c. Add NEW_ADDRESS to section_pointer
d. Store updated section_pointer

4. Recompute the CRC32 for addresses 0x1000 to 0x1FFB. Store the new value at offset 0x1FFC. The CRC32 value must be computed on a copy of the data using the following procedure:
   a. Swap the bits of each byte so that the bits occur in reverse order and compute the CRC.
   b. Swap the bytes of the computed CRC32 value to appear in reverse order.
   c. Swap the bits in each byte of the CRC32 value.
   d. Write the CRC32 value to flash.

When using HPS to manage RSU, both U-Boot and LIBRSU clients implement the above procedure to relocate application images targeting address zero in the actual destination slot address.

*Note:* The factory update image has a different format. Refer to the *Generating a Factory Update Image* topic for the correct procedure to generate the factory update image.

**Related Information**

*Generating a Factory Update Image* on page 169

**5.5. Generating Remote System Update Image Files Using the Programming File Generator**

Use the Intel Quartus Prime Programming File Generator tool to generate the Intel Stratix 10 remote system update flash programming files.

**5.5.1. Generating the Initial RSU Image**

Follow these steps to generate the initial RSU image:

1. On the **File** menu, click **Programming File Generator**.
2. Select Intel Stratix 10 from the **Device family** drop-down list.
3. Select the configuration scheme from the **Configuration scheme** drop-down list. The current Intel Quartus Prime only supports remote system update feature in **Active Serial x4**.
4. On the **Output Files** tab, assign the output directory and file name.

5. Select the output file type.
   - Select the following file types for AS x4 configuration mode:
     - JTAG Indirect Configuration File (.jic)/Programmer Object File (.pof)
     - Memory Map File (.map)
     - Raw Programming File (.rpd)

6. On the **Input Files** tab, click **Add Bitstream**, select the factory and application image .sof files and click Open.

7. On the **Configuration Device** tab, click **Add Device**, select your flash memory and click **OK**. The Programming File Generator tool automatically populates the flash partitions.

8. Select the **FACTORY_IMAGE** partition and click **Edit**.

9. In the **Edit Partition** dialog box, select your factory image .sof file in the Input file drop-down list and click **OK**.
   
   **Note:** You must assign Page 0 to Factory Image. Intel recommends that you let the Intel Quartus Prime software assign the Start address of the FACTORY_IMAGE automatically by retaining the default value for **Address Mode** which is **Auto**. From the **Address Mode** drop down list, select **Block** to set an **End address** value for the FACTORY_IMAGE. The Programming File Generator reserves and assigns the start and end flash addresses to store BOOT_INFO, SPT0, SPT1, CPB0, and CPB1.

10. Select the flash memory and click **Add Partition**.

11. In the **Add Partition** dialog box, select for application image .sof file from the **Input file** drop-down list, assign the page number.

12. Repeat this step for additional application images and click **OK**. You can add up to seven partitions for seven application images. The **page 1** application image is the highest priority, and the **page 7** image is the lowest priority.

13. For .jic files,
   
   Click **Select** at the Flash loader, select your device family and device name, and click **OK**.

14. Click **Generate** to generate the remote system update programming files. After generating the programming file, you can proceed to program the flash memory.
**Note:** The generated `.jic` file contains only the initial flash data. If a remote host updates the initial flash image and then the application performs a verify operation, the verify operation fails. Verification fails because the verify operation compares the updated image to the initial flash data. If you want to verify the updated flash image, you read back the updated image from flash and compare it to the expected `.rpd` file.

You can use the programmer to examine the flash content and compare it to the new flash image `.rpd`.

**Note:** If you plan to update the factory image, Intel recommends reserving an additional 64 KB space for possible expansion of the factory image. Complete the following steps to reserve extra space for updates to the factory image:

a. Identify the new end address by adding 64 KB to the existing END ADDRESS of the FACTORY_IMAGE. The end address is available in the `.map` file. For example, if the current end address is `0x00423FF`, the new end address is `0x00523FF`.

b. Repeat the steps to regenerate the new `.jic` file. On the Configuration Device tab, select the FACTORY_IMAGE partition and click Edit. In the Edit Partition dialog box, under the Address Mode drop down list, select Block to set the new End address value for the FACTORY_IMAGE.

c. You can optionally Click File ➤ Save As .. to save the configuration parameters as a file with the `.pfg` extension. The `.pfg` file contains your settings for the Programming File Generator. After you save the `.pfg`, you can use this file to regenerate the programming file by running the following command:

```
quartus_pfg -c <configuration_file>.pfg
```

The `.pfg` file is actually an XML file which you can edit to replace absolute file paths with relative file paths. You cannot edit the `.pfg` file for other reasons. You can open and edit the `.pfg` in the Programming File Generator.
5.5.2. Generating an Application Image

You can generate the RSU image from the command line directly, by running the `quartus_pfg` with the following arguments:

```
quartus_pfg -c fpga.sof application.rpd -o mode=ASX4 -o start_address=<address> -o bitswap=ON
```

Alternatively, you can use the Intel Quartus Prime Pro Edition Programming File Generator to generate the `.rpd` image by completing the following procedure:

1. On the File menu, click Programming File Generator.
2. Select Intel Stratix 10 from the Device family drop-down list.
3. Select the configuration mode from the Configuration mode drop-down list. The current Intel Quartus Prime only supports remote system update feature in Active Serial x4.
4. On the Output Files tab, assign the output directory and file name.
5. Select the output file type.
   Select the following file types for AS x4 configuration mode:
   - Raw Programming File (.rpd)
6. Click the Edit... button and assign the Start address for the image in flash memory. This Start address must match the starting address of the target partition in flash memory.
7. By default, the .rdp file type is little-endian, if you are using a third-party programmer that does not support the little-endian format. Set the Bit swap to On to generate the .rdp file in big endian format.

8. On the Input Files tab, click Add Bitstream. Change the Files of type to SRAM Object File (*.sof). Then, select application image .sof file and click Open.
9. Click **Generate** to generate the remote system update programming files. You can now program the flash memory. You can save the configuration in a .pfg file for later use.

### 5.5.3. Generating a Factory Update Image

You can generate the factory update image from the command line directly, by running the `quartus_pfg` with the following arguments:

```
quartus_pfg -c fpga.sof factory_update.rpd -o mode=ASX4 -o start_address=<address> -o bitswap=ON -o rsu_upgrade=ON
```

Alternatively, you can use the Intel Quartus Prime Pro Edition **Programming File Generator** to generate a factory update image (.rpd). You can use this image to update the decision firmware, decision firmware data, and the factory image.

**Note:** Starting with the Stratix 10 device family the .rpd to program flash memory includes firmware pointer information for image addresses. You must use the **Programming File Generator** to generate the .rpd for flash devices.

1. On the **File** menu, click **Programming File Generator**.
2. Select Intel Stratix 10 from the **Device family** drop-down list.
3. Select the configuration mode from the **Configuration mode** drop-down list. The current Intel Quartus Prime only supports the RSU feature in the **Active Serial x4** configuration mode.
4. On the **Output Files** tab, assign the **Output directory** and **Name**.

5. Select the `.rpd` output file type.

6. Click the **Edit**... button and assign the **Start address** for the update image in flash memory. This **Start address** should be the sector boundary of unused space in flash memory.

   *Note:* If unused space is not available, you can use an application image space other than application image 1. In this case after the update operation completes you must restore the application image by writing the associated application image (`.rpd`) to the application slot.

   **Figure 72. Specifying Parameters for Single .rpd Stored in Flash Memory**

   ![Specifying Parameters for Single .rpd Stored in Flash Memory](image)

7. By default, the `.rpd` file type is little-endian. If you are using a third-party programmer that does not support the little-endian format, set **Bit swap** to **On** to generate the `.rpd` file in big endian format.

8. On the **Input Files** tab, click **Add Bitstream**. If necessary, change the **Files of type** to SRAM Object File (`*.sof`). Then, select factory image `.sof` file and click **Open**.
5. Remote System Update (RSU)
UG-S10CONFIG | 2019.12.16

Figure 73. Specify the .sof File

9. Select the .sof and then click Properties. Turn On Generate RSU factory update image. The Bootloader parameter

*Note:* You only have to specify the Bootloader parameter for Intel Stratix 10 SX devices.
10. Click **Generate** to generate the RSU programming files. You can now update the Intel Stratix 10 firmware. You can save the configuration in a `.pfg` file for later use.
5. Remote System Update (RSU)

5.5.4. Command Sequence To Perform Quad SPI Operations

Here is the recommended command sequence to access quad SPI flash memory or perform an RSU update operation.

Refer to Table 35 on page 146 for more information about these commands.

1. Request exclusive access to the AS x4 interface: QSPI_OPEN.
2. Specify a quad SPI flash chip: QSPI_SET_CS*. This command is optional for the AS x4 configuration scheme and mandatory for other configuration schemes.
3. Perform the desired operation or operations. The following operations are available: QSPI_READ, QSPI_WRITE, QSPI_ERASE, QSPI_READ_DEVICE_REG, QSPI_WRITE_DEVICE_REG, QSPI_SEND_DEVICE_OP, and RSU_IMAGE_UPDATE.
4. Close exclusive access to the AS x4 interface: QSPI_CLOSE.

5.6. Remote System Update from FPGA Core Example

This section presents a complete remote system update example, including the following steps:

1. Creating the initial remote system update image (.jic) containing the bitstreams for the factory image and one application image.
2. Programming the flash memory with the initial remote system update image that subsequently configures the device.
3. Reconfiguring the device with an application or factory image.
4. Creating a single remote system update (.rpd) containing the bitstreams to add an application image in user mode.
5. Adding an application image.
6. Removing an application image.
5.6.1. Prerequisites

To run this remote system update example, your system must meet the following hardware and software requirements:

- You should be running the Intel Quartus Prime Pro Edition software version 19.1 or later.
- You should create and download this example to the Intel Stratix 10 SoC Development Kit.
- Your design should include the Mailbox Client Intel FPGA IP that connects to a JTAG to Avalon Master Bridge as shown the Platform Designer system. The JTAG to Avalon Master Bridge acts as the remote system update host controller for your factory and application images.
- In addition, your design must include the Reset Release Intel FPGA IP. This component holds the design in reset until the entire FPGA fabric has entered user mode.
- The `ninit_done_reset` and `reset_bridge_1` components create a two-stage reset synchronizer to release the Mailbox Client Intel FPGA IP and JTAG to Avalon Master Bridge Intel FPGA IP from reset when the device configuration is complete and the device is in user mode.
The ninit_done output signal from Reset Release IP gates this reset by connecting to the ninit_done_reset pin.

The reset_in Reset Bridge Intel FPGA IP provides a user mode reset. In this design, the exported resetpin connects to application logic.

Figure 75. Required Communication and Host Components for the Remote System Update Design Example

<table>
<thead>
<tr>
<th>Connections</th>
<th>Name</th>
<th>Description</th>
<th>Export</th>
<th>Clock</th>
<th>Base</th>
<th>End</th>
<th>IRQ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>clock_in</td>
<td>Clock Bridge Intel FPGA IP</td>
<td>clk</td>
<td>clock_in_out_clk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>reset_in</td>
<td>Reset Bridge Intel FPGA IP</td>
<td>resetpin</td>
<td>clock_in_out_clk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ninit_done</td>
<td>Reset Bridge Intel FPGA IP</td>
<td>ninit_done_reset_in_reset</td>
<td>clock_in_out_clk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>reset_bridge_1</td>
<td>Reset Bridge Intel FPGA IP</td>
<td>clock</td>
<td>clock_in_out_clk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>user_rst_clkgate_0</td>
<td>Reset Release Intel FPGA IP</td>
<td>user_rst_clk</td>
<td>clock_in_out_clk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>mailbox_client_1</td>
<td>Mailbox Client Intel FPGA IP</td>
<td>mailbox_client_1</td>
<td>clock_in_out_clk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>master_0</td>
<td>JTAG to Avalon Master Bridge IP</td>
<td>master</td>
<td>clock_in_out_clk</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5.6.2. Creating Initial Flash Image Containing Bitstreams for Factory Image and One Application Image

1. On the File menu, click Programming File Generator.
2. Select Intel Stratix 10 from the Device family drop-down list.
3. Select the configuration mode from the Configuration mode drop-down list. The current Intel Quartus Prime Software only supports remote system update feature in Active Serial x4.

Send Feedback
4. On the **Output Files** tab, assign the output directory and file name.

5. Select the output file type.
   Select the following file types for the Active Serial (AS) x4 configuration mode:
   - JTAG Indirect Configuration File (**.jic**)
   - Memory Map File (**.map**)
   - Raw Programming File (**.rpd**). Generating the **.rpd** file is optional.

   **Figure 76. Creating Initial Flash Image**

6. On the **Input Files** tab, click **Add Bitstream**, select the factory and application image **.sof** files and click **Open**.
5. Remote System Update (RSU)
UG-S10CONFIG | 2019.12.16

a. Bitstream_1 is the bitstream for factory image.
b. Bitstream_2 is the bitstream for application image.

Figure 77. Input Files Tab: Specifying the .sof

7. On the **Configuration Device** tab, click **Add Device**, select MT25QU02G flash memory and click **OK**. The Programming File Generator tool automatically populates the flash partitions.

8. Select the **FACTORY_IMAGE** partition and click **Edit**.

9. On the **Edit Partition** dialog box, select **Bitstream_1** as the factory image .sof in the **Input file** drop-down list. Keep the default settings for the **Page** and **Address Mode**. Click **OK**.

10. Select the **MT25QU02G** flash memory and click **Add Partition**.

11. In the **Add Partition** dialog box, select **Bitstream_2** for the application image .sof in the **Input file** drop-down list. Assign **Page: 1**. Keep the default settings for **Address Mode**. Click **OK**.

13. For **Flash loader** click **Select**. Select Intel Stratix 10 from **Device family** list. Select 1SX280LU2 for the **Device name**. Click **OK**.

14. Click **Generate** to generate the remote system update programming files. The Programming File Generator generates the following files:
a. Initial_RSU_Image.jic  
b. Initial_RSU_Image_jic.map

Figure 78. Configuration Tab: Add Device, Partition, Flash Loader and Generate

The following example output shows the generated .map file. The .map lists the start addresses of the factory image, CPB0, CPB1, and one application image. The remote system update requires these addresses.

<table>
<thead>
<tr>
<th>BLOCK</th>
<th>START ADDRESS</th>
<th>END ADDRESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOT_INFO</td>
<td>0x00000000</td>
<td>0x0010FFFF</td>
</tr>
<tr>
<td>FACTORY_IMAGE</td>
<td>0x00110000</td>
<td>0x002D3FFF</td>
</tr>
<tr>
<td>SPT0</td>
<td>0x002D4000</td>
<td>0x002DBFFF</td>
</tr>
<tr>
<td>SPT1</td>
<td>0x002DC000</td>
<td>0x002E3FFF</td>
</tr>
<tr>
<td>CPB0</td>
<td>0x002E4000</td>
<td>0x002EBFFF</td>
</tr>
<tr>
<td>CPB1</td>
<td>0x002EC000</td>
<td>0x002F3FFF</td>
</tr>
<tr>
<td>Application Image</td>
<td>0x002F4000</td>
<td>0x004B7FFF</td>
</tr>
</tbody>
</table>

Configuration device: 1SX280LU3S2
Configuration mode: Active Serial x4
Quad-Serial configuration device dummy clock cycle: 15
5.6.3. Programming Flash Memory with the Initial Remote System Update Image

You can program the initial remote system update image from the command line. In the following command, substitute your .jic for output_file.jic if necessary.

```plaintext
quartus_pgm -c 1 -m jtag -o "pvi;/output_file.jic"
```

Alternatively, you can use the Intel Quartus Prime Programmer to program the initial RSU update image by completing the following procedure:

1. Open the Programmer and click Add File. Select the generated .jic file (output_file.jic) and click Open.
2. Turn on the Program/Configure for the attached .jic file.
3. To begin programming the flash memory with the initial remote system update image, click Start.
4. Configuration is complete when the progress bar reaches 100%. Power cycle the board to automatically configure the Intel Stratix 10 device with the application image using the AS x4 configuration scheme.
Figure 79. Programming the Flash Memory with the Initial RSU Image
Note: This example does not assign the **Direct to Factory Image** pin. Consequently, the Programmer configures the device with the application image. The application image is the default image if the design does not use the **Direct to Factory Image** pin.

5. Use the `RSU_STATUS` command to determine which bitstream image the Programmer is using as shown in the following example:
   a. In the Intel Quartus Prime software, select **Tools ➤ System Debugging Tools ➤ System Console** to launch the system console.
   b. In the Tcl Console pane, type `source rsu1.tcl` to open the example of Tcl script to perform the remote system update commands. Refer to the **Related Information** for a link to rsu1.tcl.
   c. Type the `rsu_status` command to report the current remote system update status. You can retrieve the current running image address from the remote system update status report. The current image address must match the start address for the application image printed in the `.map` file.

**Figure 80. Running Tcl Commands Available in rsu1.tcl**

![Running Tcl Commands Available in rsu1.tcl](source rsu1.tcl rsu_status)

**Related Information**

rsu1.tcl

**5.6.4. Reconfiguring the Device with an Application or Factory Image**

The following steps describe the process to reconfigure the device with a different application image or the factory image using operation commands after the device is in user mode.

1. The remote system update host sends the `RSU_IMAGE_UPDATE` command to perform the remote system update to the new application image or factory image.
   a. For example, in the Tcl console of the System Console, type the following command to initiate a remote system update to the factory image.
     i. `rsu_image_update 0x00110000`
This command reconfigures the device with factory image. Address 0x00110000 is the start address of the factory image as shown in the .map file. The JTAG host automatically disconnects from the System Console once the device reconfiguration is successful. You must restart the System Console to re-establish the connection with the device to perform next command.

ii. `rsu_image_update 0x002F4000`

This command reconfigures the device with the application image. Address 0x002F4000 is the start address of the application image as shown in the .map file.

Optional: Retrieve the remote system update status by using the `rsu_status` command to ensure you have successfully reconfigured the device.

2. In the Tcl console of the System Console, type `rsu_status` to verify the current image. The following figure shows the device is being reconfigured with the factory image.

![Figure 81. Verify Current Image Using rsu_status Command](image)

```bash
$ source rsu1.tcl
/channels/local/top/master_1
$ rsu_status
current image address 0x00110000
first failing image address 0x00000000
failing code 0x00000000
error location 0x00000000
```

### 5.6.5. Adding an Application Image

Complete the following steps to add an application image to flash memory:

1. Set up exclusive access to the AS x4 interface and flash memory by running the QSPI_OPEN and QSPI_SET_CS commands in the Tcl Console window. You now have exclusive access to the AS x4 interface and flash until you relinquish access by running the QSPI_CLOSE command. Write the new application image to the flash memory using the QSPI_WRITE command.

2. Alternatively, the `rsu1.tcl` script includes the `program_flash` function that programs a new application image into flash memory. The following command accomplishes this task:

```bash
program_flash new_application_image.rpd 0x03FF0000 1024
```
The program_flash function takes three arguments:

a. The .rpd file to write to flash memory.

b. The start address.

c. Number of words to write for each QSPI_WRITE command. The QSPI_WRITE supports up to 1024 words per write instruction.

**Figure 82. Program New Application Image**

```
$ source rsu.tcl
/channels/local/top/master_1
$ program_flash new_application_image.rpd 0x03ff0000 1024
total number of words is 458752
total number of page is 448
total number of sector is 28
reading rpd is completed
start erasing flash
erasing flash is completed
start writing flash
writing flash is completed
```

3. Write the new application image start address to a new image pointer entry in the configuration firmware pointer block (CPB) using the QSPI_WRITE command. Ensure that the new image pointer entry value is 0xFFFFFFFF before initiating the write.

   **Note:** You must update both copies (CBP0 and CBP1) when editing the configuration firmware pointer block and sub-partition table. Refer to Table 1 for more details about the configuration firmware pointer block.

Based on the example described above, the address offset 0x20 in the CPB0 and CPB1 must point to the start address of the application image. The next new image pointer entry value must be 0xFFFFFFFF before you write the start address of the new application image to the next image pointer entry.
Table 45. Configuration Firmware Point Block Contents

<table>
<thead>
<tr>
<th>CPB Start Address + 0x20</th>
<th>Content</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPB0 + 0x20 = 0x002E4020</td>
<td>Current application image pointer entry (highest priority)</td>
<td>0x002F4000</td>
</tr>
<tr>
<td>CPB0 + 0x28 = 0x002E4028</td>
<td>Next image pointer entry</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>CPB1 + 0x20 = 0x002E0C20</td>
<td>Current application image pointer entry (highest priority)</td>
<td>0x002F4000</td>
</tr>
<tr>
<td>CPB1 + 0x28 = 0x002E0C28</td>
<td>Next image pointer entry</td>
<td>0xFFFFFFFF</td>
</tr>
</tbody>
</table>

Table 46. Configuration Firmware Point Block Contents

<table>
<thead>
<tr>
<th>CPB Start Address + 0x20</th>
<th>Content</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPB0 + 0x20 = 0x004A0020</td>
<td>Current application image pointer entry (highest priority)</td>
<td>0x004B0000</td>
</tr>
<tr>
<td>CPB0 + 0x28 = 0x004A0028</td>
<td>Next image pointer entry</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>CPB1 + 0x20 = 0x004A8020</td>
<td>Current application image pointer entry (highest priority)</td>
<td>0x004B0000</td>
</tr>
<tr>
<td>CPB1 + 0x28 = 0x002E0C28</td>
<td>Next image pointer entry</td>
<td>0xFFFFFFFF</td>
</tr>
</tbody>
</table>

You can use the QSPI_read function verify that the new image pointer entry value is 0xFFFFFFFF. The QSPI_read function takes in two arguments:

1. Start address
2. Number of words to read

Figure 83. Verifying that the New Image Pointer entry Value is 0xFFFFFFFF

```bash
$ qspi_read 0x002e4020 1
0x002f4000
$ qspi_read 0x002e4028 1
0xffffffff
$ qspi_read 0x002f4000 1
ISR is empty
0x002f4000
$ qspi_read 0x002ec020 1
0xffffffff
$ qspi_read 0x002ec028 1
0xffffffff
```
You can now proceed to write the new application image address to next image entry by using the `QSPI_write_one_word` function. The `QSPI_write_one_word` function takes in two arguments:

1. Address
2. The value of the word

**Figure 84. Writing an Address Pointer to the New Image Pointer Entry**

```plaintext
% qspi_write_one_word 0x002e4028 0x03ff0000
% qspi_write_one_word 0x002ec028 0x03ff
```

You can now do a `QSPI_read` function to the next image pointer entry to ensure that it is written with the start address of the desired new application image.

**Verifying the Update to the New Image Pointer**

```plaintext
% qspi_read 0x002e4028 1
0x03ff0000
% qspi_read 0x002ec028 1
0x03ff0000
```

Host software can now reconfigure the Intel Stratix 10 FPGA with the new application image by asserting the `nCONFIG` pin. Alternatively, you can power cycle the PCB. After reconfiguration, check the current image address. The expected address is 0x03ff0000. After adding a new image, your application image list includes the newly added application image and the old application image, which is now a secondary image. The newly added application image has the highest priority.

**Note:** When the remote system update host loads an application image, the decision firmware traverses the image pointer entries in reverse order. The new image has the highest priority when you restart the device.
5.6.6. Removing an Application Image

1. Set up exclusive access to the AS x4 interface and flash memory by running the QSPI_OPEN and QSPI_SET_CS commands in the Tcl Console window. You now have exclusive access to the AS x4 interface and flash until you relinquish access by running the QSPI_CLOSE command. Write the new application image to the flash memory using the QSPI_WRITE command.

2. Write 0x00000000 to the application image start address stored in the image pointer entry of the configuration firmware pointer block (CPB0 and CPB1) using the QSPI_WRITE command.
   
   Note: You must update both copies (copy0 and copy1) when editing the configuration firmware pointer block and sub-partition table.

3. Erase the application image content in the flash memory using the QSPI_ERASE command.

4. To remove a new application image, add another new application image in the next or subsequent image pointer entry or allow the device to fall back to the previous or secondary application image in your application image list. The following table shows correct entries for image pointer entries for CPB0 and CPB1 for offsets 0x20 and 0x28:

<table>
<thead>
<tr>
<th>CPB Start Address + 0x20</th>
<th>Content</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPB0 + 0x20 = 0x002E4020</td>
<td>Old application image pointer entry (lower priority)</td>
<td>0x002F4000</td>
</tr>
<tr>
<td>CPB0 + 0x28 = 0x002E4028</td>
<td>Current/new application image pointer entry (highest priority)</td>
<td>0x03FF0000</td>
</tr>
<tr>
<td>CPB1 + 0x20 = 0x002EC020</td>
<td>Old application image pointer entry (lower priority)</td>
<td>0x002F4000</td>
</tr>
<tr>
<td>CPB1 + 0x28 = 0x002EC028</td>
<td>Current/New application image pointer entry (highest priority)</td>
<td>0x03FF0000</td>
</tr>
</tbody>
</table>

Figure 85. Read Current CPB Values

```
% qspi_read 0x002e4020 1
0x002f400
% qspi_read 0x002e4028 1
0x03ff0000
% qspi_read 0x002e020 1
0x002f4000
% qspi_read 0x002ec028 1
ISR is empty
0x03ff0000
```
You can now remove the current or new application image address image pointer entry by writing the value to 0x00000000 using the QSPI_write_one_word function as shown in the following example. The QSPI_write_one_word function takes address and data arguments. Be sure to erase the application content that you just removed from flash memory.

**Figure 86. Remove Application Image**

```
% qspi_write_one_word 0x002e4028 0x00000000
% qspi_write_one_word 0x002ec028 0x00000000
```

You can use a QSPI_read to the image pointer entry at offset 0x28 for CBP0 and CPB1 to verify completion of the QSPI_write_one_word commands.

**Figure 87. Verify the Writes**

```
% qspi_read 0x002e4028 1
% qspi_read 0x002ec028 1
```

**Figure 88. Verify the Writes**

```
% qspi_read 0x004A0028 1
% qspi_read 0x004A8028 1
```

You can now configure the device with the old application image. The old application image has the highest priority if you power cycle the device or the host asserts the nCONFIG pin. You can run the rsu_status report to check the status of the current image address.
6. Intel Stratix 10 Configuration Features

6.1. Device Security

Note: Contact your Intel sales representative for more information about the device security support in Intel Stratix 10 devices.

The Intel Stratix 10 device provides the following flexible and robust security features to protect sensitive data and intellectual property:

• User image authentication and encryption
• Public-Key based authentication
• Advanced Encryption Standard (AES)-256 Encryption
• JTAG Disable
• JTAG Debug Disable/Enable
• Side channel protection
• Physical anti-tampering protection

Related Information

Intel Stratix 10 Device Features
For a list of device features that are planned for future releases.

6.2. Configuration via Protocol

The CvP configuration scheme creates separate images for the periphery and core logic. You can store the periphery image in a local configuration device and the core image in host memory, reducing system costs and increasing the security for the proprietary core image. CvP configures the FPGA fabric through the PCI Express® (PCIe) link and is available for Endpoint variants only.
Figure 89. Intel Stratix 10 CvP Configuration Block Diagram
The CvP configuration scheme supports the following modes:

- **CvP Initialization Mode:**
  
  In this mode an external configuration device stores the periphery image and it loads into the FPGA through the Active Serial x4 (Fast mode) configuration scheme. The host memory stores the core image and it loads into the FPGA through the PCIe link.

  After the periphery image configuration completes, the `CONF_DONE` signal goes high and the FPGA starts PCIe link training. When PCIe link training completes, the PCIe link transitions to the Link Training and Status State Machine (LTSSM) L0 state and then through PCIe enumeration. The PCIe host then configures the core through the PCIe link. The PCIe reference clock must be running for the link for link training.

  After the core image configuration is complete, the CvP_CONF_DONE pin (if enabled) goes high, indicating the FPGA has receiver the full configuration bitstream over the PCIe link. `INIT_DONE` indicates that configuration is complete.

- **CvP Update Mode:**
  
  CvP update mode is a reconfiguration scheme that uses the PCIe link to deliver an updated bitstream to a target device after the device enters user mode. The periphery images which includes the PCIe link remains active, allowing CvP update to use this link to reconfigure the core fabric. In this mode, the FPGA device initializes by loading the full configuration image from the external local configuration device to the FPGA or after CvP initialization.

  You can perform CvP update on a device that you originally configure using CvP initialization or any other configuration scheme.

**Related Information**

Intel Stratix 10 Configuration via Protocol (CvP) Implementation User Guide

### 6.3. Partial Reconfiguration

Partial reconfiguration (PR) allows you to reconfigure a portion of the FPGA dynamically, while the remaining FPGA design continues to function. You can define multiple personas for a region in your design, without impacting operation in areas outside this region. This methodology is effective in systems with multiple functions that time-share the same FPGA device resources. PR enables the implementation of more complex FPGA systems.

**Related Information**

7. Intel Stratix 10 Debugging Guide

7.1. Configuration Debugging Checklist

Work through this checklist to identify issues that may result in operational failures.

Table 48. General Configuration Debugging Checklist

<table>
<thead>
<tr>
<th>Checklist Item</th>
<th>Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Verify that the $V_{CC}$, $V_{CCP}$, $V_{CCIO}$, $V_{CCPT}$, $V_{CCERAM}$, $V_{CCADC}$ supplies are in the proper range by using SDM Debug Toolkit.</td>
<td>☐</td>
</tr>
<tr>
<td>2. Verify that all configuration resistors are correctly connected ($MSEL$, $nCONFIG$, $nSTATUS$, $CONF_DONE$, $INIT_DONE$).</td>
<td>☐</td>
</tr>
<tr>
<td>3. Verify that you are following the correct power-up and power-down sequences.</td>
<td>☐</td>
</tr>
<tr>
<td>4. Verify that the SDM I/Os assignments are correct by checking the Intel Quartus Prime Compilation QSF and Fitter reports.</td>
<td>☐</td>
</tr>
<tr>
<td>5. For SmartVID devices (-V), ensure that all PMBus pins are connected to Intel Stratix 10 device.</td>
<td>☐</td>
</tr>
<tr>
<td>6. Verify that SmartVID settings follow the recommendations in the Intel Stratix 10 Power Management User Guide</td>
<td>☐</td>
</tr>
<tr>
<td>7. Verify that the Intel Stratix 10 -V device has its own voltage regulator module for $V_{CC}$ and $V_{CCP}$.</td>
<td>☐</td>
</tr>
<tr>
<td>8. After configuration are the $nCONFIG$, $nSTATUS$ $CONF_DONE$, and $INIT_DONE$ pins high? Use the SDM Debug Toolkit to determine these levels.</td>
<td>☐</td>
</tr>
<tr>
<td>9. Is the SDM operating Boot ROM code or configuration firmware? Use the SDM Debug Toolkit to answer this question.</td>
<td>☐</td>
</tr>
<tr>
<td>10. Are the $MSEL$ pins correctly connected on board? Use the SDM Debug Toolkit to answer this question.</td>
<td>☐</td>
</tr>
<tr>
<td>11. For designs that use transceivers, HBM2, PCIe, or EMIF, are the reference clocks stable and free running before configuration begins?</td>
<td>☐</td>
</tr>
<tr>
<td>12. Does your design include the Reset Release IP?</td>
<td>☐</td>
</tr>
</tbody>
</table>

continued...
7. Intel Stratix 10 Debugging Guide

7.2. Intel Stratix 10 Configuration Architecture Overview

Intel Stratix 10 devices employ a new configuration architecture. The Secure Device Manager (SDM), a dedicated hard processor, controls and monitors all aspects of device configuration from device power-on reset. This configuration architecture differs from previous Intel FPGA device families where state machines control configuration.

There are important differences between Intel Stratix 10 and previous device families with respect to available configuration modes, configuration pin behavior, and connection guidelines. In addition, the bitstream format is different. Knowing about these differences and how these pins behave can help you understand and debug configuration issues.

7.3. SDM Debug Toolkit Overview

The SDM Debug Toolkit provides access to current status of the Intel Stratix 10 device. To use these commands you must have a valid design loaded that includes the module that you intend to access The SDM Debug Toolkit includes the four tabs:

**Configuration Status**

The **Read Configuration Status** option provides the current value of MSEL, Configuration Pin Values, and Chip ID. The following information would be useful for debugging with the help of Intel: State, Error Location and Error Detail,
Voltage Sensor

- The Read option in the External Channel window reads the voltage on available channels. The Read option in the Internal Power Supplies window provides the values of internal power supplies.

**Figure 90.** Read External Channel and Read Internal Power Supplies

For more information about using the voltage sensor refer to *Intel Stratix 10 Voltage Sensor* in the *Intel Stratix 10 Analog to Digital Converter Uses Guide*. 
Temperature Sensor

- **Read** option reads the temperature in Celsius of the Intel Stratix 10 device, the HSSI channels, and the UIB_TOP and UIB_BOTTOM. The Universal Interface Bus (UIB) blocks are general-purpose SiP interfaces for HBM2.

- **HPS Reset Control**: Provides the following two options to reset the HPS: **Release HPS from Reset** option and **HPS Cold Reset**.

**Figure 91. HPS Reset Options**
**HPS Reset Control**

Provides the following two options to reset the HPS: **Release HPS from Reset** option and **HPS Cold Reset**.

**Figure 92.** HPS Reset Options
7. Intel Stratix 10 Debugging Guide

7.3.1. Using the SDM Debug Toolkit

To use the Intel Stratix 10 SDM Debug Toolkit, bring up the System Console in the same version of the Intel Quartus Prime software that you used to configure the Intel Stratix 10 device.

Complete the following steps to become familiar with the Intel Stratix 10 SDM Debug Toolkit:

1. In a Nios II command shell, type the following command:

   % system-console


3. Verify that the Intel FPGA Download Cable II connects to the PC and the 10-pin JTAG header connects to the Intel Stratix 10 device.

4. In the Intel Stratix 10 SDM Debug Toolkit, click Refresh Connections. The Refresh Connections is above the tabs in the SDM Debug Toolkit GUI.

5. On the Configuration Status tab, click Read Configuration Status. The following figure shows the Configuration Status after a successful read.
Figure 93. Read Configuration Status Command

![Read Configuration Status Command](image)

- **Refresh Connections**
7.4. Configuration Pin Differences from Previous Device Families

Intel Stratix 10 configuration pin behavior is different from earlier device families. Knowing about these differences and how these pins behave can help you understand and debug configuration issues.

<table>
<thead>
<tr>
<th>Configuration Pin Names (Pre-Intel Stratix 10)</th>
<th>Intel Stratix 10 Pin Names</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRST</td>
<td>Not Available</td>
<td>Use the TMS reset sequence. Hold TMS high for 5 TCK cycles.</td>
</tr>
<tr>
<td>CLKUSR</td>
<td>OSC_CLK_1</td>
<td>An external source you can supply to increase the configuration throughput to 250 MHz. Using an external clock source Transceivers, the HPS, PCIe, and the High Bandwidth Memory (HBM2) require this external clock. - 25 MHz - 100 MHz - 125 MHz. Refer to Setting Configuration Clock Source for instructions on setting the clock source and frequency in the Intel Quartus Prime Pro Edition software.</td>
</tr>
<tr>
<td>CRC_ERROR</td>
<td>Any unused SDM_IO (SEU_ERROR)</td>
<td>No dedicated location. Now called SEU_ERROR. Ignore until after CONF_DONE asserts.</td>
</tr>
<tr>
<td>CONF_DONE</td>
<td>SDM_IO5, SDM_IO16 (CONF_DONE)</td>
<td>No single dedicated pin location. No longer Open Drain. External pull-up Is not mandatory.</td>
</tr>
<tr>
<td>DCLK (PS - FPP)</td>
<td>AVST_CLK, AVSTx8_CLK</td>
<td>x8 mode has a dedicated clock input on SDM_IO14 (AVSTx8_CLK). For other Avalon-ST modes, use AVST_CLK. AVST_CLK and AVSTx8_CLK must be continuous and cannot pause during configuration.</td>
</tr>
<tr>
<td>DCLK (AS)</td>
<td>SDM_IO2 (AS_CLK)</td>
<td>When using the internal oscillator in AS mode, the AS_CLK runs in the range of 57 - 133 MHz based on AS_CLK selection. If you provide a 25 MHz, 100 MHz or 125 MHz clock to the OSC_CLK_1 pin, the AS_CLK can run up to 133 MHz.</td>
</tr>
<tr>
<td>DEV_OE</td>
<td>Not Available</td>
<td></td>
</tr>
<tr>
<td>DEV_CLRn</td>
<td>Not Available</td>
<td></td>
</tr>
<tr>
<td>INIT_DONE</td>
<td>SDM_IO0, SDM_IO16 INIT_DONE</td>
<td>No longer Open Drain.</td>
</tr>
<tr>
<td>MSEL[0]</td>
<td>SDM_IO5 (MSEL[0])</td>
<td>After the SDM samples MSEL this pin functions as per the configuration mode selected. Do not connect directly to power. Use 4.7 KΩ pull-up or pull-downs, as appropriate.</td>
</tr>
<tr>
<td>MSEL[1]</td>
<td>SDM_IO7 (MSEL[1])</td>
<td>After the SDM samples MSEL, this pin functions as per the configuration mode selected. Do not connect directly to power. Use 4.7 KΩ pull-up or pull-downs, as appropriate.</td>
</tr>
</tbody>
</table>

continued...
### Configuration Pin Names (Pre-Intel Stratix 10)

<table>
<thead>
<tr>
<th>Configuration Pin Names</th>
<th>Intel Stratix 10 Pin Names</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSEL[2]</td>
<td>SDM_109 (MSEL[2])</td>
<td>After the SDM samples MSEL, this pin functions as per the configuration mode selected. Do not connect directly to power. Use 4.7 KΩ pull-up or pull-downs, as appropriate.</td>
</tr>
<tr>
<td>NSTATUS</td>
<td>nSTATUS</td>
<td>No longer Open Drain. Intel recommends a 10 KΩ pull-up to VCC collateral.</td>
</tr>
<tr>
<td>NCE</td>
<td>Not Available</td>
<td>Multi-device configuration is not supported.</td>
</tr>
<tr>
<td>NCEO</td>
<td>Not Available</td>
<td>Multi-device configuration is not supported.</td>
</tr>
<tr>
<td>DATA[31:0] (PP32/PP16)</td>
<td>AVST_DATA[31:0]</td>
<td>Avalon-ST x8 uses SDM pins for data pins.</td>
</tr>
<tr>
<td>DATA[7:0] (PP8)</td>
<td>SDM_IO pins (AVSTx8_DATA)</td>
<td>Intel Stratix 10 supports up to 4 cascaded AS devices</td>
</tr>
<tr>
<td>nCSO[2:0]</td>
<td>SDMIO_8 (AS_nCSO3)</td>
<td>Intel Stratix 10 supports up to 4 cascaded AS devices</td>
</tr>
<tr>
<td>__</td>
<td>SDMI_07 (AS_nCSO2)</td>
<td>Intel Stratix 10 supports up to 4 cascaded AS devices</td>
</tr>
<tr>
<td>__</td>
<td>SDMI_09 (AS_nCSO1)</td>
<td>Intel Stratix 10 supports up to 4 cascaded AS devices</td>
</tr>
<tr>
<td>__</td>
<td>SDM_IO5 (AS_nCSO0)</td>
<td>Intel Stratix 10 supports up to 4 cascaded AS devices</td>
</tr>
<tr>
<td>nIO_PULLUP</td>
<td>Not Available</td>
<td>Use a JTAG instruction to invoke.</td>
</tr>
<tr>
<td>AS_DATA0_ASDO</td>
<td>SDM_IO4 (AS_DATA0)</td>
<td></td>
</tr>
<tr>
<td>AS_DATA[3:1]</td>
<td>SDM_IO6 (AS_DATA3)</td>
<td>Unlike earlier device families, the AS interface does not automatically tristate at power-on. When you set MSEL to JTAG, the SDM drives the AS_CLK, AS_DATA0-AS_DATA3, and AS_nCS0-AS_nCS3, MSEL pins until POR.</td>
</tr>
<tr>
<td>__</td>
<td>SDM_IO3 (AS_DATA2)</td>
<td></td>
</tr>
<tr>
<td>__</td>
<td>SDM_IO1 (AS_DATA1)</td>
<td></td>
</tr>
<tr>
<td>PR_REQUEST</td>
<td>GPIO*</td>
<td>No dedicated location.</td>
</tr>
<tr>
<td>PR_READY</td>
<td>GPIO*</td>
<td>No dedicated location.</td>
</tr>
<tr>
<td>PR_ERROR</td>
<td>GPIO*</td>
<td>No dedicated location.</td>
</tr>
<tr>
<td>PR_DONE</td>
<td>GPIO*</td>
<td>No dedicated location.</td>
</tr>
<tr>
<td>CVP_CONF_DONE</td>
<td>Any unused SDM_IO CVP_CONF_DONE</td>
<td></td>
</tr>
</tbody>
</table>

**Related Information**

[Setting Configuration Clock Source](#) on page 37
7.5. Configuration File Format Differences

Detailed information about the configuration file format is proprietary. This topic explains the general structure and differences from previous device families.

The configuration file format differs significantly from previous device families. The configuration bitstream begins with a SDM firmware section. The SDM loads the boot ROM firmware during power-on reset. Design sections for I/O configuration, HPS boot code (if applicable), and fabric configuration follow the firmware section. Configuration begins after the SDM boot ROM performs device consistency checks.

**Figure 94. Example of an Intel Stratix 10 Configuration Bitstream Structure**

The firmware section is not part of the .sof file. The Intel Quartus Prime Pro Edition Programmer adds the firmware to the .sof. The programmer adds the firmware when configuring an Intel Stratix 10 device or when it converts the .sof to another format. The version of firmware that the Programmer adds depends on the version of the Programmer you are using.
7.6. Understanding SEUs

SEUs are rare, unintended changes in the state of an FPGA's internal memory elements caused by cosmic radiation effects. The change in state is a soft error and the FPGA incurs no permanent damage. Because of the unintended memory state, the FPGA may operate erroneously until background scrubbing fixes the upset.

The Intel Quartus Prime software offers several features to detect and correct the effects of SEU, or soft errors, and to characterize the effects of SEU on your designs. LSM firmware provides SEU single bit error correction and multi-bit error detection per LSM. Additionally, some Intel FPGAs contain dedicated circuitry to help detect and correct errors.

For more information about SEUs, refer to Intel Stratix 10 SEU Mitigation User Guide.

Related Information
Intel Stratix 10 SEU Mitigation User Guide

7.7. Reading the Unique 64-Bit CHIP ID

The Chip ID Intel FPGA IP in each Intel Stratix 10 device stores a unique 64-bit chip ID. After the Chip ID Intel FPGA IP receives a valid clock input and readid signal the chip ID is available on the chip_id[63:0] output port. You can read the chip ID using the JTAG interface. The chip ID may be useful for debugging. For more information about the chip ID refer to the Chip ID Intel FPGA IP User Guide.

Related Information
Chip ID Intel FPGA IP User Guide

7.8. E-Tile Transceivers May Fail To Configure

Making the PRESERVE_UNUSED_XCVR_CHANNEL assignment to completely unused E-tile transceivers may cause configuration failures in Intel Stratix 10 TX or MX devices.

The Intel Quartus Prime Programmer detects an internal error and fails to configure your device under the following conditions:

- You have made the PRESERVE_UNUSED_XCVR_CHANNEL assignment to an entire unused E-tile.
- Your design does not provide a reference clock to this unused E-tile.
The reference clock is necessary to generate a pseudo-random data signal to prevent the transceiver from degrading over time. You must instantiate at least one dummy channel in the E-tile using the Native PHY IP GUI. Provide this channel at least one reference clock. All preserved channels in a single E-tile can use the same reference clock.

When your design uses some channels in an E-tile, you can use the per-pin PRESERVE_UNUSED_XCVR_CHANNEL QSF assignment to preserve only the channels in the E-tile that you intend to use. If you never intend to use a channel, you should not add the per-pin PRESERVE_UNUSED_XCVR_CHANNEL QSF assignment.

Here are some examples of PRESERVE_UNUSED_XCVR_CHANNEL QSF assignments.

```
#Global QSF assignment
set_global_assignment -name PRESERVE_UNUSED_XCVR_CHANNEL ON

#Per-pin QSF assignment
set_instance_assignment -name PRESERVE_UNUSED_XCVR_CHANNEL ON -to AA75
```

**Related Information**

**Unused Transceiver Channels**

For more detailed information about preserving unused transceiver channels in E-tile devices.

### 7.9. Understanding and Troubleshooting Configuration Pin Behavior

Configuration typically fails for one of the following reasons:

- The host times out
- A configuration data error occurs
- An external event interrupts configuration
- An internal error occurs
Here are some very common causes of configuration failures:

- Check OSC_CLK_1 frequency. It must match the frequency you specified in the Intel Quartus Prime Software and the clock source on your board.
- Ensure a free running reference clock is present for designs using transceivers, PCIe, or HBM2. These reference clocks must be available until the device enters user mode.
- For designs using the HPS and the external memory interface (EMIF), ensure that the EMIF clock is present.
- For designs using SmartVID (-V devices), ensure that this feature is set-up and operating correctly. Ensure that the voltage regulator supports SmartVID.

Here are some debugging suggestions that apply to any configuration mode:

- To rule out issues with OSC_CLK_1 select the Internal Oscillator option in the Intel Quartus Prime.
- Try configuring the Intel Stratix 10 device with a simple design that does not contain any IP. If configuration via a non-JTAG scheme fails with a simple design, try JTAG configuration with the MSEL pins set specifically to JTAG.

The following topics describe the expected behavior of configuration pins. In addition, these topics provide some suggestions to assist in debugging configuration failures. Refer to the separate sections on each configuration scheme for debugging suggestions that pertain to a specific configuration scheme.

**Related Information**

- Debugging Guidelines for the Avalon-ST Configuration Scheme on page 50
- Debugging Guidelines for the AS Configuration Scheme on page 106
- Debugging Guidelines for the JTAG Configuration Scheme on page 119

### 7.9.1. nCONFIG

The nCONFIG pin is a dedicated, input pin of the SDM. nCONFIG has two functions:

- Hold-off initial configuration
- Initiate FPGA reconfiguration

The nCONFIG pin transition from low to high signals a configuration or reconfiguration request. The nSTATUS pin indicates device readiness to initiate FPGA configuration.

The configuration source can only change the state of the nCONFIG pin when it has the same value as nSTATUS. When the Intel Stratix 10 device is ready it drives nSTATUS to follow nCONFIG.
The host should drive nCONFIG low to initiate device cleaning. Then the host should deassert nCONFIG initiate configuration. If the host drives nCONFIG low during a configuration cycle, that configuration cycle stops. The SDM expects a new configuration cycle to begin.

**Debugging Suggestions**

The host drives nCONFIG. Be sure that it is not floating or stuck low. nCONFIG should remain high during configuration.

### 7.9.2. nSTATUS

nSTATUS has the following two functions:

- To behave as an acknowledge for nCONFIG.
- To behave as an error status signal. It is important to monitor nSTATUS to identify configuration failures.

**Note:** nSTATUS does not go low for PR failures or failures using the JTAG configuration scheme.

Generally, the Intel Stratix 10 device changes the value of nSTATUS to follow the value of nCONFIG, except after an error. For example, after POR, nSTATUS asserts after nCONFIG asserts. When the host drives nCONFIG high, the Intel Stratix 10 device drives nSTATUS high.

In previous device families the deassertion of nSTATUS indicates the device is ready for configuration. For Intel Stratix 10 devices, when using Avalon-ST configuration scheme, after the Intel Stratix 10 device drives nSTATUS high, you must also monitor the AVST READY signal to determine when the device is ready to accept configuration data.

nSTATUS asserts if an error occurs during configuration. The pulse ranges from 0.5 ms to 10 ms.

nSTATUS assertion is asynchronous to data error detection. Intel Stratix 10 devices do not support the auto-restart configuration after error option.

Previous device families implement the nSTATUS as an open drain with a weak internal pull-up. Intel Stratix 10 always drives nSTATUS. Consequently, you cannot wire OR an Intel Stratix 10 nSTATUS signal with the nSTATUS signal from earlier device families.

**Debugging Suggestions**

Ensure nSTATUS acknowledges nCONFIG. If nSTATUS is not following nCONFIG, the FPGA may not have exited POR. You may need to power cycle the PCB.
7.9.3. CONF_DONE and INIT_DONE

For Intel Stratix 10 devices, both CONF_DONE and INIT_DONE share multiplexed SDM_IO pins. Previous device families implement the CONF_DONE and INIT_DONE pins as open drains with a weak internal pull-up. Consequently, you cannot wire OR an Intel Stratix 10 CONF_DONE or INIT_DONE signal with the nSTATUS signal from previous device families. Otherwise, CONF_DONE and INITDONE behave as these signals behaved in earlier device families. If you assign CONF_DONE and INIT_DONE to SDM_IO16 and SDM_IO0, weak internal pull-downs pull these pins low at power-on reset. Ensure you specify these pins in the Intel Quartus Prime Software or in the Intel Quartus Prime settings file (*.qsf). CONF_DONE and INIT_DONE are low prior to and during configuration. CONF_DONE asserts when the device finishes receiving configuration data. INIT_DONE asserts when the device enters user mode.

**Note:**
The entire device does not enter user mode simultaneously. Intel recommends that you include the Including the Reset Release Intel FPGA IP in Your Design on page 122 to hold your application logic in the reset state until the entire FPGA fabric is in user mode.

CONF_DONE and INIT_DONE are optional signals. You can use these pins for other functions that the Intel Quartus Prime Pro Edition Device and Pin Options menu defines.

**Debugging Suggestions**

Place the CONF_DONE and INIT_DONE pins on the SDM_IO pins that correlate with the board-level connection. Refer to SDM Pin Mapping and Setting Additional Configuration Pins for more information.

**Related Information**

- SDM Pin Mapping on page 26
- Specifying Optional Configuration Pins on page 32

7.9.4. SDM_IO Pins

Intel Stratix 10 devices include 17 SDM_IO pins that you can configure to implement specific functions such as CONF_DONE and INIT_DONE. The chosen function must follow the GX, MX, TX, and SX Device Family Pin Connections Guidelines. The configuration bitstream controls the pin locations for the SDM_IO pins.

Internal Intel Stratix 10 circuitry pulls SDM_IO0, SDM_IO8 and SDM_IO16 weakly low through a 25 kΩ resistor. Internal Intel Stratix 10 circuitry pulls all other SDM_IO pins weakly high during power-on.
Debugging Suggestions

Check the Intel Quartus Prime Pro Edition settings and Fitter report to ensure that the SDM_IO configuration matches your PCB design. The following screen shots show where to configure these signals and how to confirm the SDM_IO pin settings in the Fitter report.

Figure 95. Configuration Pin Selection in the Intel Quartus Prime Pro Edition Software

**Related Information**
SDM Debug Toolkit Overview on page 192
8. Intel Stratix 10 Configuration User Guide Archives

If an IP core version is not listed, the user guide for the previous IP core version applies.

<table>
<thead>
<tr>
<th>IP Core Version</th>
<th>User Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.3</td>
<td>Intel Stratix 10 Configuration User Guide</td>
</tr>
<tr>
<td>19.2</td>
<td>Intel Stratix 10 Configuration User Guide</td>
</tr>
<tr>
<td>19.1</td>
<td>Intel Stratix 10 Configuration User Guide</td>
</tr>
<tr>
<td>18.1</td>
<td>Intel Stratix 10 Configuration User Guide</td>
</tr>
<tr>
<td>18.0</td>
<td>Intel Stratix 10 Configuration User Guide</td>
</tr>
<tr>
<td>17.1</td>
<td>Intel Stratix 10 Configuration User Guide</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| 2019.12.16       | 19.4                        | Made the following changes:  
• Added a new chapter covering the Reset Release Intel FPGA IP and why it must be included in your design.  
• Added the following components to the Required Communication and Host Components for the Remote System Update Design Example figure:  
  — Reset Release Intel FPGA IP  
  — 3 Reset Bridge Intel FPGA IPs  
• Added the following text to the OSC_CLK_1 Clock Input topic: When you specify OSC_CLK_1 for configuration and reconfigure without powering down the Intel Stratix 10 device, the device can only reconfigure with OSC_CLK_1. In this scenario, OSC_CLK_1 must be a free-running clock.  
• Added the following text to the definition of the Failing image field of the RSU_STATUS command:  
  Note: A rising edge on nCONFIG to reconfigure from ASx4, does not clear this field. Information about failing image only updates when the Mailbox Client receives a new RSU_IMAGE_UPDATE command and successfully configures from the update image.  
• Added the following restriction to the definition of QSPI_SET_CS: Access to the QSPI flash memory devices using SDM_IO pins is only available for the AS x4 configuration scheme, JTAG configuration, and a design compiled for ASx4 configuration. For the Avalon ST configuration scheme, you must connect QSPI flash memories to GPIO pins.  
• Updated the final suggestion in Debugging Guidelines for the JTAG Configuration Scheme topic, to the following: When the MSEL setting on the PCB is not JTAG, if you use the JTAG interface for reconfiguration after an initial reconfiguration using AS or the Avalon-ST interface, the .sof must be in the file format you specified in the Intel Quartus Prime project. For example, if you initially configure the MSEL pins for AS configuration and configure using the AS scheme, a subsequent JTAG reconfiguration using a .sof generated for Avalon-ST fails.  
• Annotated the figures illustrating RSU in the Remote System Update from FPGA Core Example chapter. |
| 2019.10.07       | 19.3                        | Made the following changes:  
• Corrected definition of RSU_STATUS command. This command has 9, not 10 words.  
• Added E-Tile Transceivers May Fail To Configure to the Debugging chapter.  
• Revised the Modifying the List of Application Images topic. |
| 2019.09.30       | 19.3                        | Made the following changes:  
continued... |
<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019.07.19</td>
<td>19.2</td>
<td>Made the following changes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Corrected numbers on Configuration, Reconfiguration, and Error Timing Diagram timing diagram. The number 3 now labels the nCONFIG rising edge. Renumbered associated text under the Initial Configuration Timing heading.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the Additional Clock Requirements for HPS, PCIe, eSRAM, and HBM2 topic, removed the following items from the list of components requiring a free-running clock before configuration begins:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— EMIF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— E-Tile transceiver</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: HPS EMIF retains this requirement.</td>
</tr>
<tr>
<td>2019.07.08</td>
<td>19.2</td>
<td>Made the following changes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Corrected minor errors and typos.</td>
</tr>
</tbody>
</table>

## Document Revision History for the Intel Stratix 10 Configuration User Guide

| UG-S10CONFIG | 2019.12.16 |

## Send Feedback

Intel Stratix 10 Configuration User Guide

211
- Revised and reorganized all topics covering configuration pin assignments:
  - Clarified the behavior of the MSEL pins in AS x4 mode.
  - Added information about the SDM.IO pin states during power-on and after device cleaning to the *Intel Stratix 10 Configuration Pins* topic.
  - Created separate topics covering partial configuration and SmartVID signals.
- Made the following changes to the RSU chapter:
  - Added the following topics:
    - RSU Glossary
    - Standard (non-RSU) Flash Layout
    - RSU Flash Layout – SDM Perspective
    - RSU Flash Layout – Your Perspective
    - Detailed Quad SPI Flash Layout
    - Sub-partitions Layout
    - Sub-Partition Table Layout
    - Pointer Block Layout
    - Modifying the List of Application Images
    - Application Image Layout
  - The static firmware has been replaced by decision firmware.
  - The update image now includes the factory image, the decision firmware and the decision firmware data.
  - The QSPI_ERASE command is now 4 KB aligned. The number of words to erase must be a multiple of 1024.
  - Added definitions of major and minor error codes for RSU_STATUS and CONFIG_STATUS.
- Added footnote explaining that before you can use CvP you must configure either the periphery image or the full image via the AS configuration scheme. Then, you can configure the core image using CvP.
- Added recommendation to use the Analog Devices LTM4677 device to regulate the PMBus for SmartVID devices. You set this parameter here: **Device ➤ Device and Pin Options ➤ Power Management & VID ➤ Slave device type.**
- Added two restrictions to the dual-purpose use of Avalon-ST pins. For more information, refer to the *Enabling Dual-Purpose Pins* topic.
- Corrected maximum speed and data rate in the *Intel Stratix 10 Configuration Data Width, Clock Rates, and Data Rates* table. The Max Clock Rate is 33 MHz. The Max Data Rate is 33 Mb.
- Updated the *Intel Stratix 10 Reset Release IP* to include reference to the new *An 891: Using the Reset Release FPGA IP*. Removed recommendation to gate Intel Hyperflex registers using the nINIT_DONE signal.
- Added the eSRAM clocks to the list of free-running clocks that must be stable before configuration begins.
- Added Attention warning that designs including the Intel Stratix 10 Mailbox Client FPGA IP using Intel Quartus Prime Programmer 19.2 or later whose .sof was generated in Intel Quartus Prime Programmer 19.1 or earlier must be regenerate the .sof.
### Changes

- **Added 10 kΩ pull-up resistor to nCONFIG in the following figures:**
  - Connections for Avalon-ST x8 Single-Device Configuration
  - Connections for Avalon-ST x16 Single-Device Configuration
  - Connections for Avalon-ST x32 Single-Device Configuration
  - PFL II IP core with Dual CFI Flash Memory Devices
- **Removed discrete synchronizers for the AVST READY signal in the following figures:**
  - Connections for Avalon-ST x8 Single-Device Configuration
  - Connections for Avalon-ST x16 Single-Device Configuration
  - Connections for Avalon-ST x32 Single-Device Configuration
  
  If necessary, you can implement synchronizers in the host controller if the host is an FPGA or CPLD. Validation has shown that external synchronizers are not required.
- **Made a global change recommending that you use the newer Intel Quartus Prime Programming File Generator instead of the legacy Intel Quartus Prime Convert Programming Files conversion program to generate programming files.**
  
  Changed all file conversion topics to use the Programming File Generator.
- **Revised all topics providing steps for file conversion to use Programming File Generator instead of the legacy Convert Programming Files dialog box.**
- **Clarified statement on quad SPI flash byte addressing:** The SDM configures the Quad SPI flash device to operate using 4-byte addressing if the flash size is 256 MB or greater.
- **Corrected flash memory sizes in Understanding Quad SPI Flash Byte-Addressing topic:** All sizes in megabits or gigabits, not megabytes or gigabytes.
- **Generalized Figure 2. Intel Stratix 10 Configuration Architecture Block Diagram:** This figure no longer lists specific variants of Intel Stratix 10 device.
- **Corrected Step 3 in the Initial Configuration Timing description:** The step should say, with nConfig low, the SDM enters Idle mode after booting.
- **Corrected the Intel Stratix 10 FPGA Configuration Flow diagram:** The transition between FPGA Config* and User Mode should say INIT_DONE = HIGH.
- **Corrected the following statement in the Debugging Guidelines for the JTAG Configuration Scheme topic:** An nSTATUS falling edge terminates any JTAG access and the device reverts to the NSEL-specified boot source. nSTATUS must be stable during JTAG configuration. In both sentence, nSTATUS should be nCONFIG.
- **Removed pin assignments for CVP_CONF_DONE for the Avalon-ST in the Available SDM I/O Pin Assignments for Configuration Signals that Do Not Use Dedicated SDM I/O Pins table:** CVP does not the support Avalon-ST x8 configuration scheme in Intel Stratix 10 devices.

<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019.04.10</td>
<td>19.1</td>
<td>Updated the transceiver reference clocks.</td>
</tr>
<tr>
<td>2019.04.01</td>
<td>19.1</td>
<td>Made the following additions and enhancements:</td>
</tr>
<tr>
<td>Document Version</td>
<td>Intel Quartus Prime Version</td>
<td>Changes</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Intel Stratix 10 Reset Release IP. Use the nINIT_DONE output of this IP to hold your application logic in reset until the entire FPGA fabric enters user mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Configuration Scheme Components and File Types topics illustrating the software flow and programming file outputs for the AS, Avalon-ST, and JTAG programming schemes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the following topics to the Stratix 10 Configuration Debugging Guide chapter:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Debugging Checklist</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— SDM Debug Toolkit Overview</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Using the SDM Debug Toolkit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Reading the Unique 64-Bit CHIP ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Understanding SEUs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Generating an Update Image for Static Firmware and Factory Image topic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added topics covering SDM_IO pin assignments and QSF settings for the Avalon-ST x8, x16, x32, and AS configuration schemes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added note in the Avalon-ST Configuration Timing topic. This note covers special requirements for driving configuration data Avalon-ST x16 and x32 configurations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the following signals to the Intel Stratix 10 Configuration Timing Diagram: nINIT_DONE, Data&lt;n&gt;-1:0], AVST_READY, AVST_VALID, and AS_CS0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added a 10K Ω pull-up resistor to nCONFIG and corrected file type for flash image in the following figures:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Connections for AS x4 Single-Device Configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Connections for AS Configuration with Multiple Serial Flash Devices</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Connections for Programming the Serial Flash Devices using the JTAG Interface</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the IBIS model name to the Intel Stratix 10 Configuration Pins I/O Standard and Drive Strength table. Renamed this table Configuration Pins I/O Standard, Drive Strength, and IBIS Model.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added Updating the SDM Firmware topic in the Intel Stratix 10 Configuration Overview chapter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the following guidance in Debugging Guidelines for the JTAG Configuration Scheme topic: When you use the JTAG interface for reconfiguration after an initial reconfiguration using AS or the Avalon-ST interface, the .sof must be in the file format you specified in the Intel Quartus Prime project.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the following signals to the list of device configuration pins that do not have fixed assignments:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— CONF_DONE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— INIT_DONE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— HPS_COLD_nRESET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Improved definitions of programming file output types.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edited Using the PFL II IP Core for clarity and style. Added many screenshots illustrating the step to complete a task.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated the supported flash memory devices and supported SD* card types in the Intel Stratix 10 Configuration Overview topic.</td>
</tr>
</tbody>
</table>

continued...
• Updated the SDM Pin Mapping table to include the following:
  — Avalon-ST x16, and x32 configuration scheme
  — Pins for SmartVID
• Added definition of the GETDESIGN_HASH command to the Mailbox Client Intel Stratix 10 FPGA IP Command List and Description table.
• Renamed the topic title Commands and Error Codes to Commands and Responses.
• Updated the descriptions for Length and Command Code/Error Code in the Mailbox Client Intel Stratix 10 FPGA IP Command and Response Header Description table.
• Added PLL reference clock requirement to the Additional Clock Requirements for Transceivers, HPS, PCIe, High Bandwidth Memory (HBM2) and SmartVID topic.
• Updated the Generating a Single RSU Image topic to clarify that the .rpd for Intel Stratix 10 devices now includes firmware pointer information for image addresses and is not compatible with earlier generation methods.
• Removed a note in Remote System Upgrade Configuration Images topic, saying that the application image is optional and can be added later. The initial RSU setup requires both a factory image and an application image.
• Added the following note to the Configuration Firmware Pointer Block (CPB) topic:
  Note: Application images must align to partition boundaries in the flash device. If an application image is less than a full partition, the rest of the sector cannot be used.
• Added a new topic RSU Recovery from Corrupted Images that explains how the SDM recovers from attempts to load corrupted images.
• Added 71.5 MHz as a supported frequency for the OSC_CLK_1 for AS configuration.
• Added description of optional 16-byte .rpd Version ID to the Remote System Upgrade Flash Device Layout topic.
• Removed Supported Flash Devices appendix. This appendix has been replace by the following web page Supported Flash Devices for Intel Stratix 10 Devices which provides more information about flash devices for different purposes.
• Removed references to P30 and P33 flash memory devices. These CFI flash devices are no longer available.

Made the following corrections:
• Corrected the following statement: Because Intel Stratix 10 devices operate at 1.8 volt and all SD MMC I/Os operate between 2.7 - 3.6 volts, an intermediate voltage level translator is necessary for SD cards. This statement is only true for SD cards.
• Corrected the value of MSEL for Avalon-ST x16 configuration in Table 1 and Table 9. The correct value is 101.
• Corrected PFL II IP core with Dual P30 or P33 CFI Flash Memory Devices figure. The nCONFIG signal should not have a pulldown resistor.
• Removed the statement that Remote system upgrade cannot use partial reconfiguration (PR) images for the application image from the Remote System Upgrade Using AS Configuration topic. Remote system upgrade does support PR.
• In the Mailbox Client Intel Stratix 10 FPGA IP Command List and Description table, for CONFIG_STATUS, corrected the size of MSEL. MSEL is 3 bits.
• Corrected the end address in step 14a of Generating a Standard RSU Image. It should be 0x00523FF.
• Corrected the definition of QSPI_ERASE. The number of words to erase must be a multiple of 4000 (hexadecimal) words.

continued...
<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• Changed Number of Commands and Number of Responses to Command Length and Response Length in the Mailbox Client Intel Stratix 10 FPGA IP Command List and Descriptions (RSU Functions for Non-HPS Variants) table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Corrected the fields of the RSU_STATUS command. The Last failing image field should be called the First failing image. This field reports the flash offset of the first failing application image.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the Remote System Upgrade Flash Memory Layout table, changed the amount of reserved flash memory image from 64k to 256k.</td>
</tr>
<tr>
<td>2018.11.02</td>
<td>18.1</td>
<td>Updated Figure 39: Intel Stratix 10 Modules and Interfaces to Implement RSU Using Images Stored in Flash Memory to exclude SD and MMC memory. These memory types are not supported in the current release.</td>
</tr>
<tr>
<td>2018.10.23</td>
<td>18.1</td>
<td>Added the following statement to the description of Avalon-ST Configuration Timing topic: The AVST_READY signal is only valid when the nSTATUS pin is high.</td>
</tr>
<tr>
<td>2018.10.10</td>
<td>18.1</td>
<td>Made the following changes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed the number of remote system upgrade images supported from more than 500 to 507 in Remote System Upgrade Configuration Images.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated the last two entries in the Configuration Firmware Pointer Block Format table.</td>
</tr>
<tr>
<td>2018.10.04</td>
<td>18.1</td>
<td>Made the following changes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Corrected statement in the Remote System Upgrade topic. A command to the Mailbox Client Intel Stratix 10 FPGA Mailbox Client IP Core initiates reconfiguration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Corrected the Intel Stratix 10 Remote System Upgrade Components figure and Related Information link. The mailbox component is the Mailbox Client Intel Stratix 10 FPGA IP Core.</td>
</tr>
<tr>
<td>2018.09.21</td>
<td>18.1</td>
<td>Made the following changes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added new chapter, Remote System Upgrade</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added new chapter, Intel Stratix 10 Debugging Guide</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added separate Debugging Guidelines topics in the Avalon-ST, AS, and JTAG configuration scheme sections.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Significantly expanded Stratix 10 Configuration Overview Configuration Overview chapter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Additional Clock and SmartVID Requirements for Transceivers, HPS, PCIe, High Bandwidth Memory (HBM2) and SmartVID topic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Expanded OSC_CLK_1 Clock Input topic to include additional usage requirements.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added AS Using Multiple Serial Flash Devices topic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added numerous screenshots illustrating Intel Quartus Prime Pro Edition procedures.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Improved many figures illustrating configuration schemes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added the fact that you must have system administrator privileges to define a new flash device in the Defining New CFI Flash Memory Device topic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added MT28EW to the list of PFL II flash devices supported.</td>
</tr>
</tbody>
</table>

continued...
<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Moved almost all of the material describing the PFL II flash from an appendix to the <em>Intel Stratix 10 Configuration Schemes</em> chapter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edited entire document for clarity and style.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corrected minor errors and typos.</td>
</tr>
<tr>
<td>2018.05.07</td>
<td>18.0</td>
<td>Removed Estimating the .qekActive Serial Configuration Time section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated the OSC_CLK_1 supported frequency.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added selecting flash loader step to <em>Generating Programming Files using Convert Programming Files</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added a note to TCK, TDI, TMS, and TDO stating that they are available for HPS JTAG chaining in SoC devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Removed instruction to drive nCONFIG low from POR in the following diagrams:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Connections for AS x4 Single-Device Configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Connection Setup for AS Configuration with Multiple EPCQ-L Devices</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Connection Setup for Programming the EPCQ-L Devices using the JTAG Interface</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added a note in <em>OSC_CLK_1 Clock Input</em> stating that reference clocks to EMIF and PCIe IP cores must be stable and free running.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Removed .ekp file from <em>Overview of Intel Quartus Prime Supported Files and Tools for Configuration and Programming</em> figure.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated the <em>Configuring Intel Stratix 10 Devices using AS Configuration</em> section title to <em>Generating and Programming AS Configuration Programming Files</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated <em>Configuration Schemes and Features Overview in Intel Stratix 10 Devices</em> table:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Added a note stating to contact sales representative for more information about support readiness.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Added a note stating to contact sales representative for more information about flash support other than EPCQ-L devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Removed NAND configuration support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated <em>Configuration Sequence in Intel Stratix 10 Devices</em> figure by adding a looped flow arrow during Idle state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated the MSEL note in <em>Intel Stratix 10 Device Configuration Pins</em> table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added a note to recommend OSC_CLK_1 for configuration clock source in <em>OSC_CLK_1 Clock Input</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Updated CvP data width and maximum data rate in <em>Configuration Schemes and Features Overview in Intel Stratix 10 Devices</em> table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Removed the multiple EPCQ-L configuration device support.</td>
</tr>
<tr>
<td>Date</td>
<td>Version</td>
<td>Changes</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| November 2017| 2017.11.09| • Removed link to the Configuration via Protocol (CvP) Implementation User Guide.  
| November 2017| 2017.11.06| • Updated Option Bits Sector Format table.  
• Updated a step in Setting Additional Configuration Pins.  
• Added Converting .sof to .pof File and Programming CPLDs and Flash Memory Devices.  
• Updated the .pof version value in Storing Option Bits.  
• Added information about restoring start and end address for option bits in Restoring Option Bit Start and End Address.  
• Added note about pull-down resistor is recommended for CONF_DONE and INIT_DONE pins in Additional Configuration Pin Functions.  
• Added new subsection Multiple EPCQ-L Devices Support.  
• Added Configuration Pins I/O Standard and Drive Strength table.  
• Updated information about maximum additional data words when using 2-stage register synchronizer.  
• Updated the equation for minimum AS configuration time estimation.  
• Added RBF Configuration File Format section explaining the format of the .rbf file.  
• Updated Configuration Sequence to state that a firmware which is part of the configuration data if loaded in the device initially.  
• Updated description for Number of flash devices used parameter in the PFL II Flash Interface Setting Parameters table.  
• Updated Configuration via Protocol overview and added link to the Configuration via Protocol (CvP) Implementation User Guide.  
• Updated Partial Reconfiguration overview and added link to the Creating a Partial Reconfiguration Design chapter of the Handbook Volume 1: Design and Compilation.  
• Updated Design Security Overview descriptions.  
• Added note for Partial Reconfiguration feature and link to Partial Reconfiguration Solutions IP User Guide in Intel Stratix 10 Configuration Overview.  
• Removed SDM pin notes in Intel Stratix 10 Configuration Overview.  
• Updated internal oscillator’s AS_CLK frequency in Supported configuration clock source and AS_CLK Frequencies in Intel Stratix 10 Devices table. |
| May 2017     | 2017.05.22| • Updated Connection Setup for Programming the EPCQ-L Device using the AS Interface figure.  
• Updated guideline to program the EPCQ-L device in Programming EPCQ-L Devices using the Active Serial Interface.                                                                                                                                                                         |
| April 2017   | 2017.04.10| • Updated note for AS Fast Mode in MSEL Settings for Each Configuration Scheme of Devices table.  
• Added note to Configuration via Protocol recommending user to use AS x4 fast mode for CvP application.  
• Updated instances of Spansion to Cypress.  
• continued...
<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• Updated note and description in <em>Configuration Overview</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated note and description in <em>Configuration Overview</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Removed AS x1 support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added <em>Connection Setup for SD/MMC Single-Device Configuration</em> figure.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated <em>Connections for AS x4 Single-Device Configuration</em>, <em>Connection Setup for AS Configuration with Multiple EPCQ-L Devices</em>, <em>Connection Setup for Programming the EPCQ-L Devices using the JTAG Interface</em>, <em>Connection Setup for NAND Flash Single-Device Configuration</em>, and <em>Connection Setup for SD/MMC Single-Device Configuration</em> to include note about nCONFIG test point.</td>
</tr>
<tr>
<td>February 2017</td>
<td>2017.02.13</td>
<td>• Added note in <em>Avalon-ST Configuration</em> stating that AVST_CLK should be continuous.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated <em>Configuring Stratix 10 Devices using AS Configuration</em> section and subsections to include .jic for AS configuration scheme.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added <em>Programming .jic files into EPCQ-L Device</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated the SDM description.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated SDM block diagram by adding Mailbox block and note for Avalon-ST x8 configuration scheme.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated <em>Configuration Sequence Diagram</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated configuration sequence descriptions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated <em>Avalon-ST Bus Timing Waveform</em> figure.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added note to Avalon-ST in <em>Stratix 10 Configuration Overview</em> table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated ASx4 max data rate in <em>Stratix 10 Configuration Overview</em> table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Removed <em>Configurable Node</em> subsection.</td>
</tr>
<tr>
<td>December 2016</td>
<td>2016.12.09</td>
<td>• Updated max data rate for ASx1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated the <em>Configuration Sequence in Stratix 10 Devices</em> figure.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated configuration sequence description.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added JTAG configuration sequence description.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added <em>Parallel Flash Loader II IP core</em>.</td>
</tr>
<tr>
<td>October 2016</td>
<td>2016.10.31</td>
<td>Initial release</td>
</tr>
</tbody>
</table>